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 _______________________________ Using This Manual 
 

In 

Using This Manual 
 
This manual is written as closely as possible to Microsoft standards to standardize text for the user. 
Look at the sample and explanation of the formatting below. 

Each procedure is written in sequential steps. Words written in bold type also appear on your screen. 
Words in Arial font are the names of applications, windows, dialog boxes, or messages that open after 
you perform a step. These names are always located in the title bar at the top of the window or box in 
question. 

Each procedure has a title statement beginning with the word “to”. Some exercises contain more than 
one procedure. When you are using this manual in class, you may not need the sort of detailed 
information in the procedures. However, the manual is meant to guide you after the course is over 
when you are attempting these procedures in your office. Remember, the project shown in the graphics 
is for the training class only. 

Sample procedure 
To prepare a project for PEDDS 

1. the Preparing a Seed Project with PEDDS folder, click Launch. Florida 
Department Of Transportation - PEDDS opens. 

 
Launching PEDDS 
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Florida Department of Transportation – PEDDS 

 

Each procedure may be accompanied by notes, tips, or cautions, as applicable.  

• A note is additional useful information that is not necessary for performing the 
procedure.  

• An important note contains information that you need to perform a procedure. 

• A tip contains actions that supplement what you do in the procedure, usually a different 
way to do something that you may prefer. 

• A caution indicates an action that may irreparably damage your data if performed 
incorrectly. Be sure to look for cautions and read them carefully. 

• A warning indicates an action that could hurt you or damage your hardware. This 
manual doesn’t contain any warnings. 
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Introduction 
Forward to the FDOT Electronic Delivery Course 
by Bruce Dana, P. E., FDOT State CADD Coordinator 
 
We are pleased to bring you an updated version of the Electronic Delivery (ED) Software suite.  These updates 
not only remedy reported bugs, but include process and productivity enhancements that many users have 
requested.  Inside the FDOT2008 production suite itself you will see enhancements made to modules, such as 
Sheet Navigator, that, when coupled with the ED modules provide a more robust and automated means of 
producing and delivering a complete and fully indexed electronic set of plans and supporting data.  

We have chosen to stay with our web-enabled interface that helps guide you through a systematic, three-phased 
approach to the electronic deliverable process.  ED includes on-line help, which I encourage you to take 
advantage of.  

For additional help, visit our web site at http://www.dot.state.fl.us/ecso/.  On these sites you will find 
our Customer Support Guide, which has been developed to help the users developing plans for the FDOT 
obtain support.  The guide explains how to get help, who to contact for help with a specific application, and 
what to expect.  

You may wish also to check out the Quick Clips 
at http://www.dot.state.fl.us/ecso/downloads/clips/default.shtm which are recorded video segments 
covering many of the tools in the FDOT2008 software suite including many directly related to the ED process.  
They say a picture is worth 1000 words – so a video must be worth a million.  Over time, we intend to add more 
of these which can be viewed by users at their desks. 

As with any other technical process you find yourself doing, I encourage you to take advantage of the resources 
available and invest in learning the ED processes and applications.  This course guide is just one of the many 
resources you have available.  We have seen so often that some users wait until the 11th hour before attempting 
Electronic Delivery, or have not availed themselves of the training and other help materials available, which 
sets themselves up for failure.  Also, Electronic Delivery relies upon following certain standards for data 
structure and content, and being cavalier about adhering to those standards is negligence that can also lead to 
failures.  The staff at the FDOT Engineering / CADD Systems Office (ECSO) is available to assist when you 
simply cannot find the solution yourself. 

As always, we hope you find your ED training experience an enriching one.  It is our desire to provide quality 
training materials that will provide you the CADD-related information and instruction needed to produce and 
deliver your projects.  Please use the links on our web sites to give us your questions, comments, and 
suggestions. 

 

Thank you! 
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Course Overview  
 
Section 1 – Overview of Electronic Delivery – A 30-minute instructor-led class to introduce the FDOT2008 
ED software.  This session demonstrates how to launch the program, new tools and the program’s 
capabilities.  This section is intended for all course attendees, both Pre and Post-Production as well as 
Production. 

Section 2 – Pre-Production Phase - A one-half day instructor-led class that teaches project managers the 
FDOT2008 ED software and the tools needed to create a “seed” project.  This instruction ensures the creation 
of a successful environment for the production phase of the process and that FDOT standards for ED process are 
met.  This section is intended for managers of projects.  Personnel taking the Production Phase training will 
receive an overview of the Pre-Production Phase. 

Section 3 – Production Phase - This two-day instructor-led class teaches production staff how to utilize the 
FDOT2008 ED software for securing and submitting electronic projects per FDOT standards. This course 
focuses on the tools needed to allow the building of an index and journal, electronic signing/sealing with 
PEDDS, creating postscript images of the project plans, and securing the electronic project with PEDDS for 
delivery to FDOT.  These tasks meet FDOT standards as set forth in the FDOT CADD Production Criteria 
Handbook and the CADD Manual, which are located in PDF format at:  

http://www.dot.state.fl.us/ecso/downloads/publications/default.shtm   

This section is intended for production personnel.  An overview of the Pre-Production and the Post-Production 
sections is included. 

Section 4 – Post-Production Phase - A one-half day instructor-led class that teaches project managers the 
FDOT2008 ED software.  Students learn the tools required to receive and accept delivery of electronic plan 
sets, as well as how to make them available to electronic services for posting.  This section is intended for 
managers of projects. 

Section 5 - Electronic Delivery - Handling Revisions - This section is part of the Production Phase class, 
which teaches the recommended workflow for handling plan sheet(s) revisions within the context of ED. 

Section 6 - Electronic Delivery - Strung Projects - This section is part of the Production Phase class, which 
teaches the recommended workflow for handling Strung Projects within the context of ED. 

Section 7 - Production Phase - Extras - This section contains additional reference material on Production 
Tools that can assist a user while preparing a project for electronic delivery, but may not always be a key 
component of an electronic delivery.  If time permits at the end of the of the ED Production course, these 
exercises can be started. 
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Electronic Delivery ______________________________________________________Resources 

Resources 
 
The ECSO offers various support options. 

Online Support 

ECSO maintains a website with the latest in news, software updates, and online help.  Visit the ECSO site at: 

http://www.dot.state.fl.us/ecso/ 

Video Quick Clips 

ECSO maintains a website with on-line recorded video for several FDOT2008 and ED Applications.  Visit the 
ECSO Quick Clips site at: 

http://www.dot.state.fl.us/ecso/downloads/clips/default.shtm 

Training 

ECSO often offers scheduled classes and presentations on ED and its various subtopics. Contact your FDOT 
CADD Manager for details on events near you.  Also check the ECSO Events page at: 

http://www.dot.state.fl.us/ecso/main/events.shtm 

Phone Support 

You can contact ECSO for technical assistance by calling (850) 245-1600.  Telephone support is available 
between 8 PM and 5 PM, Monday through Friday. 

Where to Obtain the Latest FDOT Manuals 

The latest version of the FDOT CADD Manual is located in PDF format at:  
http://www.dot.state.fl.us/ecso/downloads/publications/Manual/default.shtm 

The latest version of the FDOT CADD Production Criteria Handbook is located in PDF format at: 

http://www.dot.state.fl.us/ecso/downloads/publications/CriteriaHandBook/ 

Location of Electronic Delivery suite of tools: 

The FDOT2008 ED software should be installed along with the latest FDOT2008 CADD software. ED 
requires resources that the FDOT2008 software installation provides.  

Location device:\FDOT2008\APPS\.  The device is the hard drive on which the FDOT software is installed. 

Note  Several of the ED tools write temporary files to the local hard-drive’s \FDOT2008\ folder. This local 
folder requires read/write permissions. Please verify this with your IT/IS staff. 

Location of ED Help Files: 

Within the location of the ED software, Location device:\FDOT2008\APPS\EDelivery, where device is the 
hard drive the FDOT CADD software is installed, there are several subfolders.  Many of these subfolders 
contain folders with help documents in HTML format for that application. 

Electronic Delivery Training Course © 2009 FDOT 3 

http://www.dot.state.fl.us/ecso/
http://www.dot.state.fl.us/ecso/downloads/clips/default.shtm
http://www.dot.state.fl.us/ecso/main/events.shtm
http://www.dot.state.fl.us/ecso/downloads/publications/Manual/default.shtm
http://www.dot.state.fl.us/ecso/downloads/publications/CriteriaHandBook/


 
Course Overview________________________________________________ Electronic Delivery 
 

 
 

Figure Intro-1: Flow Chart of Electronic Delivery Process 
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 (ED) training section covers the details of launching the 
software and reviewing the interface. 

 

•   Launching Electronic Delivery Desktop 

•   Electronic Delivery Desktop Overview  

To launch the FDOT2008 ED software from the desktop icon 

esktop. Shortcuts to start and other FDOT2008 applications are also 
included. 

FDOT2008 Folder Icon  

From the desktop, double-click the FDOT2008 folder. FDOT2008 opens. 

OT2008, double-click the Electronic Delivery icon. Electronic Delivery Desktop 
opens. 

 

1 Electronic Deliver
Overview 

 
The Overview of Electronic Delivery

 

Section 1.1 Launching Electronic Delivery Desktop 

The FDOT2008 desktop folder is created during the installation process of the FDOT2008 
software. This folder contains short cut links to most FDOT2008 tools, including the short cut to 
start ED D MicroStation V8 

 

•   From FD
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Section 1 _______________ Electronic Delivery Overview - Launching Electronic Delivery Desktop 
 

 
FDOT2008 Desktop Folder 

 

If the Electronic Delivery icon is copied to the desktop, double-click it to start Electronic Delivery 
Desktop. 

 
FDOT2008 Desktop Folder 
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Electronic Delivery Overview - Launching Electronic Delivery Desktop _______________ Section 1 
 
To launch the FDOT2008 ED Desktop software from the start menu 

•   From the desktop, click the Start button, point to Programs, point to FDOT2008, and 

then click Electronic Delivery. Electronic Delivery Desktop opens. 

 
Windows Start Menu 
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Section 1 _______________ Electronic Delivery Overview - Launching Electronic Delivery Desktop 
 
To launch the FDOT2008 ED Desktop software from the Windows Explorer 

•   From Windows Explorer, navigate to the C:\FDOT2008\APPS\EDelivery\ 
directory.  

•   Double-click on the executable file named EDelivery.exe. 
 

 
1Windows Explorer View of Electronic Delivery Folder 
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Electronic Delivery Overview - Electronic Delivery Desktop ________________________ Section 1 
 

Section 1.2 Electronic Delivery Desktop 
Electronic Delivery Desktop window appears and behaves like a web browser. Clicking or 
expanding items in the Task Pane (left side of window), results in instructional content being 
displayed in the Explanation Pane (right side of window). The Instructional text displayed in the 
Explanation Pane can be printed to a networked print device by clicking the Print button. The ED 
software applications can be launched from this window. 
 

 
Electronic Delivery Desktop  

Section 1.3 Electronic Delivery Desktop Hierarchy 
Overview 

ED software has three major components which follow the Introduction folder in the Task Pane, as 
seen in the following figure. These components are Pre-Production Phase, Production Phase and 
Post-Production Phase. Each of these items can be expanded by clicking the ‘+’ expander on the 
tree view within the Task Pane. 
Clicking the Getting Help task displays a page where the user can find on-line help as well as phone 

numbers for technical help. 

Within the Task Pane of the Electronic Delivery Desktop window, expanding the dark-shaded 
category folder icons ( ) results in the display of a sheet icon ( ) as shown in the image above. 
  
Clicking any of the listed tasks in the Task Pane expands the display of associated text within the 
Explanation Pane of the Electronic Delivery Desktop window. 

•   Click the Folder icon ( ) to display a printable explanation of the associated Phase. 

•   Click the Sheet icon ( ) to activate the associated HTML help pages for the program. 

•   Click the Shuttle icon ( ) to launch the appropriate program associated with the process. 
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Section 1 _______ Electronic Delivery Overview - Electronic Delivery Desktop Hierarchy Overview 
 
 

 
Expanded Task Pane with associated text in Explanation Pane 

Note  Icon colors described within the document refer to default screen colors. These may vary 
depending on individual windows default colors. 

 

To reactivate a selected option 

Move off the item and then re-select the item to activate it. 
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Electronic Delivery Overview - Introduction _____________________________________ Section 1 
 

Section 1.4 Introduction 
The Introduction of the Electronic Delivery Desktop interface gives access to valuable resource 
pages, Process Overview and Glossary of Terms, which can be printed for reference.  The 
Process Overview provides a brief description of each of the phases of Electronic Delivery process. 
 

 
Electronic Delivery Desktop - Process Overview 
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Section 1 _____________________________________ Electronic Delivery Overview - Introduction 
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The Glossary of Terms defines commonly used terms within the ED process.  An extended 
Glossary of Terms is also provided in this course to assist in the user’s understanding and 
training. 
 

 
Electronic Delivery Desktop - Glossary of Terms 

 
Exercise 1.1 Overview of Electronic Delivery Desktop 

This is an informal exercise. The user is encouraged to investigate the Electronic Delivery 
Desktop Interface by opening and closing several of the Electronic Delivery Tools.  



 
  
 

2 Pre-Production Phase 
 

The Pre-Production Phase training section covers creating the Seed Project, creating the PEDDS 
Project ID, and securing the Seed Project for Delivery. 

 

• Creating and Preparing a Seed Project 

o Creating a Seed Project using Electronic Delivery Indexer (EDI2) 

o Creating a Seed Project using Create Edit XM Files 

o Creating a Seed Project using MicroStation XM 

• Preparing a Seed Project with PEDDS 

• Creating a PEDDS Project ID file 

• Creating a PEDDS Project Header 

• Modifying a PEDDS Project ID file 

• Modifying a PEDDS Project Header 

• Checking the Project with File Checker 

• Securing the Project for Delivery to Design Consultant 

• Preparing the Delivery Media  
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Section 2 ________________________ Pre-Production Phase - Introduction to Pre-Production Tools  
 

Section 2.1 Introduction to Pre-Production Tools 
Section 8.4 of the CADD Production Criteria Handbook (CPCH) describes the Pre-Production 
phase as the creation of a “seed” project electronically, to provide an environment for meeting 
CADD standards as defined in the CADD Manual and CPCH.  Functions include the 
specification of the project directory structure, creating a project information file and providing 
the opportunity to include applicable administrative documents.  To ensure a successful 
environment for the production phase later, it is essential that the project begin correctly so that 
compliance to FDOT standards for the Electronic Delivery process can be met. 

The following figure shows the required tasks for the Pre-Production phase from the Electronic 
Delivery Desktop. 

 
Expanded Pre-Production Phase 

Before production on a project can begin, a workspace must be provided for project development. 
The FDOT2008 CADD Software suite provides the tools necessary to do the following: 

• Create a directory structure that complies with current CADD standards. 

• Create a MicroStation project configuration file (.PCF). 

• Create files needed to allow for future security using the PEDDS application. 

• Gather metadata (data describing the project), simplifying reporting later in 
production and preparing the project for future archiving. 

Once these tasks are completed, the resulting file and folder structure is called a seed project. 
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Pre-Production Phase  - Creating and Preparing a Seed Project _____________________ Section 2 
 

Section 2.2 Creating and Preparing a Seed Project 
The first step in Pre-Production is the creation of a seed project.  A seed project is a folder set that 
contains all discipline folders as listed in Chapter 4 of the CPCH, as well as the MicroStation 
project configuration file (.PCF).  

There are 3 ways to create a Seed Project. 

• EDI2  

• Create/Edit Project  

• MicroStation XM Manager 

The main exercise in this section concentrates on using EDI2 to create a seed project. Optional 
review exercises using the other tools to create a seed project are included at the end of this 
section. 

The Pre-Production Phase provides the tools necessary to produce the following items, which are 
delivered to the Project Consultant. 

• Project specific files such as Scope of Services documents, etc. may be copied into 
the newly created directory structure. 

• A MicroStation Project Configuration File (.PCF) is created and placed in the 
project root directory during project creation. The PCF file can then be relocated to 
the appropriate location for MicroStation File Manager to recognize and point to 
the project directory. 

Creating and Preparing a Seed Project 
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Section 2 _______________________ Pre-Production Phase - Creating and Preparing a Seed Project  
 
Exercise 2.1 Creating and Preparing a Seed Project 

The first time EDI2 executes, it configures itself. A few items need to be confirmed before 
starting. There are not installation steps required for installing the EDI2 software, but EDI2 needs 
to be configured for the PC's specific environment, including the installation of FDOT CADD 
software, correct MicroStation version and several other programs. 

EDI2 is delivered with the FDOT2008 CADD Software installation. EDI2 is a Microsoft.NET 
application, and therefore requires Microsoft.NET Framework Version 2 or higher, available 
from Microsoft Downloads. This allows EDI2 to be installed with XCOPY simplicity and still 
provides a rich, informative user experience, with fewer installation issues. 

More information about the configuration of EDI2 is available in the Production Phase of this 
manual. 

Note   Executable files are provided in the dataset for logical starting points throughout 
Section 2.  For example the executable file EDSection2Exercise2.2Start.exe contains 
the files from Section 2 exercises up to Exercise 2.2.  If you encounter errors while 
working through an exercise, select the executable with the nearest starting point and 
unzip the files as demonstrated above.  The Unzip to folder will be set to the correct 
hard drive location. 

To install Electronic Delivery Indexer 

1. In the Creating and Preparing a Seed Project folder, click Launch. The Electronic 
Delivery Index splash screen displays and then EDI Configuration Information opens. 
Click OK to continue. 

 
Launching Creating and Preparing a Seed Project 

 
Electronic Delivery Index Splash Screen 
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Pre-Production Phase  - Creating and Preparing a Seed Project _____________________ Section 2 
 
Important   The following outlines the steps to complete the installation of EDI2. The 

directories listed in the dialog boxes may differ depending on the user that is installing it and 
the installation directories for the various other software used.  

2. MicroStation Configuration Setup opens. Edit the settings as shown (program 
defaults are usually the correct choice) in the following figure and click the OK button. 

 
MicroStation Configuration Setup 

3.  DI - Open Project for Write Access opens.  Click the Yes button. 

 
EDI - Open Project for Write Access 

4. EDI Verify Files opens.  Click the Cancel button to open EDI2 without mining files. 

 
EDI Verify Files 
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Section 2 _______________________ Pre-Production Phase - Creating and Preparing a Seed Project  
 

5. EDI2 displays. 

 
EDI2 
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To Create a Seed Project using EDI 

1. From the EDI2, select File > Create Project... (ProjectID and PEDDS).  

 
EDI2 - Create Project 

2. Create New FDOT Project opens. 

 
Create New FDOT Project 
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3. Edit Create New FDOT Project to match the following figure.  

Note   Pay attention to the default project location.  If a location other than the default is 
needed, click the Browse button. 

 
Create New FDOT Project  
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4. Click the Project Files & Folders tab to review the Seed Project folder structure. 
When finished click the OK button to display Verify Input for New Project. 

 
Create New FDOT Project - FDOT Standard Seed Project Folders 
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5. From Verify Input For New Project, scroll through the input information and then 
click the OK button.  

 
Verify Input For New Project 

6. EDI - FDOT Project Created opens.  Click Yes. Project ID for PEDDS (Financial) 
opens and the FPID Number automatically fills in the Financial Accounting 
Identification text fields as shown in the figure on the following page. 

 
EDI - FDOT Project Created 

Note   Although PEDDS has not opened, the information to identify a project in PEDDS 
activates. Section 2.3 contains an Introduction to PEDDS. This exercise continues 
with the creation of the PEDDS Project ID File. 
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Project ID for PEDDS (Financial)  

Note   The Project Key is an alphanumeric character string called a Global Unique 
Identifier or GUID, generated by operating system that uniquely identifies a project 
(regardless of the project’s root directory structure name or Financial Project 
Identification number changing).  This number is unique across all projects secured 
using PEDDS and identifies one project and one project only.  Multiple deliveries of 
the same project at various phases of completion, or after subsequent revisions always 
have the same Project Key. 

7. If applicable, type in the Federal Aid Number.  

Important   All projects with Federal Funding have a Federal Aid Number. This number is 
not required to uniquely identify the project, but this is the only data that links the project to 
Federal Funding. The Federal Aid Number may contain alpha characters in addition to 
numeric characters.  
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Note   The Contract Agreement Date is automatically filled with the default date. 

8. Verify or modify the Contract Agreement Date. 

9. Verify the appropriate Project Usage option is set to As-Designed. 

Note  The following usage options are available: 

• As-Designed are project deliveries secured with PEDDS used to create a finished 
design; including work produced by survey, right-of-way, or design.  

• As-Bid are project deliveries secured with PEDDS used as the bid set of plans. 

• As-Built are project deliveries secured with PEDDS used to represent finished 
construction. 

• Other files are secured with PEDDS that do not fall into one of the above 
categories. 

10. Click the Next button to continue.  Project ID for PEDDS (Location) displays. 

 
Project ID for PEDDS (Location) 
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11. Type the Designation (which is the common reference to the facility). 

12. The Project Physical Location is a multiple-entry grid control acting as a collection 
of the edit fields provided just below the grid control shown above.  Enter the data in 
each of the County, Section/Subsection, Beginning Mile Post, etc. 

13. After all values are entered, click the Add button, which enters the data entered into 
the grid above. 

14. To make a correction to the values just entered, select the entry from the grid, type the 
new information in the edit fields, and then click the Update button.   

Note   Entries can be removed from the grid by selecting the entry from the grid, then 
clicking the Remove button. 

Important   In Project ID for PEDDS, all values are added, modified or removed using the 
method just described.  

15. Enter the Service Road Number, and then click the Add button.  

16. Click the Next button. Project ID for PEDDS (Disciplines) displays. 

 Project ID for PEDDS (Disciplines) dialog  
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17. Select any check box of the disciplines that are known for the project.  These can be 
used in the future for searches when many projects have been loaded into the electronic 
plans room software, knows as PEDDS DB, an archival repository of plans deliveries. 

18. Click the Next button. Project ID for PEDDS (Bridge Identification) displays.  

 
Project ID for PEDDS (Bridge Identification) dialog 

19. Enter the 6-digit Bridge Number (as defined in the National Bridge Inventory) . 

CAUTION     If something other than 6 digits is entered and the Add button is clicked, this causes an 
error, known as an error trap. Enter only 6 digits. 

20. Enter the Surface On Bridge description. 

Note   The surface descriptions are utilized to simplify identification of the bridge.  For 
example, if the surface is a road, use the road’s name or highway number. If the 
surface is a river, use the name of the river and any other information that helps locate 
the bridge. 
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21. Enter the Surface Over Bridge information, and then click the Add button. 

22. Click the Next button. Project ID for PEDDS (Description) opens. 

 
Project ID for PEDDS (Description) dialog  

23. Type any Keywords about the project.  Keywords are brief words or phrases a crawler 
might find to index those projects for a search engine (think of Google and searching 
previously indexed web sites). 

Tip  Navigate between sections by clicking the TAB key. 

Important   In Project Description, separate the Key words text phrases by semi-colons (;).  

24. The Project Description text field is automatically populated with the description 
entered in EDI2 when the seed project was first created.  It can be modified here if 
needed.  The General Description does appear in later reports, so it is important to be 
both descriptive and concise.Type any Miscellaneous Comments about the project.  
Comments can be any text, and do not appear in later reports. 
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25. Click the Next button. Project ID for PEDDS (Management) opens. 

 
Project ID for PEDDS (Manager) dialog 

26. In the Project Manager Information box, enter the Manager Names of all FDOT 
Project Managers.  

Important   Separate each Project Manager’s name by a semi-colon (;). 

27. In the Professional(s) of Record - Name of Professional box, enter the name of a 
Professional of Record anticipated to participate on the project. 

28. In the Professional(s) of Record - Area of Responsibility box, enter the type of work 
that the Professional of Record is responsible for. 

29. Click the Add button.  

Note   To enter additional Professionals of Record, repeat steps 28-30 for each one. 
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30. To make a correction to a Professional of Record, select the entry in the collection 
grid, correct the entry in the input fields, and click the Modify button.   

Note   Professionals of Record may be removed by selecting the entry in the collections, 
and clicking the Remove button.  

31. In the Project Created By - Firm Name box, type the name of the firm working on 
the project, or the FDOT district number (i.e. FDOT District 4). 

32. In the Project Created By - State Vendor Number box, type the vendor number. 

33. Click the Save Changes button. Save Changes message box opens to verify.  Select 
OK to save all changes. 

 
PEDDS ProjectId Save Changes confirmation 

Note   Clicking the Close button results in the following message box. Selecting Yes will 
result in all changes lost. 

 

Project ID for PEDDS (Close) dialog  
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Important   It is recommended to mine data at this point. 

34. EDI - Mining Project Files Attributes opens.  Click the OK button.  EDI–
Verify/Update Process opens. 

 
Mining Project Files Attributes 

 

 
EDI - SheetInfo Data Mining Processing 

Note   Mining (a term for gathering information about files in the project) begins.  The 
data gathered is called “file attribute data.” Upon completion of the data mining 
process, EDI2 re-appears with the newly created project active and mined. EDI2 has 
also created the file EDIProject.edi. This file and other information about EDI2 are 
discussed in the Production Section of this manual.  
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35. EDI2 has completed the creation process and now can be closed. The new Seed Project 
directory structure, PEDDS project identification file, ProjectID.xml, and Index file, 
EDIProject.edi, have all been created. 

 
EDI2 
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Exercise 2.2 Creating a Seed Project Directory Structure 

The Create File/Project tool is used primarily to create MicroStation design files, text files, 
etc, with standard FDOT file naming conventions. Create File/Project uses an ASCII file, called 
a control file (*.ctl), to perform this task. Able to run from CADPilot within MicroStation or as a 
stand-alone application, Create File/Project is used to create a new Seed Project directory 
structure in the following exercise. 

To create a Seed Project directory structure using Create Edit FDOT2008 Files 

1. From the desktop, double-click the FDOT2008 folder. FDOT2008 opens. 

 
FDOT2008 Folder Icon 

2. From FDOT2008, double-click Create Edit FDOT2008 Files icon. Create 
File/Project opens. 

 

 
Opened FDOT2008 Desktop Folder 
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Create File/Project 

Note   Depending on tool usage, Create File/Project could be empty of a specific 
project, or it may contain information from a previously defined project. 

3. From Create File/Project, click the Project Settings button. Project Settings opens. 

 
Project Settings 
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Note   Project Settings allows the user to select an Active Project (a project that already 
exists). Once an active project is selected using this tool, the user can create files with 
FDOT standard naming conventions. The files are saved to that project’s discipline 
directories. 

4. From Project Settings, click Create New Project button.  Create New Project opens. 

5. From Create New Project, click the Browse button. Choose folder opens. 

 
Create New Project 

6. From Choose folder, navigate to the \FDOT2008\ directory. Select the 
Project_template folder and click the Select button. Create New Project reappears. 

Note   This folder is located under the default directory of \FDOT2008\, which could 
reside on the server depending on how your workstation software was configured.  

 
Choose folder dialog box 

Note   The exercises and examples in this manual are using a default FDOT2008 
installation to the local hard drive (C: Drive). 
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Create New Project 

7. From Create New Project in the Create Project from Template box, type the 
default location for the project desired to be created.  

Important   For this exercise, the default location is C:\E\Projects\40564815201 as shown in 
the figure above. 

8. Click the Create button. Create/Edit File message opens displaying that the Project 
directory structure was successfully created (copied from the project template 
selected).  

  
Create/Edit File 

Note   From Create/Edit File, click the OK button. Create New Project reappears.The user 
can create another new project directory structure, if desired. 

9. From Create New Project, click the OK button. Project Settings opens. 

 
Create New Project - New project has been created 
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10. From Project Settings, click the OK button. If the project is new, Create File/Project 
reappears. If the Seed Project already exists, Create/Edit File opens with a warning 
that the Project already exists. 

 
Project Settings 

 
Create File/Project 

Note   It may be necessary to load the correct Control File upon the initial use of the 
application. 
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Create/Edit File 

Note   Upon completion of creating the Project directory structure, the user can also create 
design files to start production using Create File/Project.  

Important   Using Create File/Project to create a seed project does not create the MicroStation 
Project Configuration File (*.pcf), nor the Project Identification File (ProjectID.xml) the way 
EDI2 does. This tool simply builds the FDOT standard project directory structure!   

Important   To create the Project Identification File (ProjectID.xml), run the ProjectID 
application from EDI2 (select Tools > PEDDS (Execute PEDDS Operations and 
Applications > ProjectID... (Open the PEDDS Application) or PEDDS (more on this later 
in the course). 

Exercise 2.3 Creating a Seed Project Directory Structure (Optional 
Exercise) 

An FDOT Seed Project directory structure can also be created using the MicroStation Manager. 
The following exercise demonstrates how to create a new Seed Project using the FDOT2008 
workspace. 

To create a new Seed Project directory structure using MicroStation XM 

1. From FDOT2008, double-click FDOT2008 icon. 

 
Opened FDOT2008 Desktop Folder 
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2. MicroStation XM 2008 Edition and MicroStation Manager open. 

 
MicroStation XM 2008 Edition - MicroStation Manager 

Note   When MicroStation XM 2008 Edition is started with the FDOT2008 short-cut, 
MicroStation XM starts using the proper FDOT2008 Workspace User and Interface. If 
a Project Configuration File (.pcf) exists, the Project area of the Workspace will have 
that project available. This .pcf file sets up reference information for the active FDOT 
project. 
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3. From Project list on MicroStation Manager, click the arrow and select New.  

 
MicroStation Manager dialog   

4. Create New Project displays. Type the 11-digit Financial Identification Number 
(FIN) in the Name box.  

5. Type the same FIN In the Description box, as shown in the following figure.  

6. Click the OK button. MicroStation Manager reappears with the newly created 
Project set as the active project. 

 
Create New Project 
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MicroStation XM 2008 Edition - MicroStation Manager 

Important   If a user tries to create a Seed Project directory structure that already exists, 
MicroStation Manager does not re-create the Project; instead, the existing project is selected as 
the active project and no data is lost. 

Tip  Tip    Upon completion of creating the Project directory structure, use Create File/Project 
to create design files to start production. 

Note   Using MicroStation XM 2008 Edition to create a seed project directory structure 
creates the MicroStation Project Configuration File (*.pcf), but does not create the 
PEDDS Project Identification File (ProjectID.xml). This tool only builds the FDOT 
directory structure. 
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Section 2.3 An Introduction to PEDDS 
by Elwin Broome, P.E., Former FDOT State CADD Coordinator 

For the benefit of new Professional’s Electronic Data Delivery System (PEDDS) users, this 
introduction restates some of the basic concepts about the PEDDS. 

At the heart of the Electronic Delivery process is an application called the PEDDS.   PEDDS was 
the first application developed in the Electronic Delivery software suite, and hence the 
“grandiose” name (the author of the software had very high hopes for what PEDDS might 
become).  However, PEDDS is not a delivery system unto itself. 

You will encounter the use of the PEDDS software early on in the Pre-Production phase of the 
Electronic Delivery process and training. The student must not become confused when mention 
is made of a "PEDDS project" and a "seed project". The use of "seed" implies growth. A seed 
project is merely a directory structure with a root directory named with a valid FDOT project id 
number. It is a template of directories to be filled with project data during the production phase.  

To speak of a "PEDDS project" means that the seed project directory structure created in the Pre-
Production phase must also be introduced to the PEDDS application and made ready for PEDDS 
processing. Once PEDDS has "done its thing" with the seed directory structure, the directory 
structure is not only a seed project, but a PEDDS project too. In other words, PEDDS now knows 
about the seed project. Once a given directory structure becomes a PEDDS project, the directory 
structure can be secured, authenticated, professional signatories can be defined, files can be 
signed/sealed, re-securing can take place, re-authentication can take place, etc.  

What actually happens when a directory structure becomes a PEDDS project? PEDDS needs a 
specific folder to store information. The \_META_INFO sub-folder belongs to PEDDS. The 
EDI2, accessed via the Electronic Delivery Desktop, will create the \_META_INFO directory 
(as will the other exercises in Section 2 previously.    

When a directory structure is given to PEDDS to become a PEDDS project, the PEDDS software 
processes every single file in the complete directory structure that was defined to be the PEDDS 
project, and generates a "finger print" of each file (called a “hash code,” or more formally, a 
“message digest”) and a relative URL with which to know the path to the file from the project root 
directory.  The hash code exists in the form of a strange looking series of digits 0-9 and letters A-
F.  PEDDS generates the number based solely on the content of the file (the name of the file or 
type of file does not matter). The number is referred to as a "hash" code because the algorithm 
used to generate the code is the Federal Department of Commerce's Secure Hashing Algorithm 
SHA-1 adopted in 1995.  

Consider this: 

The probability of two differing files (not the same content) having the same hash code value, i.e. 
the same "finger print", is, get ready for this, one over ten to the forty-eighth power! That's 
1,000,000,000,000,000,000,000,000,000,000,000,000,000,000,000,000!   This is: 

• The number of atoms in the Earth and Moon combined. 

• Greater than the number of nanoseconds in 4.5 billion years (the approximate 
age of the Earth), squared. 
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Example SHA-1 hash codes: 

• E059A970 - E74332B9 - C88EFE6B - 07AEF50B - 8DAD3F1E 

• C67AA18D - BB796868 - 864D6012 - 20303B8B - 07CC4600 

Note   These represent the hash code of a 200K MS Word document, #1 is the original, 
and #2 is the results of re-processing with PEDDS after adding only a single space! 

Details regarding the PEDDS software and how it operates can be found later in this material. 
This brief introduction is provided to give the student awareness that a file or group of files can be 
processed with the PEDDS software, and if a single bit in any one of the files that has been made 
part of the PEDDS project, is altered, PEDDS will not authenticate the data. In other words the 
software will know the data has been changed.  

PEDDS gives the Department, or consultant, a way to authenticate data given to a consultant. In 
case there are questions, both the Department and the consultant can run PEDDS to validate files 
that may be in question. 

Likewise, when production is finished, the consultant can use the PEDDS software to process the 
final set of files with which he populated the directories of the seed project. The final processing 
allows the appropriate files to also be signed and sealed to meet all legal requirements, and the 
total set of files for the project is secured and can be authenticated later as needed. 

It is important for the PEDDS user to understand the difference between data authentication and 
data validation. We tend to use the word authentication any time data is processed by PEDDS, 
when, in fact, true authentication only occurs when the hash codes produced by PEDDS for a 
given set of data are physically compared to, and agree with, the hash codes appearing on a 
printed sheet that is physically signed and sealed by the professional. PEDDS may process a set of 
data, and internally the hash codes may agree with those stored in the files for the data, yet the 
hash codes may not agree with the paper (data validates, but will not authenticate). So we must 
distinguish and understand the difference between data authentication and internal data validation.  

Section 2.4 Preparing a Project for PEDDS 
Before a project can be secured and sent to the design consultant, the project must first become 
known to PEDDS as a “PEDDS project.  ”PEDDS is an application used to simplify tasks 
involved with file security.  PEDDS allows professional users, known as “Signatories,” to 
electronically sign and seal electronic files.  PEDDS is also used to secure data, ensuring that 
anyone can easily test to determine if a project has been changed, corrupted or tampered with. 

Before PEDDS allows securing, a PEDDS Project ID and PEDDS Manifest file must be created. 
The Project ID file (ProjectID.XML) contains additional data (metadata) about the project 
including identities of key personnel, location information, etc., while the Project Manifest file 
(Manifest.XML) contains, amongst other information, the reasons why the project is being 
secured.  PEDDS provides a means of creating a Project ID file through a separate application 
called ProjectID.EXE.  Users may also use this tool to add or modify existing information in the 
Project ID file. 
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In addition to a \_META_INFO directory (which stores the ProjectID.XML, Manifest.XML, and 
other files accessed by ), a “PEDDS project” is defined by the set of directories and files existing 
in the directory structure beneath a parent directory (generally labeled with a valid FDOT project 
identification number), known as the project root directory.  The project root directory is the 
directory created in Exercise 2.1. It contains all files and subdirectories related to the project, 
including the \_META_INFO subdirectory used by PEDDS.  No files or directories outside the 
project root Directory may become part of the PEDDS project. Before creating a new PEDDS 
project, the user must know which project directory structure PEDDS is to secure. Also note that 
all file operations (copy, move, etc.) are handled outside of PEDDS. 

 
The following exercise details the steps to make an existing project directory PEDDS aware. 

 
Preparing a Seed Project with PEDDS 
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Section 2.5 PEDDS Metadata 
Due to the information needed to properly set up project metadata, FDOT strongly recommends 
that seed projects be prepared by the project manager in charge of the project or a responsible 
party charged with creating the project. This project metadata is created and stored in the PEDDS 
Project Identification file, ProjectID.xml. 

Not all descriptive metadata about a project is required at project startup, but it is important to 
enter as much information as is known at the time to reduce errors, which need later correction. 
The information needed to completely set up project identification includes the following. 

• Financial Project Identification Number (FIN No.), which becomes the project's 
folder name (11 characters as the default). THIS IS REQUIRED. 

• Federal Aid Number, if applicable. 

• Consultant Contact Number and Execution Date, if applicable. 

• Project usage (As-designed, As-Built, As- Bid, or other). 

• Location Information pertaining to the project, including County, 
Section/SubSection, Beginning Mile Post, and Ending Mile Post. 

• Project Designation or local name (i.e., Veteran's Expressway). 

• State Road Number(s) for the designated roadway. 

• Disciplines that apply to the project.  

• Bridge information, if applicable, including Bridge Number(s), Bridge On Surface 
designation, and Bridge Over Surface designation. 

• A general project description (i.e., milling and resurfacing from A to B). 

• A list of general key words pertaining to the project that can be searched for in the 
future. 

• Any additional comments relative to the identification of the project. 

• The name and title of the project’s FDOT Project Manager. 

• The names and areas of responsibility for all Professionals of Record. 

• The name of the Consulting firm or the FDOT District performing the work. 

• The Consultant’s Vendor Number, if applicable. 

If the Seed Project was created using EDI2, as in Exercise 2.1, most if not all of this information is 
already entered in the Project Identification file, ProjectID.xml. If any of the other tools were 
used to create a Seed Project, as in later exercises, PEDDS can be used to create the Project 
Identification File by selecting Project > Modify > Project ID. 
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Exercise 2.4 Preparing a Seed Project with PEDDS 

To prepare a project for PEDDS 

This exercise uses Project 40564815201, created in Exercise 2.2 using the Create File/Project 
application. Creating the Project Identification file is only needed, if EDI2 was not used to create 
the Seed Project. 

1. In the Preparing a Seed Project with PEDDS folder, click Launch.  

 

 
Launching Preparing a Seed Project with PEDDS 

2. Florida Department Of Transportation - PEDDS opens. 

 
Florida Department of Transportation – PEDDS 2.6 dialog  
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3. From the Project menu, select New --or-- click the New Project button  in the 
toolbar.  

 
Create a New PEDDS Project 

Note   Create a New Project appears several times during this process. Do not be 
confused. “New project” as it relates to PEDDS means making an existing project 
directory structure known to the PEDDS software, so PEDDS-related functions can be 
performed on the project directory structure. This process does not create any type of 
new physical directory or project structure; however, it does create a ProjectID.xml file 
in the project. 

4. Create Project opens.  Select the drive letter where projects reside. 

5. Navigate through the project directory list and select the newly created seed project 
directory structure. 
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6. In Current Path, verify the selection of the project. Click the OK button to display 
Project ID. 

 
Browse for project in PEDDS 

 
Create New PEDDS Project 
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Tip    To scan the current drive for existing PEDDS projects, populate the Find all Projects 
on Current Drive checkbox. 

Note   Server drives must be mounted as a logical drive (A:, B:, C:, etc.), as PEDDS does 
not recognize UNC shares (i.e. \\servername\sharename\). 

 
PEDDS - Project ID 
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Exercise 2.5 Create a PEDDS Project ID File 

To create a Project ID File 

1. In Project ID, click the Create/Edit a Project ID File button to begin the process of 
creating or editing a PEDDS Project ID file. Project ID for PEDDS (Financial) 
displays.  

  
Project ID dialog  

Note   The information entered in the following steps can be updated at anytime using the 
same dialog boxes and sequence of steps. The purpose of these dialog boxes is to 
provide project specific identification variables to be used by subsequent software in 
the Electronic Delivery process to create reports, and allow search engines to locate 
projects by their identifying data (like finding a book in a library by looking up key 
data in a card catalog). These search engines are part of a server-side application called 
PEDDS/DB residing on FDOT servers to warehouse projects in an electronic form of a 
plans room.  

All projects are identified uniquely by a Project Key, automatically generated by the 
system.  The Project key is a Global Unique Identifier (or “GUID”), that never changes 
no matter how many deliveries of a project occur (including revisions).  Even if 
projects root directory name changes, the Project Key should not change.  The project 
key is stored in the Manifest.XML file, and the ProjectID.XML file and the Project key 
must match in both places. 
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2. Enter the Financial Accounting Information, (FIN), number used in the previous 
exercise (405648-1-5-1-01). 

3. Enter the Contract Number. In house FDOT designed projects do not require a 
contract number.  Populate the In-House checkbox for FDOT designed projects.  

4. Verify the Contract Agreement Date. 

5. Enter the Federal Aid Number (if applicable). 

6. Designate the appropriate Project Usage option. 

 
Project ID for PEDDS (Financial) dialog 

7. Click the Next button to display Project ID for PEDDS (Location). 

8. In each of the Physical Location fields found below the grid control, enter the 
appropriate value.  

9. After all values are entered, click the Add button. The information is added to the 
Physical Location grid collection above.  More than one physical location can be added 
to the collection if warranted. 

10.  To make a correction to the values just entered, select the value from the grid, type the 
new information and then click the Modify button. 
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11. Type the Designation (common name of the facility). 

 
Project ID for PEDDS (Location) dialog  

12. Enter the State Road Number and then click the Add button. More than one State 
Road number may be added to its collection grid.  

Note    If the user attempts to add an invalid county number, a warning appears. The 
figure below is a Table of County Numbers from PEDDS on-line help. 
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Table of County Numbers from PEDDS On-Line Help 

13. Click the Next button to display Project ID for PEDDS (Disciplines). 

14. Select any disciplines that are known for the project and then click the Next button to 
display to display Project ID for PEDDS  (Bridge Identification) .  

 
Project ID for PEDDS (Disciplines) dialog  
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15. Enter the 6-digit Bridge Number as defined in the National Bridge Inventory (NBI) 
file. 

 
PEDDS - Bridge Identification dialog box 

CAUTION  If something other than 6 digits is entered and the Add button is clicked, this causes an 
error, known as an error trap.  Enter only 6 digits. 

16. Enter the Surface On Bridge description. 

17. Enter the Surface Over Bridge information, and then click the Add button. Once 
information is added, the Add button is dimmed.  
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18. Click the Next button to display. Project ID for PEDDS (Description). 

 
PEDDS - Project Description dialog box 

19. Type any Key Words about the project.  These can be used later to search in PEDDS 
DB. 

Important   In Project Description, separate the text phrases in the Key Words field by semi-
colons (;).  

20. Type a general Project Description about the project.  This should be a verbose, 
detailed description of the project.  It appears in reports generated during other 
Electronic Delivery operations. 

21. Type any Miscellaneous Comments about the project.  This is internal data that does 
not appear in subsequent reports. 
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22. Click the Next button to display the Project ID for PEDDS (Management). 

 
PEDDS – Project Management dialog box 

23. In the FDOT Project Manager box, enter the names of all FDOT Project Managers.  

Important   Separate each Project Manager’s name by a semi-colon (;) if there is more than 
one. 

24. In the Name of Professional box, enter the name of a professional of record 
anticipated to participate on the project. 

25. In the Area of Responsibility box, enter the type of work that the Professional of 
Record is responsible for. 

26. Click the Add button. To enter additional Professionals of Record, if needed, repeat 
steps 23-24 for each one. 

27. To make a correction to a Professional of Record, select the entry from the grid, make 
corrections in the edit fields, and click the Update button. 

28.  In the Name of Firm field, type the name of the firm working on the project, or the 
FDOT district number (i.e., “FDOT District 4”). 

29. In the State Vendor Number field, type the Vendor number. 
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30. Click the Finish button. Project ID re-opens with the entered project information. 

 

PEDDS – ProjectId Save Changes confirmation 

 

PEDDS – Close ProjectId dialog box 

 
PEDDS - Project ID dialog box 

Tip    The Project ID entries can be verified by scrolling up and down the dialog box. If any 
information is incorrect, click Create/Edit a Project ID File to return to previous dialog boxes. 
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Exercise 2.6 Creating PEDDS Project Header Data in Manifest.XML 

The creation of the PEDDS Project Header Data (Delivery Manager and Description) in this 
exercise is a continuation of the creation of the Project Identification.  The Project header data is 
stored in the Manifest.XML file.  If the Project was created using the EDI2 application, the user 
will not be able to create the Project Header as shown in this Exercise. Instead, see Exercise 2.8 
for the method to modify the Project Header.  

To create a Project Header continuing from the creation of the Project 
Identification: 

1. Continuing in Project ID, click the Next button. Delivery Manager Information 
opens. 

 
PEDDS - Project Manager Information dialog 

2.  In Delivery Manager Information, enter the Delivery Manager Name. 

Note   The Delivery Manager is the person managing the data, not necessarily the Project 
Manager overseeing the plans/specs development (although it could be). This Delivery 
Manager is the person securing the seed project prior to transmittal to the design 
consultant and authenticating the data delivered to the Department following the 
Production phase. 

3. In the Delivery Manager Title field, type his/her Title, then click the Next button. 
Purpose of Delivery opens. 

 
PEDDS Purpose of Delivery dialog box 
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4. In Purpose of Delivery, enter a brief project description for the purpose of the delivery 
and the reasons for securing the project  

 
PEDDS - Project Description dialog box 

5. Click the Finish button. Florida Department of Transportation - PEDDS opens 
with the information from Project ID added to the \_meta_info folder.  A 
Manifest.XML file is also created that contains the project header data just entered 
(Delivery Manager and Description). 

 
PEDDS window 

Note   PEDDS now displays a briefcase icon for the project just entered. This indicates 
that PEDDS now recognizes the project.  

2-46 © 2009 FDOT Electronic Delivery Training Course 



Pre-Production Phase  - PEDDS Metadata _____________________________________ Section 2 
 
Exercise 2.7 Modifying a PEDDS Project ID file 

Once created, Project Managers, Prime Consultants and Sub Consultants can modify the Project 
ID as necessary to reflect current information. Examples for modifying a Project ID would be 
adding Professional of Records, disciplines, or making corrections to erroneous information. 

To modify a PEDDS Project ID from PEDDS  

1. From the Project menu, select Modify < Project ID. Project ID opens. 

 

 
PEDDS - Modify Project ID 
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2. In Project ID, begin editing the PEDDS Project ID file.   Refer to Exercise 2.5 and 
modify the Project ID as required. 

 
PEDDS - Project ID (Editing the Project ID) 

Note   As previously mentioned, the Project ID for PEDDS application can also be 
accessed from EDI2: 
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Exercise 2.8 Modifying a PEDDS Project Header in Manifest.XML 

Use this function to modify a PEDDS Project Header. This function is also used to create a 
PEDDS Project Header if EDI2 was used initially to create the Seed Project. The project header 
includes the name and title of the delivery manager and a description of the secured delivery. 
Anytime a project is secured for delivery, this description must be changed to describe the purpose 
of the delivery. 

To modify a PEDDS Project Header 

1. On the Project menu, select Modify <  Delivery Information. 

 
PEDDS - Modify Project Header 

2. A PEDDS warning dialog opens.  Click the Yes button to continue modifying the 
Project Header.   

 
PEDDS dialog box 
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3. After Delivery Manager Information displays, modify the data as required and click 
the Next button to continue.  

 
PEDDS - Project Manager Information dialog 

4. Purpose of Delivery displays. Enter the description as required.  Multiple lines may be 
entered, separated with the Enter key. 

 

 
PEDDS - Project Description dialog 

5. Click the Finish button to close Description of Delivery and return to Florida 
Department of Transportation - PEDDS. Other actions in PEDDS may take place after 
this, or PEDDS may be closed. 
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Section 2.6 Checking the Project with File Checker 

Section 2.6.1 Introduction to File Checker - ED Desktop 

File Checker is a tool designed to assist with the Quality Control (QC) of Electronic Delivery 
projects. It is used to examine projects both during development and ready for submission, in 
order to provide reporting that certain portions of the project follow standards and business rules 
for the Electronic Delivery.  File Checker uses data already present in the project to provide 
simpler reporting, such as pre-existing QC reports (*.txt) from QA/QC software, and attribute data 
mined during Sheet Navigator runs. The program examines a variety of potential problems in the 
project, and presents those in color coded reports to the user. The program also provides a 
powerful search utility. The following list is only a few of the items checked by File Checker: 

• FDOT directory structure intact (directories added / deleted / and non-standard 
directories)  

• Reports directories greater than 16 chars, with spaces, multiple consecutive spaces, 
or special characters  

• Reports file names with spaces, multiple consecutive spaces, long file names, and 
special characters  

• Makes sure that full paths to files are 255 characters or less  

• Looks for same file names, found in different paths, with same or different file 
content noted  

• Looks same file content, but with different file paths / file names  

• Looks for large files (could indicate a problem file)  

• Looks for MicroStation files that do not meet FDOT file naming conventions  

• Looks Sheet files that have been signed / sealed, but are not registered in the index 
(ProjectIndex.XML) 

• Looks for Indexed sheets that are not signed / sealed (not selected by any Signatory 
file). 

• Determines presence of key ED component files (SheetNDX#.htm, 
ProjectIndex.XML, Project#.pdf, Projectfiles.xml) and looks at their 
chronology. 

• Indexes validated against PEDDS data, against data on-disk (URL paths, SHA-1 
hashes, etc.) 

• Searches for QC reports, and extracts QC Report data into sort able tables, 
including QC reporting of Critical files  

A Video tutorial for the operation of the File Checker utility is available on the Florida 
Department of Transportation, Engineering / CADD Office website. 
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Note   File Checker is only a tool to assist in the audit and reporting of projects for the 
items it checks.  One should not consider it a "black box" that will uncover all potential 
problems.  Likewise, the one should read the reports carefully to determine if a 
reported item is indeed problematic for the project. 

File Checker is accessed from the Electronic Delivery Desktop (Post Production Phase > QC of 
Project Data Structure > Launch) from the browsing pane, or from the Launch pull-down menu as 
shown in the following figures: 

 
ED – Filechecker launch 

 
ED – Filechecker launch 

File Checker may also be accessed in EDI2 by selecting Tools > File Checker... (Execute the 
FileChecker Application as shown in the following figure: 
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Section 2.6.2 Directory Structure Tab 

  
FileChecker - Directory Structure Tab 

• Missing Folders - checks the default structure (found in the 
\FDOT2008\Project_Template\ folder) on the left against the active project 
structure on the right and reports any folders missing, added folders, etc.  If 
\FDOT2008\Project_Template\ is missing, then it uses 
C:\FDOT2008\APPS\FileChecker\resources.zip\dirlist.txt as a backup for 
comparison. 

• Non-Standard Folder Names - checks the default structure on the left against the 
active project structure on the right and reports any non-standard folder names that 
have been added to the active project and do not meet standards. 

• Invalid Folder Names - checks the default structure on the left against the active 
project structure on the right and reports any invalid folder names found in the 
active project directory structure. 
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Section 2.6.3 Project Files Tab 

 
FileChecker - Project Files Tab 

After the Directory Structure tab is accessed (and its sub tabs: Missing Folders, Non-Standard 
Folder Names, Invalid Folder Names, then next tab the user should open is the Project Files 
tab. 

The Project Files tab subsequently reads all project data, and loads several control files found in 
the \FDOT2008\APPS\FileChecker\ directory for use in its subsequent checking operations and 
reporting.  The size of the project, and where it is located (local disk or across the network on a 
server) dictates how long this operation will take. 

Required ED Files - Reads RequiredFiles.xml from the \FDOT2008\APPS\FileChecker\ 
directory and checks the active project for these files and their chronology (who 
came first?). 

Duplicate Names - Checks the active project and lists any with the same name, but same or 
differing data (different versions of the same file in another location?). 
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Invalid Files/Names - Reads the project directory, compares against FDOT project file naming 

business rules and the files FileNames.txt and DescriptionData.txt in the 
\FDOT2008\APPS\FileChecker\ directory and checks the active project for any 
invalid files and non-standard file naming conventions.  Also checks for zero-byte 
files (empty files), very large files (> 100 MB, >200 MB), and files that contain 
special characters and spaces (particularly consecutive spaces), etc. 

Duplicate Data - Checks the active project and lists any file(s) that contains duplicate data (the 
same name or different file name?). 

Miscellaneous - Checks the active project and lists any miscellaneous file(s), looking particularly 
for files that may contain known engineering data from FDOT design software, 
like GEOPAK (.inp, .gpk, .tin, .dat, etc.), which should have either Journal entries 
describing those files and their content, or have EDMS entries (more later on this). 

Section 2.6.4 File Distribution Tab 

 
FileChecker - File Distribution Tab 

File Distribution - Provides graphics which show the file distribution (% data wise of the total 
project, and an actual file count per folder) across the entire active project. 
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Section 2.6.5 MicroStation Files Tab 

 
FileChecker - MicroStation Files Tab 

Non-Standard Names - Reads the files FileNames.txt and DescriptionData.txt in the 
\FDOT2008\APPS\FileChecker\ directory and checks the active project for any 
non-standard MicroStation files naming conventions. 
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Quality Control Reports - Checks the active project for existing QC Reports (those .txt files 

produced by the GDM QC Reporter application), lists all reports found and 
displays QC information including the compliance in the dialog.  Compliance 
matching data is derived from DescriptionData.txt in the 
\FDOT2008\APPS\FileChecker\ directory.  Each different QC report found is 
accessed from the file drop down list by clicking as shown: 

 

 
 

Critical File Report - Checks the active project for existing QC Reports on critical files lists all 
reports found and displays QC information including compliance in the dialog.  
Critical files are those MicroStation files deemed to need a high level of 
symbology QC compliance because subsequent automation depends on the 
symbology of the graphical elements in these files being correct.  

Design Attributes – Reads the Indexes (Index.XML and/or SheetInfo.XML) from the active 
project, if present, and provides information about the design files including sheet 
information, and attached and missing MicroStation reference files. 
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Section 2.6.6 PEDDS Files Tab 

 
FileChecker - PEDDS Files Tab 

Manifest Files - Checks the PEDDS SHA-1 hash codes and file URLs (paths) from the 
\_meta_info\Manifest.XML against the files in the active project and reports any 
file that has been modified, added, or deleted after being secured. 

Signature Files - Checks PEDDS SHA-1 hash codes and file URLs (paths) from the 
\_meta_info\Signatory Files and validates any Signatures in the active project. 

Disk Files - Validates the PEDDS Manifest and reports any file with an invalid hash code.  This 
report is similar in content to the Manifest Files tab report. 

Index Files - Validates files that are referenced in the Index (ProjectIndex.XML) of sheets and 
the status of those files in PEDDS. 
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Section 2.6.7 File Search Tab 

 
File Checker - File Search Tab 

File Search Tab - Allows users to search the active project for files. Searches may be conducted 
by combinations of File Name, File Type (extensions) and text phrases within the 
files of given names or types.  The Type Filter is a pull-down showing file 
extensions found in the project, including logical groupings. 

  For text searching, File Checker can list the locations of the text within files for 
easier editing with other editors, as File Checker is not an editor.  Note that once 
files are found and shown in the grid, double-clicking the file name opens that file 
using the associated application within Windows. 

  The search option supports standard wildcards and regular expression searches (see 
File Checker’s on-line help for regular expressions (shown below) or the wealth 
of documentation on the internet about regular expressions). 
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Section 2.6.8 Reports Tab 

 
File Checker - Reports Tab 

Reports Tab - Allows users to create and save HTML formatted reports based on the options 
checked in the dialog (and those options opened/viewed under the tabs). These 
reports are not mandatory for Electronic Delivery, but are provided for 
convenience.  Note that some Districts may require users to produce and deliver the 
reports as evidence of good Quality Control practices.  The report contains those 
sections that are checked in the interface. 
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Section 2.6.9 FileChecker Comment Feature 

In order to add a comment to any item in FileChecker (Folders or Files), the user needs to double 
click the item as shown in the figures below.  The “add comment” dialog box opens .  Type the 
comment into the “add comment” dialog box and click ok.   Filechecker reappears.  To view or 
change the comments for the file, double click the file and the comments will appear in the dialog 
box.  Comments are saved in Filechecker.cmt.  You can specify the location of the file, but it is 
only read from the project root folder. 

 
File Checker – Comment Feature (Double Click any item) 

 
File Checker – Add Comment 
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Exercise 2.9 Checking the Project with File Checker 

To open the Seed Project with File Checker 

1. From Electronic delivery, click launch and then click the FileChecker link. 
FileChecker opens. 

 
Open FileChecker from Electronic Delivery kiosk 

 
FileChecker 
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2. From the File Menu, select Open Project.  

 
FileChecker - Open Project 

3. Once Browse For Folder displays, browse to the active project, 
C:\E\Projects\40564815201 and click the OK button to continue. 

 
Browse For Folder 
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4. FileChecker re-appears with the selected project loaded. 

 
FileChecker C:\E\Projects\40564815201 

To check the Project 

1. Follow the instructor during a discussion on the various tabs and reports available in 
File Checker.  
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Section 2.7 Securing the Project for Delivery to 
Design Consultant 

Prior to delivery of the seed project to the Design Consultant, the project should be secured with 
PEDDS. Securing the project provides a means of “fingerprinting” the files in the project such 
that if any file(s) are modified, the authentication process can identify the changes. This is 
important should questions arise. 

After FDOT has secured the project, the project can be copied to a portable media, such as a 
floppy disk (subject to project size), or burned to a CD. The authentication procedure is performed 
to ensure that the project template transmitted by the Department can be verified when received 
by the Design Consultant. 

 
Exercise 2.10 Securing the Project for Delivery to Design Consultant 

To secure the project for delivery to design consultant 

1. Open PEDDS by any of the methods previously presented. 

2. From the PEDDS Project menu, select Secure --or—click the Secure the Current 
Project icon  on the tool bar. Securing Project opens briefly then closes. .  

 
PEDDS 

 Electronic Delivery Training Course © 2009 FDOT 2-65 



Section 2 __________ Pre-Production Phase - Securing the Project for Delivery to Design Consultant  
 

3. Delivery Manager Information displays. Enter the required Project Manager Name 
and Project Manager Title and then click the Next button to continue. 

  

 
Delivery Manager Information 

4. Once  Purpose of Delivery opens, enter a brief description of the purpose of the 
delivery and then click the Finish button.  PEDDS begins the process the secure the 
project. 

 

 
Description of Delivery 

Note   PEDDS passes all files in the project through the Federal Government SHA-1 
secure Hash algorithm to create a manifest list of Hash Codes for each file. That 
manifest is contained in a file called Manifest.XML, located in the 
\Project\_meta_info\ folder. 
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5. Report Viewer opens and displays the Delivery Manifest Document (a report based 
on the Manifest.XML file). Click the Print button to send the Delivery Manifest 
Document to a print device.  The Delivery Manifest Document must be printed (See 
Item 14 of the Compliance Certification Checklist Report) and reviewed by the 
delivery manager. 

 

 
PEDDS - Report Viewer 

Note   The Delivery Manifest Document is a signed paper document used to secure a 
Manifest File (and those files referenced by the Manifest File) and to reference the 
Signature files in the project delivery.   

By signing the Delivery Manifest Document, one has associated their name (the 
delivery manager) to the manifest file that corresponds to the hash code on the paper 
Delivery Manifest Document.  

The Manifest File itself lists the project files by their relative URL and each file’s 
SHA-1 hash-code, thus the signatory has signed (but not sealed!) the files listed in the 
Manifest (that they belong to the project data set). 

6. Click the EXIT button to close Report Viewer. 
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Section 2.8 Preparing the Delivery Media 
After the seed project is secured, it can be copied to a portable media, such as a floppy disk (if it 
fits), or burned to a CD for delivery to the design consultant. If a CD is to be burned, always 
choose the Data CD creation option when burning the CD. 

If anything changes in the project directory (files added, files deleted, files modified) prior to 
putting the project on a portable media for the consultant, open this project in PEDDS and re-
secure the project. 

This concludes the Pre-Production Phase of the Electronic Delivery Training Course. 
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3 Production Phase 
The Production Phase training section covers the details of using the production tools. 

 

• Introduction to Production Tools 

• File Management Considerations 

• Authenticating the Project 

• Importing the Seed Project 

• Indexing / Plotting / Journaling - Indexing 

• Review of the EDI2 Application 

• Indexing the Project 

• Adding EDMS Comments 

• Updating Attributes 

• Updating the Index 

• Indexing / Plotting / Journaling - Plotting 

• Indexing / Plotting / Journaling - Journaling 

• Creating Reports and Project.pdf in EDI 

• Revisions 

• Signing & Sealing the Project 

• Indexing / Plotting / Journaling - Updating the Index 

• Signing & Sealing / Securing the Delivery 

• Indexing / Plotting / Journaling –PEDDS Viewer 

• Creating Project Subsets 

• Creating Strung Projects 

• Delivery Compliance Checklist 

• Making a Delivery 
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Section 3.1 Introduction to Production Tools 
Section 8.5 of the CADD Production Criteria Handbook (CPCH) describes the Production Phase 
as the incorporation of several functions that produce a successful electronic delivery for future 
utilization of project data. This requires compliance with standards and documentation for the 
methods and decisions used to produce CADD deliverables. A few of these functions include the 
creation of files to FDOT standards, documentation of those files, and electronic securing and 
packaging of them. 

Shown below are tools used during the Production Phase of Electronic Delivery (ED). 

 
Expanded Production Phase 

• When the project is created and delivered to the Prime Consultant or Lead 
Designers (See Section 2 of this manual), the Production Phase of Electronic 
Delivery for the project can begin. 

• Project Distribution should be provided by the Department’s Project Manager. The 
Design Consultant receives the project created in the Pre-Production Phase on a CD 
ROM or other portable media. The Production Phase begins, for the consultant, 
with authenticating and importing the contents of the received CD ROM to a 
desired project directory on their server or workstation. 

• FDOT requires the delivery of graphic files to be in a MicroStation Design File 
format and the delivery of Plan Sheet images to be in a Postscript format. (See 
Chapter 3 of the FDOT CADD Manual). 

• A link to the Compliance Certificate Form is also provided in the Production 
Phase. The Compliance Certificate is to be printed and used as a checklist to verify 
that the noted items are reviewed and addressed. 
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Section 3.2 File Management Considerations 
The processes of Electronic Delivery can be very intensive in terms of file management.  
Because large amounts of data are accessed repeatedly during Electronic Delivery operations, it is 
highly recommended that most Electronic Delivery operations be done on the local hard drive for 
both performance reasons, and that the fail safes are better between local processors and local 
memory and the local hard disk.  It has been observed many times that processes fail when being 
run across even a well maintained network of server mapped drives, but run successfully when the 
data is copied to a local hard drive.  However, prudency dictates that the data be preserved on the 
networked server’s shared drive for joint access to the data and backup purposes. 

FDOT employs a file management system called TIMS (see http://www.tims3.com) to allow 
FDOT to operate and edit files on the local hard drive, but warehouse the files each night to the 
server.  There are other tools like TIMS on the market.  If there is no tool like TIMS, the user 
could employ the “poor man’s” file management system and use what the current Operating 
System (Windows) provides.  The user could set up batch commands in Windows, which copy 
changed files to the users hard drive, where the user could then work.  Then another batch file 
could be run to copy just the changes back to the server.  The Windows consol XCOPY command 
and several qualifiers, to assist the user in copying modified files from a network location to a local 
drive and then back again are ideal for this task. 

The following switches employed in the example batch file commands are:  

 

/D – copies only files changed on or after the date of the destination file (Modified files)  

/E – Copies all directories and subdirectories (includes all project files)  

/V – Verify the files copied  

/H – Copies hidden and system files (just to make sure the projects are identical)  

/Y – Suppresses confirmation during processing  

 

Example #1  
Batch file commands copies Project 23028825201 from remote server drive “M:” to local drive 
“C:”  
cls  
echo off  
echo *************************************  
echo ** **  
echo ** COPY Project 2302882 to LOCAL **  
echo ** **  
echo *************************************  
pause  
xcopy M:\Server_Share\23028825201\*.* c:\e\projects\23028825201\ /D /E /V /H /Y  
cls  
 
  

http://www.tims3.com/


Section 3 ___________________________ Production Phase - File Management Considerations 

3-4 © 2009 FDOT Electronic Delivery Training Course 

Example #2  
Batch file commands copies Project 23028825201 from local drive “C:” to remote drive “M:”  
cls  
echo off  
echo *************************************  
echo ** **  
echo ** COPY Project 2302882 to SERVER **  
echo ** **  
echo *************************************  
pause  
xcopy c:\e\projects\23028825201\*.* M:\Server_Share\23028825201\ /D /E /V /H /Y  
cls  

Note   Modify the example batch files to designate the appropriate remote and local location. 

The examples can be made into batch files (a file with a .bat extension in Windows) and edited to 
reflect the project data being worked on.  These are executed in Windows by running them like 
any other executable (i.e. double-clicking the file name from Windows Explorer, or creating an 
icon on the desktop to launch the batch file, etc.).  The user can even set up the Windows Task 
Scheduler to run the batch files automatically at specific times (like example #2 at the end of the 
work day to copy the files up to the server, then example #1 just before arriving at work each 
morning so the latest “fresh” files are ready to work on).  Likewise, the Windows Scheduler can 
also be set to run the batch file upon logging on, or when the computer is idle, etc.   

Note   If configuring batch files to run with Windows scheduler, make sure they do not 
include the “pause” command, as that would stop their execution from completing until 
user interaction is received. 
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Section 3.3 Authenticating the Project 
If the FDOT Project Manager provides a project CD to the consultant, it is recommended to 
authenticate the CD prior to importing the contents to the project server. 

PEDDS features the ability to check the integrity of secured project files and directories. This 
function of PEDDS is used to authenticate all files and the directory structure delivered to design 
consultants or FDOT. Project designers may use the program at any time to check that the project 
has not been tampered with after it was secured. Authenticating a project detects any additions, 
deletions, or modification of files. 

Authentication is the process of comparing the PEDDS generated message digests (SHA-1 Hash 
Codes) of the manifest file and signature files for an on-hand delivery file set to those stored on a 
PEDDS generated, signed manifest document for a specific delivery. This process is similar to 
validation, but extends the process to the signed paper manifest document. 

US Secure Hash Algorithm 1 (SHA1) is a secure hash standard which produces a condensed 
representation of a message or data file. The SHA-1 is called secure because it is computationally 
infeasible to find a message which corresponds to a given message digest, or to find two different 
messages which produce the same message digest. 

 

 
Authenticating Seed Projects 
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Exercise 3.1 Authenticating the Project 
The entire project or just the signed and sealed files (covered later in course) can be authenticated. 
According to standard procedure, it is recommended that the consultant authenticate the project 
delivered from FDOT Project Manager prior to importing the project. 

To load a project in PEDDS 

1. Select the executable file EDSection3ExercisesStart.exe, ensure Unzip to folder is 
set to C:\e and click the Unzip button to place the starting dataset for Section 3 on the 
hard drive.   

Note   Executable files are provided in the dataset for logical starting points throughout 
Section 3.  For example:  the executable file EDSection5Exercise5.8Start.exe 
contains the files from Section 5 exercises up to Exercise 5.9.  If encountering errors 
while working through an exercise, select the executable with the nearest starting point 
and unzip the files as demonstrated above.  The Unzip to folder will be set to the 
correct hard drive location. 

2. In the Authenticating Seed Projects folder, click Launch. Florida Department of 
Transportation – PEDDS opens. 

 
Launching PEDDS 

 
Florida Department of Transportation - PEDDS 
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3. From the Project menu, select Open --or-- click the Open Project icon  on the 
toolbar.  

 
Open a PEDDS Project 

4. Open Project appears.  Select the drive letter where the project resides, usually the CD 
drive, from the pull-down menu as shown below. 

 
Open a PEDDS Project 

  



Section 3 _________________________________ Production Phase - Authenticating the Project 

3-8 © 2009 FDOT Electronic Delivery Training Course 

5. Navigate to the projects folder and double-click the project.  Verify the selection of the 
project in the Current Path box.  If the selected project is incorrect, repeat this step.  
To load the selected project into PEDDS, click the OK button. The loaded project is 
now ready to be authenticated. 

 
PEDDS Open Project 

Note    The class project may already be copied to the local hard drive under the working 
folder C:\e\projects\. 

Important  If the project is on multiple CD’s, use standard Windows tools to copy the 
complete project to a temporary folder. Authentication across multi-media is not supported. 
The project must reside in a single contiguous block of storage space to be processed by 
PEDDS. 

Tip   Folders with a Briefcase icon represent existing PEDDS projects. Populate the Find all Projects 
on Current Drive checkbox to have PEDDS locate the PEDDS projects on the current drive. 
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To authenticate the project 

1. From the Project menu, select Authenticate --or-- click the Authenticate the 

Current Project icon ( ) on the toolbar. 

 
PEDDS - Authenticate a Project 

2. If the project was previously secured, Authenticating Project opens and the 
authentication process begins. 

 
Authenticating Project dialog box 
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3. After the authentication process finishes, the Report Viewer automatically opens and 
displays the results in a report called Delivery Authentication Error Report. Click 
the Print button to send the report to a print device. 

 
PEDDS - Report Viewer dialog 

4. To close Report Viewer, click the EXIT button.  

Note   The Delivery Authentication Error Report is a paper trail validating that all files 
in the project directory are the same files as listed on the manifest document. This 
validates that no file has been changed since the project was secured. 
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Important  Authenticating the Project: Modified File Error Messages 

The following figure displays an example of a Delivery Authentication Error Report 
identifying a file that has been modified and does not pass authentication. The authentication 
process identifies files that have been modified, as well as files that have been added to or deleted 
from a project. 

 
Report Viewer - Invalid Project Files 
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Section 3.4 Importing Seed Projects 
Before a design consultant can begin work on a project, a copy of the project must be made 
available on the consultant’s production server. The folder structure of the project is defined in 
Chapter 4 of the CPCH. If the user receives a project CD from the FDOT Project Manager as 
recommended in Section 8.5.2 of the CPCH, then the design consultant may use standard practices 
to copy the contents of the project CD to the production server.  

If no project CD is made available by the FDOT Project Manager, the design consultant may use 
one of the 3 methods described in the Pre-Production Phase to create a new project. For FDOT 
In-House projects, the project is made available in TIMS Document Management software. The 
Project Root Directory is the file system directory that contains all project files and discipline 
folders. The project root directory should not contain files that do not pertain to the project, nor 
should files that are part of the project reside outside of the project root directory or one of its 
subfolders. Note:  There are no exercises for this section.   

Section 3.5 Indexing / Plotting / Journaling 
A Project Index contains meta data for all files, and particularly those identified as sheets in a 
project directory. This meta data includes data such as sheet order, sheet file names, component 
and discipline information, and file descriptions. The Index file, titled ProjectIndex.xml, resides 
at the root of the project and is considered the sole source of sheet index information. Other files 
(such as Sheetndx.htm, which is generated by EDI2) are considered index reports. 

 
Indexing/Plotting/Journaling 
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The Electronic Delivery Index (EDI2) application provides tools designers can use to quickly 
build an index from a set of MicroStation plans in FDOT standards. EDI2 works in conjunction 
with the Department's required CADD package, Bentley MicroStation. The Department's tools 
within MicroStation must be used to tag the proper information within the design file sheets. This 
is done interactively within the design session, using the Sheet Navigator application (available 
from the FDOT Menu in the FDOT2008 workspace interface).  

Sheet Navigator identifies administrative information on sheets, such as sheet type, sheet 
number, description, County, State Road number, etc. EDI2 calls Sheet Navigator in the 
background to mine this data and build an index of information about those files. EDI2 can also 
import Sheet Navigator index data directly.  Sheet Navigator creates index data, named 
SheetInfo.xml, in the project root folder and optionally in project discipline folders. EDI2 stores 
mined data as a single file in the root directory of the project called Index.XML, and contains the 
meta data about the parent files it documents. The Sheet Index, ProjectIndex.XML is produced 
from this attribute data and also stored in a standardized XML format. Both Index.XML and 
ProjectIndex.XML must be delivered to the Department. 

Because EDI2 is aware of the sheets in the plan set, it makes sense that the functionality of batch 
plotting a project also falls within its operational parameters. EDI2 uses MicroStation plotting to 
produce image files of each plans sheet to FDOT specifications. 

EDI2 also creates new FDOT seed projects if they do not previously exist. 

Section 3.6 Reviewing the EDI2 Application 

Section 3.6.1 EDI2 Interface 
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EDI2 is a multi-document interface application. In the image above, the three EDI2 windows are 
shown.. The three windows initially available in EDI2 are Project Viewer, Image Viewer and 
Index Editor. These windows may be arranged sized, tiled and cascaded. EDI2 opens many other 
windows and panes as well.  

The Project Viewer window is comprised of four panes; Components, Files and Folders, File 
Properties and Attribute Data.  Several of the tabs, which provide different methods for working 
with project data, found on the individual panes are linked including the following: 

The Project Files tabs in both the Files and Folders and the Files Properties panes display the data 
for all files in the project.  

The Sheet Files tab in the Files and Folders pane and Sheet Information tab in the Files Properties 
panes display the sheet information mined from design files.  

The Image Files tabs in both the Files and Folders and the Files Properties panes display 
information about image files in the project.   

Note   Each list view or tree view of files and folders is linked to a context menu. Users 
can explore the functionality of EDI2 by positioning their mouse over a window pane, 
an item in the pane or a status bar, and then right-clicking to see available options. 

Section 3.6.2 EDI2 File Data 

When executing and navigating to a project, EDI2 creates the following files in the project root 
folder and in the current local user application data folder (Typically: C:\Documents and 
Settings\username\Local Settings\Application Data\EDI).  The first time EDI2 is executed (or 
after a new version is installed) EDI2 configures and initializes all settings according to the users 
workstation environment. 

• EDIProject.edi - Saves the Sheet Index Files tree view as XML data in the project 
root folder.   

• EDILog.xml - Saves all informational, warning and error data. 

• EDIConfigure.xml - The initial EDI2 configuration files that is generated and read 
when EDI2 is first run. Any changes to most of this data, is stored in the registry 
and takes precedence. 

• EDIBackupList.xml - A list of files saved when the user deletes sheet files while 
in EDI2. They can be restored from the Restore Files tab in the Project Viewer’s 
File Properties pane. These files are copied to the user’s local application data 
folder and given GUID names, so files in different folders with the same name can 
be restored. Backup files are automatically restored if the Re-create Plot File 
process fails. 

• Index.xml - The primary project database file used throughout the ED process.  

• ProjectIndex.xml - The XML output used to define a simple sheet index.  

• Sheetndx#.htm - A required file that is generated to display the project and sheet 
index information in a user-friendly form. This file can be created using EDI2. 
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• Project#.pdf – The complete plans set. All sheets in the project are consolidated 
into a single PDF document. An intermediate Postscript file of all sheets may be 
deleted. 

• ProjectFiles.htm - An HTML report containing a simple file index. 
ProjectFile.htm - An HTML generated to document all project files and EDMS 
data. 

Section 3.6.3 EDI2 Main Menu 

 
 

File  Opens, imports, creates and saves EDI2 project data 

View  Displays EDI2 Projects, Index, Image, Journal, and other view windows 

Index (Step by Step) Provides a step by step work flow for creating ED data 

Tools  Provides access to other ED applications and EDI2 settings and options 

Window   Selects and manipulates EDI2 windows 

Help  Displays Help menus and the EDI2 Splash Screen 

GoToMeeting Provides easy access to join a GoToMeeting session. 
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Section 3.6.3.1 EDI2 File Menu 

 
EDI2 File Menu 

New... (Open New EDI Project – EDIProject.edi) 

• Clears the Plans Set tree view.  

• Clears the project index data.  

• Prompts user to set a new EDIProject.edi location. 

• Sets initial project path (The project path can be altered through Start Project. The 
EDIProject.edi location is the root folder of the project.)  

• Prompts for overwrite if EDI2 input file exists.  

• If the Project Index.xml exists, EDI2 backs up the original file before overwriting.  

• Optionally, an existing Index.xml can be read and updated for a new EDI2 project.  

• If no Index.xml exists, EDI2 prompts to create a new one. 
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Open... (Existing EDI Project – EDIProject.edi) 

• Opens an existing project.  

• Reads Plans Set data.  

• Sets the corresponding project path.  

• Reads Index.xml, if exists and may prompt the user to mine project data.  

• If no Index.xml exists, prompts to mine project data. 

 

Save... (EDI Plan Set Data – EDIProject.edi) 

• Saves EDIProject.edi data to disk, which also automatically occurs on exit of 
application.  

• Index.xml and EDIProject.edi are automatically saved for when File > New (Open 
New EDI Project – EDIProject.edi) or File > Open... (Existing EDI Project – 
EDIProject.edi) is selected, or upon exit. 

• If ReadOnly Mode (Restrict write/create functions) is selected, saving data is 
disabled. 

 

Create Project... (ProjectID and PEDDS) 

• Creates a new project from the FDOT project template and begins to create a 
Project ID (ProjectID.xml) in the project’s _meta_info folder for PEDDS. 

• Optionally invokes PEDDS to review and complete Project ID data.  

 

Exit 

• Saves registry settings.  

• Additionally, if ReadOnly Mode (Restrict write/create functions) is NOT 
toggled on, saves current Index.xml and EDIProject.edi to disk. 

• Closes MicroStation, if started.  

• Exits EDI2.  
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Section 3.6.3.2 EDI2 View Menu 

 
EDI2 - View Menu 

Project Viewer (All files, Image files, Design Sheets)  Displays overall view of 
project folder and files, including sheet information and status. Several tabs are 
displayed along the tops of various window panes, including the following: 

• Sheet Index Files (Plans Set) – Tree view representation of the sheet index. Sheets 
can be placed by dragging and dropping from the file list on Image Files tab, 
automatically from the Sheet Information tab by way of a right-click menu item or 
selecting Index (Step by Step) > 4) Sheets (Working With Sheets) > 1) 
Update... (Add/Replace index sheets).  

• Project Files (linked tabs) – Tree view representation of project folders, files and 
sheet information. All files, regardless of type, are displayed in this list view for 
each directory in the project.  

• Sheet Information (linked to Sheet Files tab) – Tree view representation of 
project folders and sheet specific files.  

• Image Files (linked tabs) – Tree view representation of project folders and a list 
view of all image files including Postscript, pdf, jpeg, and tiff. The user may drag 
image files from folder listings to the appropriate Plans Set component tree view 
node. The image file appears at the bottom of the component listing. 



Production Phase - Reviewing the EDI2 Application____________________ ________ Section 3 

Electronic Delivery Training Course © 2009 FDOT  3-19 

• Process Log tab – Errors, warnings and information messages are displayed. 
Process log information is automatically saved in XML format. Any time a warning 
bell sounds, corresponding error information is recorded here. 

• PEDDS Meta Info tab - Displays PEDDS information read from the _meta_info 
folder. 

In general, the following color-coding is used: 

On the Project Files tab 

• Green – File attribute data (mined data) is present and appears OK. (Project Files)  

• Red – File attribute data is missing.  Data needs to be updated.  

On the Sheet Information tab 

• Green – All sheets are present and accounted for. (Sheet Information)  

• Amber – Postscript sheets are present but the master design file was open for write 
access and may have been modified. EDI2 only checks the master design file 
modify date for comparison.  Reference files are not checked.  

Note   Opening a file with MicroStation for write access modifies the file attributes. 

• Red – Postscript sheet files found in the source that are missing or do not exist. 

• Blue - Postscript sheet files that are not to be plotted. These files are marked “Not 
Plot” or “Obsolete” by Sheet Navigator.  

On the Image Files tab 

• Black – Image file has not been assigned to the project sheet index (Plans Set).  

• Green – Image file is included in the project sheet index (Plans Set). 

 
Index Editor (Edit and Save Index) – Assembles the Plans Set data into a listing of plans 

sheets. The user can make corrections to description and sheet number as necessary, as 
well as removing invalid sheets.  

  Clicking the Save icon ( ), saves index data to ProjectIndex.xml. 

Note   If changes are detected, the user is prompted to save ProjectIndex.xml on exit and, 
if required, for other downstream processing. In any case, EDI2 remembers the sheet 
information in EDIProject.edi, which is automatically saved. 
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Image Viewer (View Postscript use with Index) – Displays Postscript images to verify sheet 
information, and enables zooming, measuring and printing of sheets. The Lock feature, 
used in combination with the Index Editor, makes scanning of project sheets for 
description and sheet numbers possible.  

  For example, EDI2 can display sheets sequentially using the Index Editor and Image 
Viewer. After collapsing other windows, tile the Image Viewer and Index Editor 
horizontally. Zoom and locate the lower right corner (  ) of a sheet in the Image 
Viewer. Lock the image (  ) and select the Show Image icon (  ) in the Index 
Editor. The user can navigate down through the sheets (  ) and see the sheet 
numbers of each sheet. 

Journal Editor (Create/Edit Project Journals) – Edits the Journal files. The Journal Editor 
can be launched from a folder or file to include a relative path reference automatically 
(see right-click menus). Journals are opened and saved in the data folder by default or 
as specified by the user. 

Index Browser (Sheet Index Grid View) – Displays index data in a simple HTML format by 
generating SheetIndex.htm (The final HTML index, Sheetndx.htm can be created in 
EDI2). 
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Section 3.6.3.3 EDI2 Index (Step by Step) Menu  

 
 

Project (Mining File Attributes) - Displays commands related to the EDI2 project index 
data, Index.xml, and the mining process.  

Journaling (Create / Edit Project Journals) – Opens the journal editor window by way of 
the Journal tab.  

Create Plot Files (How to Create Postscript Files) – Displays a dialog explaining how to use 
EDI2 to create Postscript Files. 

 
EDI2 – Index Data 
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Sheets (Working with Sheets) – Displays commands related to the project sheet index, 
ProjectIndex.xml. 

Index Editor (Edit and Save Index) – Invokes the Index Editor. 

Note   Each time the editor is activated, the Plans Set is polled for new or updated entries. 
The reverse process occurs when the Project Viewer is activated. 

Basic HTML Index (HTML Index for the Project CD/DVD) – Creates and views the 
required final HTML sheet index, Sheetndx.htm. 

 
 

 Project PDF (All Sheets Consolidated into PDF) – Creates and views the composite PDF 
file. Project#.pdf contains all sheets in the ProjectIndex.xml. 

 
 

All Files Report (ProjectFiles.htm) - Creates an HTML report on all files in the project, 
ProjectFiles.htm. Before creating ProjectFiles.htm, EDI2 prompts the user to verify 
that attribute data is available for every file in the project. 

Revision PDF (DeltaNDX Sheets Consolidated into PDF) – Displays the following menu 
items for working with revised projects.  

 
 

• Create – Creates the composite pdf for a revised project. Revised project PDFs are 
named Revision1.pdf, Revision2.pdf and so forth. The user selects the appropriate 
index number. 

• View – Views the revised project pdf. The user selects the appropriate index 
number. 

• View DeltaNDX – Displays DeltaNDX#.htm in an Internet browser window. This 
file is the source index for the revised project index. DeltaNDX#.htm, in addition 
to providing the Delta report, also contains XML data. 

EDMS (External Import and Export XML) – Used to preserve EDMS data or combine data 
from sub projects. 
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PROJECT INDEX TOOLS  

 
EDI2 - Index Menu - Project Index tools 

Project (Mining File Attributes) displays commands related to the EDI2 project index data, 
Index.xml, and the mining process.  

 
Index.xml (Click for Information) – Displays a dialog explaining what is contained in Index.xml. 

 
EDI2 – Index Data 
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• Import… (New! Import Sheet Navigator data) – Imports SheetIndex.xml from 
the root folder or any discipline folder. 

Note   This is the preferred method for mining design file data. Ideally, the user should 
execute Sheet Navigator to create SheetIndex.xml for the project or at least a discipline, 
and then import this index. This is the quickest and most efficient method. Once 
SheetIndex.xml is imported use Mine Modified Files to complete the mining process 
for all other files. 

• Mine Modified Files (Mine for Changes) – Mines only files modified since a 
previous mining operation.  

Note   To mine all files in the project, select Tools > Mine All Files (Force Mine of All 
Files). 

• Verify (Have changes occurred) – Verifies all files are mined and up to date. 
EDI2 writes information concerning suspect files into the Process Log, Errors list.  

• Save (Save Index.xml file) – Saves index data to Index.xml, explicitly.   

• Save Copy (Save a copy of Index.xml) - Saves a copy of Index.xml to another 
location. 

Note   EDI2 saves the Index.xml data automatically when closing or changing to other 
projects, as long as Read Only mode is NOT enabled. Also, the project Index.xml must 
be located in the project root folder. 

Set Default Component (Set/Reset Project’s Primary Component) – There are options 
available to set or reset the project’s primary component as well as the component for 
sheet files within a discipline folder. 
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To Set the Default Component from within EDI 

1. Go to Index (step-by-step) < Project (Mining File Attributes) < Click Set Default 
Component (Set/Reset Project’s Primary Component).  Set Default Component 
dialog box opens.   

2. Select the desired component from the pull-down menu and press OK (see figures 
below).   

  
EDI – Set Default Component 

 
EDI - Set Default Component 

 
EDI - Set Default Component 
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To Set Individual or Components of Sheets within Discipline Folders 

1. Click on the Sheet Files tab in EDI. 
2. Right click on the discipline folder or sheet file and click Set Component, as needed. 

(see figures below).   

 

 
Set Component (sheet file) 
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EDI - Set Component (discipline folder) 

 
EDI - Set Component dialog box 
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3. The Set Component dialog box opens. Set the correct component for the displayed 
sheets. 

 
EDI - Set Component 

4. Select and check the desired sheet files.  Right-click in the list for more selections 
options. 

 
EDI - Set Component 
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5. Click Apply to update the list with the new component values. 

 
EDI - Set Component 

6. Click Finish to commit changes and exit. 

 
EDI - Set Component 
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JOURNAL TOOLS 

 
EDI2 - Tools - Journal 

Journaling (Create/Edit Project Journals) provides tools to assist users in creating Rich 
Text Format (RTF) files, which document a project. Opens the Journal Editor by way 
of the Journal tab on the Project Viewer window. 

Note   EDI2 versions prior to MR 3, stored journal data in XML format. This IS NO 
longer the preferred method. RTF is a common format and allows the inclusion of 
images. Journal files are now created in RTF only. 

  The Journal Editor provides a tool bar for creating, opening, and other common editor 
functions. 

 
•   New – Creates a new journal. 

•   Open – Opens an existing journal 

•   Save – Saves the current journal 

•   User Info – Opens a user dialog used to insert user data into the journal 

•   Text Edit Buttons - Cut, Copy, Paste, Bold, 
Italic, Underline and text Justification. 

•  Insert Standard Text – Displays a tree view of standard text to be inserted 
into the journal.  

The Insert Standard Text Menu displays by right-clicking in the Insert 
Standard Text tree view (The right window pane in the Journal Editor. See 
Insert Standard Text toolbar icon above.).  
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• Insert - Select standard text category to insert.  

 
 

o Standard Insert Text Entry Dialog – Prompts the user to enter data. 

 

Note   Data entered into the standard text dialog is automatically saved for later entry. The 
default file is located in the application’s support sub-folder as StandardInsertText.xml, 
typically at: C:\FDOT2008\Win32\EDI2\support\StandardInsertText.xml. 

Note   Tip   The user may copy the StandardInsertText.xml from the applications 
support sub-folder and specify the new file with the right-click menu item, Select File. 
Custom text categories may be added, edited and deleted. 

o  Standard text inserts into the Journal Editor window. 
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SHEET INDEX TOOLS 

 
EDI2 - Index Menu - Sheet Index tools 

Sheets (Working with Sheets) - displays commands related to the project sheet index, 
ProjectIndex.xml. 

 
 

• ProjectIndex.xml (Click for Information) – Contains the final Sheet Index data: 
Sheet numbers, component and image file specifications. 

• Update...(Add/Replace index sheets) – Invokes the sheet index update process, to 
add sheet data to the Plans Set. Sheets are added, optionally overwritten or removed 
as specified by the user for the entire project. Use the right-click menu in the Sheet 
Files tree view to add individual sheets, files or folders. 

• Default (Clear Plans Set to Default Components) – EDI2 reads the component 
data from SheetInfo.xml, then clears the Plans Set to default component folders.  
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Note   SheetInfo.xml found in the FDOT2008 software suite, mdlapps folder, is not the 
same as the SheetInfo.xml index data, produced by Sheet Navigator and placed in 
the project root or discipline folder(s). This SheetIndex.xml provides the settings for 
Sheet Navigator. 

• Create Postscripts (From Existing Sheet Index List) – Invokes a window which 
provides a method for creating sheets using an existing index data as displayed in 
the Index Editor.  

• Export Listings (Existing Sheet Index List) – Invokes a window which provides 
a method for exporting various listings to file(s), using an existing index data as 
display in the Index Editor. 

Note   Create Postscripts and Export Listings menu items are tools for advanced users 
and may not function as expected. 

• Save (Save Sheet Index List to ProjectIndex.xml) - Saves the sheet index data to 
ProjectIndex.xml, explicitly. 

Note   If changes are detected, the user is prompted to save ProjectIndex.xml on exit and 
if required for other downstream processing. In any case, EDI2 remembers the sheet 
information in EDIProject.edi, which is automatically saved. 

• Save As…(Save Sheet Index List to XML file) – Saves a copy of 
ProjectIndex.xml to another location. 

 

EDMS INDEX TOOLS 

 
EDI2 - Index Menu - EDMS Index tools 
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EDMS (External Import and Export XML) preserves EDMS data or combine data from sub 
projects. 

 
 

• EDMS Data (Click for Information) – Displays the following dialog, which 
explains the EDMS Export and Import feature. 

 
EDI2 – Esport/Import EDMS data 

• Export (EDMS File Data to XML file) – Exports EDMS data to EDMSData.xml 
in the project folder. 

• Import (Previously Exported/Created XML File) – Imports EDMSData.xml and 
combines EDMS data with the existing project, which means sub project EDMS 
data can be imported. 

Note   Import overlays EDMS comments if the Group and Type are the same; otherwise 
the user is prompted to decide which to save. If no Group or Type is specified for the 
current file, then imported EDMS data is applied. 
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Section 3.6.3.4 EDI2 Tools Menu 

 
EDI2 - Tools Menu 

Mine All Files (Force Mine of All Files) – This forces mining of all files in the project.   

Note   This IS NO longer the preferred method for mining data.  Instead, it is 
recommended that users use Import… (New! Import Sheet Navigator data). And 
Mine Modified Files (Mine for Changes). 

PEDDS (Execute PEDDS Operations and Applications) – See PEDDS Tools later in this 
section. 

File Checker (Execute the FileChecker Application) - Invokes File Checker application, 
used to check the project content for missing files, incorrect file/folder naming, 
PEDDS inconsistencies, and much more. 

QC File List (Create list of project design files) – Creates a list of design files found in the 
project named DGNFileList.txt to be used as input to the GDM QC Reporter 
application. 
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Show MicroStation (Debugging Plotting) – Allows the user to view MicroStation while 
creating plot files (Postscript or PDF).  

Note   To help determine how MicroStation and EDI2 sets the plot settings; enable Show 
MicroStation (Debugging Plotting), create a plot file using the Sheet Files tree view 
context menu, and then click to focus on the MicroStation window on the main 
Windows Taskbar. This is also useful when plotting fails. 

 
 

Show Sheet Index Panel (Left Panel Project Viewer) – Alternately displays and hides the 
left pane of the EDI2 Project Viewer window.Options… (Advanced EDI application 
settings) – Under the EDI < Warning tabs, select the appropriate startup options. See 
EDI Options later in this Section for more extensive discussion. 

 
EDI - Open Project Options 
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• Show EDI Splash Screen at Setup – Disable or enable EDI2’s splash window at 
startup. 

• Show Mine project reminder at startup – Enables or disables the mining dialog 
at EDI2 startup. This is automatically disabled if projects are open for Read Only 
access. 

• Open All projects Read Only – Disables EDI2 write access and prevents EDI2 
from writing data to disk.  

Warning!   ReadOnly Mode access does NOT guarantee the user cannot write to the project. 
Write functions are disabled and normal operation of EDI2 does not write to disk; however, it is 
possible to circumvent EDI2’s protection. 

• Open all projects for Write Access - If enabled, then the Read Only Mode setting 
will not be remembered when opening other projects (i.e.; All projects are opened 
with write access). 

• Always ask how to open projects - If selected, a dialog similar to the one below 
appears when opening projects: 

 
EDI2 – Open Project Write Access 



Section 3 ____________________________ Production Phase - Reviewing the EDI2 Application 

3-38 © 2009 FDOT Electronic Delivery Training Course 

PEDDS TOOLS 

 
EDI2 - Tools - PEDDS 

PEDDS (Execute PEDDS Operations and Applications) displays commands related to the 
PEDDS application. 

 
 

• Verify (EDI Quick Check for PEDDS issues) – Looks up data for each file in the 
Index.xml (in memory during application activity). Flags files as follows:  

• If the SHA-1 code matches, the data is considered up to date and the file is not 
flagged. 

• If sheet information for a design file data is missing; even if the SHA-1 code 
matches, the file is flagged (red) and recorded in the Process Log.  

Note   The total number of files failing verification is displayed in EDI2’s main window’s 
status bar. The list of failed file names is added to the Process Log, Errors list. If all 
files pass, the following status bar entry is displayed: 
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Warning!   This is not a substitute for using the PEDDS application and does not guarantee a 
secure project.  This is used to list files with hash codes that do not match those found in the 
PEDDS Manifest.xml file. 

• PEDDS (Open the PEDDS Application) – Executes the PEDDS application and 
opens the current project and displays the following warning dialog. 

 

Note   If EDI2 is set to Read Only mode, PEDDS can successfully Secure a project while 
EDI2 is executing. 

Tip   If the PEDDS Meta Info tab is active, changes in PEDDS are not reflected in EDI2 until the 
project is re-opened; however, Tools < PEDDS (Execute PEDDS Operations and Applications) < 
Verify (EDI Quick Check for PEDDS issues) functions properly. 

• ProjectID (Open the ProjectID Application) – Executes the PEDDS ProjectID 
application to create or modify ProjectId.xml, located in the project’s _meta_info 
folder.  

Warning!   Never copy or modify the ProjectId.xml or any file in the _meta_info folder. 

Tip   EDI2 calls the ProjectID application when creating new projects.  Run ProjectID any time the 
project identification data changes or needs to be completed by selecting File < Create 
Project...(Project ID and PEDDS). 

EDI OPTIONS… (ADVANCED EDI APPLICATION SETTINGS) 
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EDI Options 

 
EDI2 Options – Waring Tab 

Note   The end user does not typically need to modify EDI2 configuration settings.  

• Warning Tab – (shown above) Options settings, if set incorrectly can adversely 
affect processing times or completely disable processing all together. 

o Links - Provided for ECSO Support and the code author’s email.  

o Check Boxes – Turns On/Off EDI2 splash, mining dialog at startup, and 
an information dialog when the user opens the Process Log database. 

o Installing EDI without MicroStation is rare. This option may not have 
the desired results in later version of EDI2. The user should be able to 
safely ignore this option. See Tools > ReadOnly Mode (Restrict 
write/create functions) documentation for similar features. 
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EDI Options - EDIConfigure.xml Tab 

• EDIConfigure.xml Tab- A configuration settings file created in the Applications 
data folder (Typically: C:\Documents and Settings\username\Local 
Settings\Application Data\EDI\EDIConfigure.xml), the first time EDI is executed. 

o Current – Displays the current settings as stored in the registry. 

o Load - Reads the EDIConfigure.xml file and overwrites any changes to  
current configuration (as saved in the registry) when OK is clicked. 

o Create – Allows the user to create the default configuration file, as in the 
initial install, if the file is missing (or deleted). Otherwise create is 
unavailable.   

o Explore – Opens the application data folder to allow access to the 
configuration file (view or delete).  

Note   The EDIConfigure.xml tab is of limited use, and is not typically accessed by the 
user. 
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EDI Options – EDI Settings Tab 

• EDI Settings Tab – Displays the registry settings values EDI2 is currently using. 
By deleting the EDIConfigure.xml and resetting the registry values, the user can 
return the EDI2 application to the initial installed state upon the next execution. 

o Uninstall – Clears registry settings and EDI local application data from 
the users PC, but does not restart. If EDI2 does not execute properly after 
Reset is selected, use Uninstall. 

Note   To completely remove EDI, delete the EDI2 program folder after selecting 
Uninstall. 
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MicroStation Options 

These settings enable the MicroStation program to create the Postscript (or PDF) file output for an 
electronic Plan Set. EDI2 is tightly integrated with the FDOT software and the default settings use 
the V8 Design format and FDOT2008 standards workspace (FDOT2008.ucf). It is recommended 
that alterations be made only if necessary. 

 
MicroStation Tab Options 

• Mine Sheets before plotting checkbox – Performs the mining operation prior to 
creating the Postscript file. This option slows processing a little, but insures that the 
sheet data is current.  

Note   This option is not normally needed. Just make sure design file’s attribute data is up 
to date. 
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• Debug Processing (Requires user intervention) checkbox - May be used to 
determine processing issues. This option causes EDI2 to display MicroStation 
during Postscript file creation and allows the user to interact with MicroStation. 
Use this option to intervene and take control while EDI2 waits for input. 

Tip    Use Tools->Show MicroStation (Debugging Plotting) for simple debugging operations. 

• MicroStation timeout [secs] pull-down – Limits the amount of time in seconds 
that MicroStation is allowed to attempt to create the Postscript files. This prevents 
hanging up if MicroStation encounters a corrupt design file.  

Note   Some files require extended processing time. An example is cross-section sheets. A 
design file with 100 sheets or more, may require more than 300 seconds to process. 
Adjust as necessary to ensure all files and sheets are processed. Network issues also 
slow down processing considerably. 

Tip   Copy projects locally to the users PC for processing. Networks can slow down and even prevent 
processing of some or all files in the project. 

• OLE Wait time [msecs] pull-down – This is the time in milliseconds EDI2 waits 
for MicroStation automation to answer a connection request. Usually 500 (0.5 
seconds) is reasonable value. If MicroStation fails to connect for the first (create 
plot sheet) operation, try increasing this value. 

Note   This value rarely needs adjusting. 

• Naming Convention pull-down –Selects between the old and new file naming 
convention for postscript output file (Postscript or PDF file names).  

 
 

o Updated Format For New Files – Includes existing plot files using 
EDI’s original naming convention while naming missing (or deleted) 
sheets with the new convention. 

o Original Format Only – Uses the original naming convention for all 
sheet files. 

o Update Format Only – Uses the new naming convention for all sheet 
files. 

Tip   Use Updated Format For New Files for working with existing projects and use Updated Format 
Only, for new projects. 

Note   Selecting Updated Format For New Files on an existing project creates a sheet 
index with a mix of names. This is acceptable, however should be avoided if possible 
for clarity. 
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Warning!   Switching formats DOES NOT update the file names in an existing sheet index (as in 
the Index Editor and Plans Set tree view). The Sheet Files tree view displays names and EDI2 
processes sheets according to this setting. 

• Plot File Type pull down - Selects between Postscript (PS) and Portable Document 
Format (PDF). 

• MicroStation Application – Location of ustation.exe for MicroStation 
processing. Set at installation; use the Browse button to specify the correct 
location, only if necessary.  

• Users Folder – Set at installation, correct only if necessary.  

• Workspace pull-down – Specifies the MicroStation user workspace. 

• MicroStation Plot Key-ins and Configurations – Allow the user to configure 
special key-ins to insert or modify during plot file processing. 

 

 

Warning!   These settings rarely need adjustment. Entering invalid commands or data can 
prevent processing with little or no feedback from MicroStation or EDI2. 

o Start Tab – The MicroStation key-in commands executed at startup of 
MicroStation processing.  

o On Plot Tab – Commands executed immediately prior to and including 
the Postscript file creation (Plot command).  

o After Plot Tab – Commands executed immediately after each plot.  

o On Exit Tab – Commands executed before MicroStation processing 
exits 
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o EDIMIN.UCF Tab – Default user configuration file used for Postscript 
file creation processing. 

o EDIPLT.UCF Tab – Default user configuration file used for sheet 
information application mining operation.  

Warning!   EDIMIN.UCF and EDIPLT.UCF are created on-the-fly and cannot be edited 
manually. 

Note   On rare occasions MicroStation acts differently when design files are open for 
Read Only access (which is the default for EDI2). To allow MicroStation to open files 
for write access, remove or comment out the MS_READONLY in this listing. 

Tip   Fix the design file, so that MicroStation can open the file with Read Only access and still create the 
correct output. Open the design file with Read Only access and determine what is not loading properly. 

o EDICFG.PLTCFG Tab - Default user plotter configuration file for 
Postscript plot file creation. The file type PLTCFG is a new XML based plotter 
configuration file type for MicroStation XM. 

Note   The user cannot edit this file listing. This file can be set for individual design files 
using the Plotter Settings dialog, which is accessed through the Sheet Files tree view, 
right-click menu. 

Warning!   When files are opened for write access by MicroStation, they are always modified. 
This causes EDI2 to flag these files as modified (amber colored file names) in the Sheet Files tree 
view. 
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GhostScript Options 

These settings are required to view Postscript files using the included GhostScript features. 

 
GhostScript Options 

• GhostScript Application - The location of the application and supporting files are 
determined at installation.  Use the Browse button to correct the location only if 
necessary 

• GhostScript Libraries and Font Path – Environment variables are set 
interactively by EDI2 to define the GhostScript supporting files library path and 
font files path. 

• Display Processing Timeout (Seconds) pull-down – Limits the processing time 
used to display images. The GhostScript application is run independently and may 
fail to function properly (hang). This timeout prevents EDI2 from waiting 
indefinitely. This rarely needs to be adjusted, except on some slower PCs. 
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• Project.pdf processing Timeout (Minutes) pull-down – GhostScript processing 
time for creating the project PDF depends on the size of the project. Fifteen minutes 
should be enough for most average projects. Adjust if the Project.pdf fails to 
convert (Times Out) from the Project.ps. 

• Default Resolution pull-down - The default resolution, which can be adjusted in 
the Image Viewer. A lower resolution (72) increases performance and provides 
good screen viewing. A higher resolution (300) degrades performance 
significantly, but may be required for quality printing. The display resolution of the 
Postscript View, on the Sheet Information tab (of the Project Viewer), is set 
independently from the Default Resolution setting. 

• Debug GhostScript checkbox – Displays the GhostScript command window to aid 
in debugging the display process. The user must exit the command window to 
continue EDI2 processing (only applies to the debugging process).  

• Default button – Resets the location defaults to the current installation location. 
Installation information is retained in the registry. If EDI2 is moved, this data can 
be corrected by using the Default button.  

•  

SheetInfo (Navigator) Options  

The path to the Sheet Navigator application and supporting files, required to mine attribute data 
from the design file. See warning below. 

 
SheetInfo (Navigator) 

Warning!   DO NOT change this path setting in versions of EDI2 prior to MR 5, as mining will 
fail.  If this occurs, use the EDI2 menu option Tools > Options... (Advanced EDI Application 
Settings) < EDI Option < EDI Settings tab, selecting the Uninstall button and restart EDI2 to 
correct this issue. 
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Section 3.7 Indexing a Project 
Section 5.1 of the CPCH requires that Indexes of delivered files be produced and delivered in 
accordance with the FDOT CADD Manual. The purpose of the indexes are to document delivered 
project files, so one might reasonably understand the purpose and content of the files delivered for 
posterity. Indexes are crucial to the successful use of data by downstream customers. The index of 
plan sheets is used to provide information and access the plans sheets. The project and sheet index 
should be updated and reviewed as work progresses. 

EDI2 provides two methods for creating an Electronic Index for FDOT Electronic Project 
Deliveries. EDI2, preferably, can generate the sheet data required to automatically produce the 
index. The project is mined, then the user selects to create the index and the index is generated. The 
index can be manually reviewed, updated and edited as needed. A simple index is exported as a 
linked html file, suitable for inclusion in an ED project. Additionally, EDI2 creates an XML Index 
for further processing with the ED Software. 

EDI2 can also manually scan the selected project folder and arrange image files in a Project Tree 
view similar to the Windows file explorer folder view. Image files are defined as Postscript, PDF 
and TIF files. Files are selected for the standard Plan set through drag and drop and placed in the 
appropriate component with the Plan set, also represented in a tree view window. Files are viewed 
and sheet numbers entered along with descriptions to complete the index.  

 
Exercise 3.2 To create a New Index Project 

1. In the Indexing/Plotting/Journaling folder, click Launch. EDI2 opens. 

 

 
Indexing/Plotting/Journaling 
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2. From the EDI2 File menu, select New... (Open New EDI Project – EDIProject.edi). 

 
EDI2 

Note   EDI2 opens to the last project opened. Use the Recent Projects (Previously 
opened projects) to view a list of previously opened projects or use Open... (Existing 
EDI Project – EDIProject.edi) and navigate to the current project.  
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3. When New EDI Project opens, navigate to the project folder and click the Save 
button. For the purposes of this course, navigate to the c:\E\Projects\21000415201 
folder. EDI2 loads the new project and Mining Project Files Attributes opens.   

 
New EDI Project 

Note   EDI2 automatically names the files, EDIProject.edi. This file is always saved to 
the projects root directory. 

4. From EDI - Mining Project Files Attributes, click the OK button. EDI2 creates the 
file, EDIProject.edi, and then EDI2 appears as shown below.  

 
EDI2 
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Exercise 3.3 To Mine Project Attributes - Index.xml 
EDI2 mines attribute data to a single file, Index.xml in the root folder of the project. EDI2 also has 
the ability to mine data at the project level, folder level and individual file level.  

1. From EDI2 menu select Index (Step by Step) < Project (Mining File Attributes) < 
Mine Modified Files (Mine for Changes) 
 –or-- right-click on the project’s root folder in the Project Files tree view and select 
Mine Folder < All Files.  

 
EDI2 - Mine Folder Attributes 

EDI Mine Attributes Processing appears and the mining process begins. Upon 
completion, EDI2 re-appears as shown below. 

Important  Before a project can be indexed, each design file with plans sheets must be 
prepared with the Sheet Navigator tool. Sheet Navigator runs in MicroStation from the 
FDOT2008 Menu and extracts sheet data. Plotting is performed by EDI2 using this data. 

Important  EDI2 provides a method for importing Sheet Navigator index data directly.  
This is a more efficient method than demonstrated in this exercise. Create SheetInfo.xml using 
Sheet Navigator for a project or discipline and use Index (Step by Step) > 1) Project 
(Mining File Attributes) > 1) Import...(New! Import Sheet Navigator data) to load the data 
into EDI2. Next, select Index (Step by Step) > Project (Mining File Attributes) > 2) Mine 
Modified Files (Mine for Changes) to mine the rest of the project or use the Mine all modified 
files icon ( ) at any time to mine modified files. 
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EDI2 

Note   EDI2 uses MicroStation automation to open and close design files. This is a CPU 
intensive process. Multi-tasking in Windows, may not be practical while the mining 
process is active. 

 

Note   The Index (Step by Step) menu is the preferred method for using EDI2. Start by 
importing data from Sheet Navigator with Index (Step by Step) > 1) Project (Mining 
File Attributes) > 1) Import... (New! Import Sheet Navigator data) and then Index 
(Step by Step) > 1) Project (Mining File Attributes) -> 2) Mine Modified Files 
(Mine for Changes). 
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Note   The Mine all modified files icon ( ) will work at any time to insure file 
attributes are up to date. 

 
EDI2 Mining 

Note   As EDI2 mines each folder, the status of the mining operation is displayed in a 
progress bar at the top of the Project Viewer window while the current file is shown in 
the status bar.  EDI - Mine Attribute Processing displays the MicroStation Process 
ID and elapsed processing time. 
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Exercise 3.4 To create Index of Sheets - ProjectIndex.xml 
Once the project is mined, Index.xml is created, the Project Sheet Index, (the sheet index data) 
ProjectIndex.xml can be created.  

1. From the EDI2 Index (Step by Step) menu, select Sheets (Working With Sheets) > 
Update... (Add/Replace index sheets). 

 
Sheet Index 
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2. EDI - Sheet Index Update displays.  Populate the Create New Index checkbox and 
then click the OK button.  

 

 
Updating Project Index 

Note   EDI2 searches through the project and assimilates all sheets into the Plans Set 
under the appropriate components according to the rules defined in the Sheet 
Navigator application.  
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3. After EDI2 processes the sheet index, EDI2 reappears as shown below.  EDI2 
displays sheet information for each design file in the Sheet Files tree view and Sheet 
Information, Attribute Data pane. The file names are red when the sheet image files 
do not exist. 

 

 
EDI2 
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4. From EDI2, select Index (Step by Step) > 4) Sheets (Working With Sheets) > Save 
(Save Sheet Index List to ProjectIndex.xml).  

 

 
EDI2 

Note   When the sheet index is modified or updated, EDI2 prompts the user to save 
ProjectIndex.xml before exiting the application or when processing depends on 
ProjectIndex.xml. 

 

 
EDI - Save Project Index 
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5. When EDI Save Project Index displays, click the OK button. EDI2 saves the Index, 

ProjectIndex.xml, and re-appears in the Index Editor view as shown below. 

 
EDI2 - Index Editor view 

 

6. Review the index for missing sheets, gaps in sheet numbers, missing descriptions, etc. 

7. Upon completion, click the close button at the top right corner of the Index Editor 
window or select View > Project Viewer (All files, Image files, Design Sheets). 
EDI2 returns to the Project Viewer window. 

Note   Sheet image files shown in red in the Index Editor do not exist. At this point in the 
exercise, no plotting has been performed; therefore, no image files exist.  Components 
of the plan set can be modified using this view.  
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Exercise 3.5 To view the Index with the Index Editor  
To review or edit the index, open the Index Editor directly from the View menu as shown below.  

1. From the EDI2 View menu, select Index Editor (Edit and Save Index). The Index 
Editor view of EDI2 opens. 

 

 
Index Editor 
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Section 3.8 Adding EDMS Comments 
EDI2 has a general comment function, EDMS Editor, which allows the user to include a general 
comment and description about all files that do not follow the FDOT standard file naming 
convention. EDMS Editor allows the user to enter comments or descriptors for files. These 
descriptors, which are tied directly to the attribute file, will provide future use with FDOT’s 
EDMS (document management) software. 

An example of using EDMS comments is to add a comment for an input file generated to describe 
which cross-section that input file generated, as there could be many based on the number of 
alignments. 

EDMS comments must be added to files prior to creating the All Files Report, ProjectFiles.htm, 
as this index includes these comments. 

 

Exercise 3.6 To add an EDMS Comments 

Add EDMS comment to a project file. 

1. In EDI2, verify that the Project Files tab is selected. Click the roadway folder and 
then click the file 2footshldr.xsm as shown below. Click the EDMS Editor tab. EDI2 
opens the EDMS Editor pane. 

 
EDI2 - EDMS Editor 
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Tip   EDI2 allows sorting of a category by clicking the heading of that category. 

2. In the EDMS Editor pane, enter the description for the selected file. Once the file 
description is entered, click the Apply button. For the purposes of this exercise, enter: 
Criteria File to draw a 2 foot wide shoulder based upon user defined variables. 

 

 
EDMS Editor 

Tip  EDI2 adds the comment to the attributes file but remains on the EDMS Editor tab. 
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3. Click the Attribute Data tab to display the file’s attribute data. The entered comment 
appears in the Attribute Data pane. 

 

 
Attribute Data 
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Add an EDMS Comment to a Sheet File 

In this exercise, a comment is added to a MicroStation Sheet or MicroStation design File. 

1. In EDI2, verify that the Project Files tab is selected. 

2. In the File Properties Pane, click the design file baseline.dgn. 

 

 
EDMS Editor 

3. Click the EDMS Editor tab to open the EDMS Editor pane. 

4. In the EDMS Editor pane, enter the description for the selected file. For the purposes 
of this exercise, enter: Baseline of construction design file. 
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5. Once the file description is entered, click the Apply button.  

 

 
EDMS Editor 
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6. Click the Attribute Data tab to display the file’s attribute data. The entered comment 
appears in the Attribute Data pane. 

 

 
Attribute Data 
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Section 3.9 Updating Attributes 
EDI2 can mine attributes at the Project’s root level, a folder level or for a single file. The exercises 
that follow demonstrate several options to update attributes at the different levels.  

 

Exercise 3.7 To update attributes 

To Update Attributes at the Project level. 

If the Project Files tab of EDI2 is selected, all project files are updated. If the Sheet Information 
tab of EDI2 is selected, only MicroStation design files are updated. This exercise demonstrates 
how to update all project files; however, updating MicroStation design files is done the same way. 

1. From EDI2, verify that the Project Files tab is selected and then select Index (Step by 
Step) > 1) Project (Mining File Attributes) > Mine Modified Files (Mine for 
Changes). Verify/Update Process opens and the mining process begins.  

 
EDI2 - Update Project Attributes 

Note   Selecting F5 while EDI2 has focus or clicking the Mine all modified files icon    
( ) invokes the same process. 
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2. As EDI2 mines each folder, the status of the mining operation is displayed in a progress 
bar at the top of the Project Viewer window while the current file is shown in the 
status bar. Mining File Attributes displays the MicroStation Process ID and the 
elapsed processing time as shown below. 

 
EDI - Verify/Update Process  
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3. When the mining process is complete, EDI2 reappears as shown in the following 
figure.  Project Files display in green on the file list pane when current with up to 
date attribute data. Project Files display in red when No attribute data is present. 
Project Files display in amber when modified since the mining process occurred. 

 

 
EDI2  
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To update attributes at the Folder level 

In this exercise, only the discipline folder’s sheet file attributes are updated. As described above, if 
the Projects Files tab is selected, all files in the folder are updated. Select the Sheet Files tab to 
update all MicroStation design files in the folder. 

1. From EDI2, verify that the Sheet Information tab is selected and then select the 
drainage folder.  

2. Right-click on the folder and click Mine Folder > All Files.  

 

 
EDI2 - Mine Folder>All Files 
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3. EDI - Mining appears and the mining process begins.  EDI - Mining displays the 
MicroStation Process ID and the elapsed processing time for each file.  

 

 
EDI – Mining 
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4. Upon completion, EDI2 reappears with the drainage discipline folder expanded as 
shown below. 

 

 
EDI2 
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To update attributes at the File level 

In this exercise, only one file’s attributes are updated. This method allows the user to pick 
individual files to update. 

1. Continuing in the Drainage discipline, Right-click on the first MicroStation design file 
(drstrd01.shg) that contains sheet information and click Mine File.  

 

 
EDI2 - Mine Attributes 
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2. EDI-Mining appears and the mining process begins. EDI2 only mines the selected 
file’s attributes. 

 

 
EDI - Mining 
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3. Upon completion, EDI2 re-appears as shown below. 

 

 
EDI2 

Tip   Update on a regular basis, as soon as Production begins. to save time when finishing the project. 

Clicking the Mine all modified files icon ( ) insures file attributes are up to date. 
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Section 3.10 Updating the Index 
Unlike updating sheet or project file attributes, updating the index is processed on the complete 
project. When updating the Index, it makes no difference if updating occurs from the Sheet 
Information tab or the Project Files tab of EDI2. 

 

Exercise 3.8  To update the Project Index 
 

1. From EDI2, select Index (Step by Step) > 4) Sheets (Working With Sheets) > 1) 
Update... (Add/Replace index sheets) as shown below.  

 

 
EDI2 - Sheet Index Update 
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--OR-- Right-click, on any file or folder in the Sheet Files tree view, and then click 
Update Sheet Index as shown below to process just those files or folder. 

 
EDI2 - Update Sheet Index 

2. Once EDI -Sheet Index Update opens, populate the Overwrite Existing checkbox 
and click the OK button. 

Note   If no option is selected, the index is updated with new sheets only. Check 
Overwrite Existing to update existing sheets with modified design file sheet data. 

 
Update Project Index Plans Set 
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Update Project Index Plans Set - Setup 

Important  At first, the Plans Set tree view has component nodes only. When the sheet index is 
created, each sheet found in the Sheet Files tree view, is inserted into Plans Set under the 
appropriate component nodes as defined by SheetInfo at the time the sheet was mined.  

Important  When updating the sheet index, existing sheets already in the index are not 
overwritten, even if the attribute data changes. This includes page renumbering, description 
and component changes. Check Create New Index or modify the information by using 
Overwrite Existing to update the sheet index, with recently mined data. 
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Section 3.11 Indexing/Plotting/Journaling - Plotting 
EDI2 allows the user to create sheet image files for the entire project, a discipline folder or an 
individual sheet. 

 

Exercise 3.9 Creating Postscript Image Files 

To create Postscript Image Files of the Project 

1. In the Sheet File tree view, select the project number and right-click.   

2. Select Create Plot Files > All.  

 

 
EDI2 

Tip   To scan the project for missing image files and create those only, right-click and select Create 
Plot Files > Missing. To process design files that may have changed, right-click and select Create 
Plot Files > Outdated. 



Section 3 _______________________ Production Phase - Indexing/Plotting/Journaling - Plotting 

3-80 © 2009 FDOT Electronic Delivery Training Course 

3. EDI - Create Plot Processing appears and the plotting process begins. EDI2 
processes design files that contain sheets. The status of the plotting operation is 
displayed at the top and bottom of EDI2. 

Note   EDI - Create Plot Processing shows the design file currently processing, the total 
elapsed time and the current file processing time. 

 
EDI2 Creating Postscript Image files 

 

Tip   EDI - Create Plot ProcessingCheck Disable Timeout to process large design files or files with 
many sheets. Select Cancel to stop processing. Check Exit MicroStation on Cancel to unload the 
MicroStation automation process. 

Note   The next few pages are not formal exercises, but rather additional information on 
available plotting options. 
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To Create the Postscript Images for an Individual Folders 

1. From EDI2, verify that the Sheet Files tab is selected and click the desired discipline 
folder. 

2. In the Sheet Files tree view, right-click the desired folder, then select Create Plot File 
and the appropriate option. 

3. EDI - Create Plot Processing appears and the plotting process begins  

 

 
Plotting at the Folder level 
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To create a plot image for an individual sheet 

1. From EDI2, verify that the Sheet File tab is selected and click the desired sheet. 
2. Right-click the sheet and select Create Plot File from the menu.  

3. EDI - Create Plot Processing appears and the plotting process begins.  

 

 
Plotting Individual Sheets 

4. Upon completion or plotting process, the created plot files are green in both the Sheet 
Files and Plans Set tree views as shown below. 
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5. If the color of the design file name is red or a red “X” sheet icon is present, then at least 
one sheet image file is missing (does not exist). A green design file name indicates all 
sheets exist. When sheets exist, Create Plot File in the right-click menu becomes 
Recreate Plot file as shown in the following figure. 

 
Recreate Plot File 

 
EDI2 

Note   An Index of all files is created near the end of the ED process, as more required files 
are created. 
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To view Postscript images 

1. From EDI2, verify that the Sheet File tab is active, select the roadway folder and then 
click keysrd01.dgn.  

2. To expand the information under keysrd01.dgn, click the plus(+) symbol.  

3. Click on the Postscript file name.  

4. Right-click the file name and from the menu, click Display Image. 

 

 
EDI2 - Display Image 
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5. The Image Viewer window opens and displays the Postscript image. Review the 
image in Image Viewer. 

Note   In class, several of the other available options will be discussed. 

 
EDI2 - Image Viewer 

6. To switch back to Project Viewer, select View > Project Viewer (All files, Image 
Files, Design Sheets). 

Important  Image Viewer is set to a default of 72 pixels per inch to maximize screen display 
speed. If the Image Viewer is used to print, the screen resolution should be increased to 
produce a better quality image, however, screen display speed decreases. 
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To Alternate Plotter Configuration 

To specify alternate plot settings for design files, use the new context menu item named “Plot 
Configuration” by doing the following steps:   

1. From the Project Viewer window, select the Sheet Information tab.  

2. Right-click on any folder or design file from the tree view as shown below. 

 

 
EDI – Plot Configuration 

3. From the menu, select Plot Configuration… to display the Plot Configuration 
Settings dialog as shown below.  
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4. Read the step-by-step instructions at the top of the dialog before proceeding.  

5. This ends the initial startup.  

 

 
EDI – Plot configuration dialog box 
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Process Selected Design Files Using an Alternate PTL or TBL Setting  

1. Copy plot settings files to the current discipline folder. On the Plot Configuration 
Settings, click Copy plotter files to folder.  

Note   The user may edit and rename these files, then return to the Plot Configuration 
Settings dialog to make selections.  

 
EDI – Plot Configuration copy plotter settings 

2. Copy Plotter Settings Files opens.  Click Yes to copy the default settings files to the 
current design file folder for modification. 

 
EDI – Plot Configuration - copy plotter settings 
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3. Plot Settings File Status opens.  Click OK. 

 
EDI – Plot Configuration – plot settings files status 

4. Copy Files for Key Sheet Color Maps opens.  Click Yes or No depending on whether 
or not the key sheet color map .pltcfg and .tbl files will be needed to plot the sheet files. 

 
EDI – Plot Configuration – copy files for key sheet color maps 

5. Select the Configuration File (PLT) from the drop down menu.  

Note   Always select this option first. The default pen table file automatically displays in 
the Pen Table File (TBL) dropdown box.  

 
EDI – Plot Configuration - configuration file (PLT) 
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6. If necessary, select the Pen Table File (TBL) from the dropdown box. 

 
EDI – Plot Configuration – Pen Table file (TBL) 

7. Click the Select and check Files button to check all files, or use “Ctrl-Click” or 
“Shift-Click” selection features or the Right-Click selection menu, to select and check 
files in the design file list. 

 
EDI – Plot Configuration – Select and check Files 
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8. Click Apply changes to files button. Each checked file will display the relative path 
for the selected PLT and TBL files. 

 
EDI – Plot Configuration – Apply changes to files 

9. Click the Finish and exit button to accept the changes and dismiss the plot 
configuration dialog.  EDI reappears with the sheet files configured with the plot PLT 
and plot TBL files that were chosen during the plot configuration process. 

 
EDI – Plot Configuration – Finish and exit 
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Section 3.12 Indexing/Plotting/Journaling - 
Journaling 

All Journaling is done within EDI2. Section 5.2 of the CPCH defines the purpose of the Journal as 
detailing design aspects and decisions made during the life of project and documenting processes 
used during the course of design. Journal file entries should document methods employed, 
procedures used, decisions made, problems encountered, fixes included or other issues 
encountered during the design process.  

For example, if custom line styles were created, the justification for the custom line style and the 
resource file name containing the custom line style should be documented in the Journal. Any 
information that would help in the regeneration of CADD files and or plots should be recorded. 
The geometry information, database, controlling alignment, profile names, relevant survey and 
cross section information and the methodology used to obtain the final geometric controls in the 
CADD product should be recorded. 

 

Exercise 3.10 Journaling 

To create a New Journal User 

1. Continuing in EDI2, select View -> Journal Editor (Create/Edit Project Journals to 
open the Journal Editor view as shown below. 

 
Journal Editor 
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Journal View 

2. Click the blank page icon to begin a New Journal Entry. 
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Journal View 

3. Create Project/Discipline Journal File opens.  Enter the file name Journal_1 for the 
journal and set Save as type to rich text file (RTF File (*.rtf)).  Then click the Save 
button to continue. 

 
Create Project/Discipline Journal File 
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4. Journal User Info opens. Enter the New User data.  For the purposes of this course, 
fill in your name, etc.  When finished, click the OK button. 

 
Journal User Info 

5. EDI2 displays a blank page with the input user information and the date in the Journal 
Editor view. 
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Journal View 
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To create a Journal Entry 

1. Begin typing under the user information.  For the purposes of this exercise, enter: This 
is the first Journal entry for this project. 

2. If needed, right-click in the journal entry area to access additional tools.  

3. Upon completion of the entry, click the Save button ( ) on the toolbar. The journal 
entry is saved. 

 

 
Journal 
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Exercise 3.11 Creating Additional Entries 

To create additional Journal Entry while still in the Journal 

1  Continuing in the Journal, click the New Entry icon ( ) on the toolbar and repeat the 
steps in Exercise 3.7.   

Note   Remember to change the name of the journal to Journal_2, to ensure the previous 
journal is not overwritten.  

 
Journal - New Entry 
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Journal Entry #2 - Save name 

4. Type in the required entry and click the Save button  on the tool bar to save the 
journal entry. For the purposes of this exercise, enter:  This is the second entry.  as 
shown below. 

 
Journal Entry #2 
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5. Continuing in the Journal, click the New Entry icon ( ) on the toolbar and repeat the 
steps in Exercise 3.7 for Journal_3.  

 
Journal Entry #3 - Save name 

6. Type in the required entry and click the Save button  on the tool bar to save the 
journal entry. For the purposes of this exercise, enter: This is the third entry. as shown 
below. 

 
Journal Entry #3 
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7. To exit the Journal Editor view in EDI2, click the Project Files tab as shown below.  
EDI2 reopens the Project Viewer window.  

 

 
Project Files View 
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Exercise 3.12 Standard Insert Text 
Pre-coded Standard Insert Text is available to automate recording various GEOPAK and 
MicroStation settings used during the design process. Items for selection, along with their 
associated sub-components, are contained in an xml file named StandardInserText.xml, located 
in the C:\FDOT2008\win32\EDI2\Support\ folder. 

To use Standard Insert Text 

For the purposes of this exercise and to be in compliance with Item 2 of the Compliance 
Certification Checklist Report, SOFTWARE Version Declarations will be used. 

 

1. Continuing in EDI2, select Tools > Project Journal Files (RTF Documents) > Open 
(Create Project Journals) to display the Journal Editor view.  

 

 
EDI2 - Journal Login 
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2. If the Standard Text options are not shown in the right pane, click the Insert Standard 

Text icon ( ) on the toolbar as shown below. 
 

 
EDI - Journal View - Insert Standard Text 
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3. Right-click the desired Standard Insert Text and select Insert from the menu.   

 
Standard Insert Text - Insert... 

4. Standard Insert Text opens displaying the information for the MicroStation Item. 
Modify the MicroStation text as needed. Click the Next button to continue. 

 
Standard Insert Text 
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5. From Standard Insert Text, modify GeoPak Item as needed and click the Next button 
to continue. 

 
Standard Insert Text 

6. From Standard Insert Text, modify Civil Extension Item as needed and click the 
Finish button to continue to add the Standard Insert Text to the Journal entry. 

 
Standard Insert Text 

7. From Standard Insert Text, modify FDOT Software Item as needed and click the 
Finish button to continue to add the Standard Insert Text to the Journal entry. 

 

Standard Insert Text 
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8. Lastly, click the Save icon ( ) on the toolbar to save the journal entry as shown 
below. 

 

 
Journal Entry #3 
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To create a Standard Insert Text 

Journal allows the user to create custom Standard Insert Text. For the purposes of this exercise, a 
Standard Insert Text titled CADD Compliance will be created. This entry can be used to track 
CADD Compliance Reports and any Exception rule files. 

1. Continuing in the Journal, right-click one of the Standard Insert Text and select New 
from the menu to display New Custom Text. 

 
Standard Insert Text 

2. Enter the New Custom Text for New Item for Category (Number 1) as shown below, 
and then click the Next button to continue.  
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3. Enter the New Custom Text for New Item for Category (Number 2) as shown below, 

and then click the Next button to continue.  

 
 

4. Enter the New Custom Text for New Item for Category (Number 3) as shown below, 
and then click the Next button. 

 
 

5. Enter the New Custom Text for New Item for Category (Number 4) as shown below, 
and then click the Add button.  The Custom Insert Text is added.  
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6. Click the Close button to exit New Custom Text. 

 
EDI 2 

 
EDI 2 

Important  Although the Custom Insert Text is added to the listing, it is not saved.  

Note   Try using the created Custom Insert Text in an entry. 
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Section 3.13 Creating Reports and Project.pdf in EDI 
EDI2 extends the reporting capability of the FDOT ED suite of tools by adding the ability to 
generate the SheetNDX#.HTM report.  This HTML report provides a simple, transportable 
interface to project sheets - grouped by component and hyper linked.  

In addition, EDI2 now allows users to generate a single file sheet summary report, Project#.pdf, 
containing all sheets that comprise a project, as specified by the project index. This report is 
available in PostScript and Adobe PDF formats. These tasks were previously done in Project 
Browser. 

 

Exercise 3.13 Creating an HTML Index Report 
The Sheet Index Report is an HTML report derived from the project's Index, ProjectIndex.xml. 
The report file is titled Sheetndx#.htm and must reside in the project's root directory. 

To create Sheetndx.htm 

Important  The Sheet Index Report, Sheetndx#.htm, is a required deliverable item per the 
Compliance Certification Check List Report - Item 17. 

1. Select Index (Step-by-Step) > Basic HTML index (HTML Index for the Project 
CD/DVD) > Create. The creation of the Basic HTML processes.  

 
EDI - Create Basic HTML 
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2. Strung Project Confirmation opens. Click the No button. 

 
Strung Project Confirmation 

Note   For the purposes of this training course, this is a standalone project; therefore, it is 
not a component of a Strung Project. 

3. The Basic HTML Index file, Sheetndx#.htm, is created in the project’s root directory 
and opens in a web page. 

 
Sheetndx#.htm HTML Web Page View 

Note   The HTML web page allows users to browse the project and view files with an 
external Web Browser, like Internet Explorer.  
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Exercise 3.14 Creating a Summary PDF Report 
The Summary PDF is a single document which contains all plan sheet images in index order. This 
file, in Adobe Portable Document Format (PDF), resides in the project's root directory, and is titled 
Project.pdf. During the creation of the Project.pdf, the application automatically overrides any 
previously created Project.pdf or Summary PostScript file, Project.ps. Only one Summary file is 
created. 

To create a Project.pdf 

1. Select Index (Step-by-Step) > Project PDF (All Sheets Consolidated into PDF) > 
Create. EDI2 begins the creation process.  

 

 
Create Project#.pdf 
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2. Upon completion of the creation process, Create Project PDF opens and displays the 
“behind the scenes” processes of Ghostscript and EDI2. 

 
Create Project PDF 

3. From EDI – Create Project PDF, the user can choose whether or not to keep the 
intermediate Project.ps file.  For this project, select No.   

 
EDI – Create Project PDF 

4. Display Project PDF opens.  Click the YES button. Adobe Reader opens to display 
contents of Project.pdf. 

 
EDI – Display Project PDF 

Tip   The user can change Adobe’s view from portrait to landscape to rotate the view of Project#.pdf. 
Check the orientation of any manually inserted sheets prior to building the Project#.pdf file.  

Note   PDF (Portable Document Format) is not a perfect solution. There is no control over 
the original size/sheet dimensions, sheet rotation, pixel density or output paper size. 
PDF does offer an inexpensive printing and viewing solution for other users of FDOT 
information that are unable to print or view postscript files as it preserves the data. 

 



Section 3 ______________________ Production Phase - Creating Reports and Project.pdf in EDI 

3-114 © 2009 FDOT Electronic Delivery Training Course 

 

Important  Adobe Reader – Project#.pdfThe Summary PDF, Project#.pdf is a required 
deliverable item as per the Compliance Certification Check List Report - Item 16. 

Note   In the case of a revision, the index number for deltandx#.htm determines the index 
number for project#.pdf.  For the original delivery, project.pdf is not indexed.   

Note   In the case of a revision, and if the project already contains a deltandx#.htm report, 
the following dialog box displays, which provides options allowing the user to choose 
the revision number of the project.pdf, as well as the coinciding deltandx#.htm 
report. 

 
EDI – Create Project#.pdf 
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Section 3.14 Revisions 
Section 20.4 of Volume I of the Plans Preparation Manual defines a revision as a modification to 
the plans package after it has been transmitted to Central Office but prior to bid opening.  

Project Delta is an application that simplifies the job of identifying and reporting indexed 
differences between two sets of project files. In the past, when a set of revisions or changes were 
delivered to FDOT, a separate set of paper or electronic files was compiled to display all additions, 
modifications and deletions to the original delivery. With the advent of ED, this process can be 
automated and improved.  

Project Delta creates two reports used to determine the differences between two sets of indexed 
files using byte-level comparisons, the Revision Report and the Change Report. 

• Revision Report - This report is designed to be created and included in the project 
before a revision delivery is made to the Department. The report denotes the 
differences between two full deliveries; the original, secure delivery file set and a 
full, revised file set. The report also contains XML data that can be used by Set 
Maker to create a secure set of revised files. 

• Change Report – This report is designed to report the indexed differences between 
any two project files sets, not merely full project deliveries, as does the Revision 
Report. Though the report was originally designed for tracking the differences 
between an original project delivery and a later corrected delivery, the report has 
many uses; from determining file changes between sets to ensuring that a revision 
set contains the proper files. As this report is designed for quality assurance, it does 
contain set generation information, as does the Revision Report. 

 
Revisions - Project Delta 

Note   Section 5 - ED - Handling Revisions provides in-depth exercise on revisions 
made after an initial delivery.  
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Section 3.15 Signing & Sealing the Project 
For years engineers have had the ability to sign and/or seal any document that could be included in 
a project. Prior to delivery of the project to the Department, the engineer of record must 
electronically sign and seal project files using PEDDS, which extends this ability to the digital 
domain. Rather than applying a marker on each individual file, PEDDS keeps track of the files 
that each user signs.  

When a user 'signs' a file, the application generates a unique, identifying code (the file's SHA-1 
message digest) and places it in a password protected file in the project's _meta_info directory. 
Once the file is updated, the application generates a report that lists the files that the user has 
signed, as well as the code for that file.  

Florida and Federal law accept the association of a physical signature with an electronic document. 
The Florida Boards of Engineering and Surveying and Mapping have adopted rules 
whereby professionals can electronically sign and seal electronic documents in accordance 
with these laws. Therefore, by signing the signature document, the signatory is, by proxy, signing 
and sealing all files listed on the report. 

 
PEDDS Signing and Sealing 
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Section 3.15.1 Signing & Sealing  

TO OPEN A PEDDS PROJECT 
1. To open a PEDDS Project In the Signing & Sealing / Securing the Delivery folder, 

click Launch.  Florida Department of Transportation - PEDDS opens. 

 
Launching PEDDS 

 
Florida Department of Transportation - PEDDS 
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2. From the Project menu, select Open --or-- click the Open an Existing Project icon(
) on the toolbar to display Open Project. 

 
Florida Department of Transportation - PEDDS 

3. In Open Project, select the drive letter where projects reside from the Drive 
pull-down menu. 

4. Navigate to the Project folder and click the project. 

Note   A PEDDS project always has a briefcase icon. 

5. In the Current Path box, verify the selection of the project. If the selected project is 
incorrect, repeat step 4. 

6. To load the selected project into PEDDS, click the OK button.  

  
PEDDS Open Project 
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PEDDS Open Project 

7. The loaded project is now ready for PEDDS processing as shown below. 

 

 
PEDDS 
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TO CREATE A SIGNATORY FOR SIGNING AND SEALING 

Before a professional can sign/seal files, that person must be known to the PEDDS software 
by creating a Signatory. 

A Signatory is the person(s) or professional(s) who secures files in a delivery using a signature 
file and document. If the signatory is a professional, signatures are governed by rules defined 
by the Florida Boards of Professional Regulation. 

1. From the Signatory menu, click Create Signatory --or—click the Create a New 

Signature icon ( ) on the toolbar. Signatory Information opens.  

 

 
Florida Department of Transportation - PEDDS  

Note   Signatory Information contains information about the individual who is signing and 
sealing the plans. 
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2. In Signatory Information, enter the following information: 

3. In the Signatory Name box, type your name. 

4. In the Signatory Number box, type 12345. 

5. In the Pass-phrase box, type 12345.  

6. In the Re-enter Pass-phrase box, type 12345. 

Note   The Pass-phrase is a password, unique to each professional responsible for signing 
and sealing files. If the professional forgets his or her pass-phrase, PEDDS allows the 
creation of additional signatories. 

7. Select the Signatory Type and click the OK button. 

8. For Signatory Types other than Signature - No Seal (SS), type your professional 
number in the Signatory Number box. 

 
Signatory Information- Professional Engineer  

Important  The requirements for sealing information stored in electronic files is defined by 
the Board of Professional Engineers in Rule 61G15-23.003, F.A.C. For each professional 
engineer in responsible charge who is signing and sealing files in a project, the PEDDS 
program generates: 

• A signature file that defines which files are being signed and sealed, and 

• A signature document that is printed, signed, dated, and sealed by the professional 
engineer with an impression seal. 
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9. Signatory Scope-of-Work displays.  Type a description of the work to be signed/sealed 
by the Signatory. 

 
Signature Scope of Work 

 
Signature Scope of Work 

Important  The professional's name, address and phone number are required by PEDDS.  

 
Signature Scope of Work 
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10. Click the Finish button. Florida Department of Transportation - PEDDS re-opens 
with the new signatory displays in the Current Signatory box. 

 
PEDDS displaying new Signatory 

Note   Upon the creation of the Signatory, PEDDS also creates a Signatory File in the 
/_meta_info/ folder of the project. The Signatory File is a file that defines the project 
files a signatory is going to sign or sign-and-seal. 
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TO CREATE A SIGNATORY TO SIGN WITH NO SEAL (OPTIONAL) 
PEDDS allows a lay person (non Professional) to sign files with no seal. This is known as 
Signing, which is the act of securing a set of files under a signature file without the benefit of 
signing-and-sealing under Florida Boards of Professional Regulation rules. This implies that the 
signatory is a lay person and not a registered professional. Signing a file adds file information to 
the signatory’s signature file. Before the lay person can sign files, that person must be known to the 
PEDDS software by creating an additional Signatory. 

1  From the Signatory menu, click Create Signatory --or—click the Create a New 

Signature icon ( ) on the toolbar to display Signatory Information.  

 
Florida Department of Transportation - PEDDS  

Note   Signatory Information contains information about the individual who is signing the 
plans. 
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11. In Signatory Information Signatory Name box, type Robert Keon. 

12. In the Signatory Number box, type 56789. 

Important  Signature - No Seal (SS) signatories must enter their Florida Driver’s License 
Number as their signatory number. 

13. In the Pass-phrase box, type 56789.  

14. In the Re-enter Pass-phrase box, type 56789. 

15. Select the Signatory Type Select Signature - No Seal (SS). 

 
Signatory Information - Signature-No Seal (SS) 

16. When finished, click the OK button. Signature Scope-of-Work opens. 

 
Signature Scope of Work 

Important  The lay person's name, address and phone number are required by PEDDS.  
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17. Click the Finish button. Florida Department of Transportation - PEDDS re-opens 
with the new signatory. 

 
PEDDS displaying new Signatory 

TO SELECT FILES TO SIGN AND SEAL 

Note  Once the Professional of Record has been identified to PEDDS, the signatory can begin 
the process of signing files. From the Current Signatory drop- down list of Florida 
Department of Transportation - PEDDS, select a Current Signatory.  Enter Password 
appears. 

1. In Enter Password, type 12345 for the selected Signatory and then click the OK 
button. 

 
PEDDS Enter Password 
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2. From the left pane of Florida Department of Transportation - PEDDS, click the 
roadway discipline folder. 

3. Select all the Postscript image files for signing. 

 

 
PEDDS Selecting Files for Signing 

Tip   Standard windows tools, Shift and CTRL keys can be used to select multiple files. Each 
discipline of the entire Project must be signed and sealed by the responsible professional. 
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4. Right-click one of the selected files and then click Select/Deselect. A green icon 
appears with each selected file and the current signatory, to be assigned responsibility 
for the selected files, appears in the Signatory column. 

 

 
PEDDS Select/Deselect 
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5. A green icon appears with each selected file and the current signatory, to be assigned 
responsibility for the selected files, appears in the Signatory column. 

 

 
PEDDS - files selected  
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TO ADD A QUALIFIER 
Qualifiers or contingencies can be added to a file that is going to be signed and sealed in the current 
session, or to a file selected to be signed and sealed at a later date. The qualifier text may be edited 
only if the file or files have been selected or signed and sealed by the current signatory; otherwise, 
the qualifier is read only and may not be modified. If an asterisk (*) appears in the Qualifier 
column, then the file has a qualifier, but the qualifier was appended by a signatory other than the 
currently selected signatory. Qualifier text is displayed only for files signed and sealed or selected 
by the currently selected signatory. 

1. With the files still selected right-click on a file and then click Edit/View Qualifier.  

 
PEDDS - View/Edit Qualifier 

 

Important  Before the qualifier can be edited, the files have to be signed and sealed by the active 
signatory.  If this is not done, the error message above will appear.  
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2. File Qualifier displays. Type the Qualifier statement for the files selected. 

 
PEDDS - File Qualifier 

3. When finished, click the OK button. Florida Department of Transportation - 
PEDDS re-opens displaying the new qualifier added. 

 

 
 

PEDDS - Qualifier displayed 
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TO SIGN AND SEAL THE FILES 
1. With the files still selected, select Sign and Seal from the Signatory menu -- or—click 

the Sign and Seal the Current Signature icon ( ) on the toolbar.  

 
PEDDS - Signing and Sealing 

2. Signing and Sealing opens briefly then closes.  Report Viewer then opens. 

 

 
Signing and Sealing process status bar 
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3. In Report Viewer, click the Print button to send the report to a print device. 

 

 
PEDDS - Signature Document 

Important  The Signature Document report must be signed, dated and manually sealed by 
the Professional of Record as it is a required deliverable item as per Item 14 of the Compliance 
Certificate Checklist Report. 

Note   The Signatory Document is a physically signed or signed-and-sealed paper 
document used to secure a signature file. Florida and Federal law accept the association 
of a physical signature with an electronic document. The Florida Boards of 
Engineering and Surveying and Mapping have adopted rules whereby professionals 
can electronically sign and seal electronic documents in accordance with these laws. 
Therefore, by signing the signature document, the signatory is, by proxy, signing and 
sealing all files that are listed on the report. A professional may have multiple 
signatories in a project as needed by the revision process, and, as such, may have 
multiple Signature Documents associated with a project. 
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4. Florida Department of Transportation - PEDDS re-opens displaying the signed and 
sealed files. 

 
PEDDS - Signed and Sealed files 

Note   The Florida Board of Professional Engineers has approved this process and the 
signing/sealing procedure. 

Section 3.15.2 Authenticating Signing and Sealing  

Signing and Sealing is the act of securing a set of files based on the rules defined by the Florida 
Boards of Professional Regulation governing signing-and-sealing electronic files. These rules 
provide for:  

• signature files to define the type of professional that is signing and sealing (i.e., 
engineer or surveyor)  

• the professional’s name, number, and scope of work  

• the list of files—defined by relative URL and hash-code—that are to be signed and 
sealed  

Signing and sealing can only be done by a registered professional. Signing and Sealing a file adds 
file information to the signatory’s signatory file, while the act of Signing is the act of securing a set 
of files under a signature file without the benefit of signing-and-sealing under Florida Boards of 
Professional Regulation rules. This implies that the signatory is a lay person and not a registered 
professional. Signing a file adds file information to the signatory’s signature file. 
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PEDDS Signing and Sealing of files also allows the following: 

• A single file can be Signed and Sealed by more than one Signatory. 

• A Qualifier must be included if file is signed by more than one Signatory. 

• Files can be unsigned (the Signatory is removed). 

• In case of revisions, files can be re-signed. 

• Signatories can be deleted. 

A file signed by the same Name and PE number is acceptable.  

 

AUTHENTICATING SIGNED AND SEALED FILES 
1. Open the project in Florida Department of Transportation - PEDDS if necessary. 

2. From Authenticate menu, select Signed and Sealed.  

 
PEDDS - Authenticate Signed and Sealed 
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3. Dialog displays.  In Authenticate the Signed and Sealed files for drop-down list, 
select the signatory name.  

 
PEDDS - Dialog 

4. Click the OK button.  Dialog processes the authentication for the selected signatory 
and then Report Viewer opens. 

 

 
PEDDS Dialog 
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5. In Report Viewer, click the Print button to send the report to a print device. 

 
PEDDS - Report Viewer 

Note   Optionally, the Signature Authentication Test report can be signed and manually 
sealed by the Professional of Record. 

6. Click the EXIT button. Report Viewer closes and Florida Department of 
Transportation - PEDDS re-opens. 

 
PEDDS  
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Section 3.15.3 Authenticating Signed and Sealed Files: 
Possible Error Messages 

After running the Authentication process on Signed and Sealed Files, the following error message 
could display: 

The following figure displays an example of a Signature Authentication Test Report identifying 
files that have been modified and do not pass authentication. The authentication process identifies 
files that have been modified, as well as files that have been added or deleted from a project. 

 
Report Viewer - Invalid Signed and Sealed Files 
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Section 3.15.4 PEDDS Report Documents 

TO VIEW AND PRINT REPORTS 
• From Florida Department of Transportation - PEDDS, select Signatory > 

View/Print > Signatory Document (or Signatory Report).  

 
PEDDS displaying available reports 

  



Section 3 ______________________________ Production Phase - Signing & Sealing the Project 

3-140 © 2009 FDOT Electronic Delivery Training Course 

Section 3.15.4.1 Signature Document 

Like the Manifest Document, the Signature Document is integral to the security process 
implemented by PEDDS. This document contains the SHA-1 message digest of a signature file, 
which in turn contains the SHA-1 message digests of each file signed and sealed in the signature. 
The Signature Document must be signed and sealed by a licensed or registered professional (the 
professional responsible for the work) and included as a part of the project ED contents. This 
process is necessary to fulfill the legal requirements for signing and sealing.  

Validation and authentication of signed and sealed files is simple. Equivalence of the generated 
Signature SHA (on an authentication checklist or Manifest Document) to the Signature SHA on 
every signed and sealed Signature Document enclosed in a project ED assures that the contents of 
the files secured by the Signature are the files actually signed and sealed. In fact, this process is the 
only way to assign legal responsibility to the signatory through PEDDS.  

 

 
PEDDS - Signature Document 
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Section 3.15.4.2 Signatory Report 

The contents of a selected Signature are outlined within the Signatory Report. This report lists the 
URL, SHA, and qualifier for every file signed and sealed by the specified Signatory. These reports 
can serve as a useful record of the signed and sealed files, although they are not a part of the 
required project ED contents. 

 
Figure 3-161a:  PEDDS – Signatory Report 

 
PEDDS - Signatory Report 
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Section 3.16 Indexing/Plotting/Journaling – Updating 
the Index 

Sometimes, while using PEDDS to Sign and Seal files, new project files are created. These newly 
created files must have their attributes mined and be included in the project’s Index. EDI2 is used 
to create required reports, like the Summary PDF file, Project.pdf and the HTML report of the 
project, Sheetndx.htm.  

While Signing and Sealing, PEDDS created signatory file and delivery manifest files in the 
_meta_info folder of the project. When all files are created and mined, the final summary index 
ProjectFiles.htm is created. At this point PEDDS is used to secure all project files one last time. 

 

 
Indexing/Printing/Journaling 
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Exercise 3.15 Updating the Index 
EDI2 uses color coding to provide visual feedback to the user. Upon opening EDI2, the Project 
Files view displays files in green and/or red. Green indicates that file attribute data is present and 
appears up to date, while the red indicates that file attribute data is missing and the index needs to 
be updated. 

To update the Index 

The user can visually see files that need to be updated. 

1. In the Index/Printing/Journaling folder, click Launch. EDI2 opens. 

 
Launching EDI2 

Note   EDI2 by default opens the previously opened project, therefore Project 
21000415201 is the default project opened. 

2. On the Index (Step by Step) menu, click 1) Project (Mining File Attributes) and 
then click 2) Mine Modified Files (Mine for Changes).   

 
EDI2 - Updating Index 
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3. EDI - Mining opens. Upon completion of the updating (or mining) process, files in the 
Project Files view are now green and attribute data is up to date.  

 

 
EDI2 - Verify/Update Process 
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Exercise 3.16 Creating the Index of Project Files 

To create the Index of Project Files - ProjectFiles.htm 

ProjectFiles.htm is an HTML report containing a simple file index. This index is generated to 
display all project files in a user-friendly form. 

1. From EDI2, select Index (Step by Step) > 8) All Files Report.  

 

 
EDI2 - All Files Report 
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2. When EDI - Create All Files Report opens, click the Yes button. The file creation 
process starts and the newly created file, ProjectFiles.htm is displayed. 

 

 
Create All Files Report 

Note   The No button is selected when the index attributes were previously mined and all 
attributes are up to date. 

 
EDI2 - ProjectFiles.htm 
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3. From EDI2, select File > Save (EDI Plan Set Data – EDIProject.edi).  

 

 
EDI2 - ProjectFiles.htm 

4. From the View menu, select Project Viewer (All files, Image files, Design Sheets). 
EDI2 changes to the Project Viewer view. 
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5. Select the newly created ProjectFiles.htm, right click and select Mine File. EDI2 
mines the attributes for this newly created file. 

 

 
EDI2 - Mine File  

Important  EDI2 does not automatically display all newly created files. It may be necessary to 
select a discipline folder and then re-select the root level of the project. EDI2 then re-scans the 
directory and lists newly created files. 

  



Production Phase - Indexing/Plotting/Journaling – Updating the Index____________________Section 3 

Electronic Delivery Training Course © 2009 FDOT  3-149 

6. Select File > Exit to close EDI2. 

 

 
EDI2 - Exit 

Note   The index is now up to date and all required project files that EDI2 can create have 
been created. The project can now be secured for delivery. 
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Section 3.17 Signing & Sealing/Securing the Delivery 
Prior to delivery, the project must be secured using PEDDS. Securing is the act of creating and 
storing SHA-1 message digests for a specific file or file set. Message digests and relative file paths 
are kept in the project’s Manifest.xml file, which in turn allows PEDDS to validate secured files. 

The Manifest.xml file is created and maintained by PEDDS to define and secure the entire 
contents of a project delivery. This manifest file always resides in the project's \_meta_info\ 
sub-directory. 

The US Secure Hash Algorithm 1 (SHA-1) is a secure hash standard which produces a condensed 
representation of a message or data file. The SHA-1 is called secure because it is computationally 
infeasible to find a message which corresponds to a given message digest, or to find two different 
messages which produce the same message digest. 

When a project is secured, PEDDS generates a hash code (or fingerprint) for each and every file in 
the total project directory structure and then processes the set of hash codes to generate a master 
hash code for the project. PEDDS then generates a manifest file, containing a message digest and 
path for all engineering and signature files in a project. 

Once the creation of the manifest file is complete, PEDDS generates a report, the Manifest 
Document, which contains all information required to authenticate the project. The slightest 
change to one of the files in the secured set causes project authentication to fail.  

 

 
Signing & Sealing / Securing for Delivery 
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Exercise 3.17 Securing the Project for Delivery 

To secure the project 

1. If PEDDS is not already open, click Launch from Securing the Delivery. Florida 
Department of Transportation - PEDDS opens. 

 
Launching PEDDS 

 
Florida Department of Transportation - PEDDS 
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2. Open Project 21000415201. 

3. From the Project menu, click Secure --or—click the Secure the Current Project 
icon ( ) on the toolbar.  

4. Securing Project opens briefly then closes. 

 
PEDDS Securing the Project 

 
PEDDS Securing the Project processing dialog box 
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5. Delivery Manager Information opens.  Enter the Delivery Manager Name and 
Delivery Manager Title. 

 
Project Manager Information 

6. Click the Next button to continue. 
7. Description of Delivery opens.  Enter the purpose for the delivery and click the 

Finish button.  

 
Project Description 

Note   Project Manager information verified and/or modified above is the PEDDS 
project’s Project Header.  This can also be changed by modifying the PEDDS 
Project Header. 

8. Report Viewer then opens to present the Delivery Manifest Document. 

Note   PEDDS passes all files through the Federal Government SHA-1 secure Hash 
algorithm to create a manifest listing of Hash Codes for each file. That manifest is 
contained in a file called the manifest file. 
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9. In Report Viewer, click the Print button. The Delivery Manifest Document is sent to a 
print device. 

 
PEDDS - Manifest Document 

Important  The Delivery Manifest Document, called manifest.txt, and its related 
manifest.xml are saved in the _meta_info folder of the project directory. The Delivery 
Manifest Document must be printed, reviewed, signed, dated, and manually sealed by the 
Professional of Record as it is a required deliverable item per Item 13 of the Compliance 
Certificate Checklist Report.  

Note   The Delivery Manifest Document is a signed paper document used to secure a 
manifest file and reference the signature files in the project delivery corresponding to 
the manifest. By signing the manifest document, one has associated their name to the 
manifest file that corresponds to the hash code on the paper document. The manifest 
file lists the project files by URL and the project files’ hash-codes; thus the signatory 
has signed the files listed in the manifest. 
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10. Click the EXIT button in Report Viewer to re-open Florida Department of 
Transportation - PEDDS. 

 
PEDDS 
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Securing the Project for Delivery: Possible Errors  

After securing process is complete, the Delivery Manifest Document opens.  A Pedds alert 
dialog displays if there is an unused signatory, since the project cannot contain unused signatories. 

 

 
Pedds Alert Dialog  

PEDDS suffixes the unused signatory file with a .DELETE extension.  To eliminate this error, 
this signatory must either be used or deleted. 

 

 
Unused Signatory File  
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Section 3.18 Additional PEDDS Reports 
To view and print additional PEDDS reports 

From the Reports menu, select Project Reports to list available printable reports. 

 
PEDDS - Additional Reports 

Note   Some of these reports are not necessarily required deliverable reports. 
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Section 3.18.1 Project Identification Report  

Although not technically a part of the PEDDS application, PEDDS relies on the Project ID 
application to provide unique project identification information for each project PEDDS secures. 
This information is summarized within the Project Identification Report.  

In the current version of PEDDS, the project ID information includes the PEDDS Key, a unique 
identifier (literally a GUID - globally unique identifier - generated by the computer from a set of 
changing values; sometimes called a UUID - universally unique identifier) that is used in PEDDS 
and PEDDSDB to uniquely identify a project. When a project ID file - projectid.xml - is 
generated for a project for the first time, this identifier is assigned and never changes afterwards. 

 

 
PEDDS - Project Identification Report 
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Section 3.18.2 Delivery Manifest Document 

The Delivery Manifest Document is the essential validation mechanism for project delivery. The 
Delivery Manifest Document is created every time a project delivery is secured by the Project 
Manager, and a printed copy of this document, signed by the Project Manager, must be included 
with the ED package (CDs and documentation) provided to FDOT.  

This document contains the results of the chain of SHA-1 message digest creation at the heart of 
the PEDDS validation process. Included in the Delivery Manifest Document are the following:  

• Manifest SHA - the message digest of the manifest.xml file - the file that contains 
the SHA-1 message digests of all files within the project delivery  

• Summary of Signature files - a listing of signature files included in the project 
delivery  

When a project is secured, an SHA-1 message digest is generated for all the files within the 
project. These file message digests are stored within the manifest file (manifest.xml) within the 
project delivery's _meta_info folder, thereby securing each file's contents. Then, an SHA-1 
message digest is generated for the manifest.xml itself, securing its contents - the message digests 
of the files in the project. Finally, the manifest.xml message digest (called the Manifest SHA) is 
printed on the Delivery Manifest Document, which is signed by the Project Manager, thereby 
securing the project through a chain of message digest generation.  

As shown below, the Delivery Manifest Document contains the only copy of the Manifest SHA, 
and thus is integral to the process that secures the project as a whole. All authentication and 
validation for the project delivery as a whole rely upon the comparison of a generated Manifest 
SHA against the Manifest SHA stored and secured on the signed Delivery Manifest Document. 

 
PEDDS – Delivery Manifest Document 
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Section 3.18.3 Multiple Signature Report 

PEDDS allowing for the signing and sealing of files by multiple signatories. The Multiple 
Signature Report reflects those changes, providing a quick, easy way to see what files within a 
project delivery are signed and sealed by multiple signatories. Files signed with multiple 
signatories are listed in this report by their SHA-1 message digest, plus the signatory, signatory 
qualifier or scope of work, and the file URL of the signed and sealed file. 

 

 
PEDDS - Project Files with Multiple Signatures 

Section 3.18.4 Duplicate File Report 

Some projects may contain files whose contents are identical, though their file names may or may 
not differ. To aid in identifying these files, the Duplicate File Report checks the SHA-1 message 
digests stored in the manifest file for duplicates. These duplicates are reported in the Duplicate File 
Report. Please note the apparent similarity of this report to the next report, the Duplicate Filename 
Report. The Duplicate File Report actually checks the SHA-1 message digest of the files contained 
in the project delivery - ignoring the file names; the Duplicate Filename Report only compares the 
file names of the files and ignores the message digests. 
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PEDDS - Duplicate File Report 
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Section 3.18.5 Duplicate Filename Report 

Unlike the Duplicate File Report, the Duplicate Filename Report checks the file names of the 
contents of a project delivery. Duplicate file names are listed in this report to aid in identifying 
duplicate file names which may or may not contain identical contents. 

 

 
PEDDS - Duplicate Filename Report 
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Section 3.19 Indexing/Plotting/Journaling - PEDDS 
Viewer 

EDI2 is PEDDS aware and contains a tab (PEDDS Meta Info) that allows the user to review and 
verify PEDDS data.  This gives the user the ability to have over-plot protection for signed / sealed 
files from one interface.  Also, EDI2 cross references on-disk files with the PEDDS Manifest and 
Signature file data and offers a color coded display.  

 

Exercise 3.18 EDI2 - PEDDS Meta Info Tab 
Once the project has been secured, the Manifest document, manifext.xml is up to date and the 
project can be opened with EDI2 to validate the project. 

To use the PEDDS Meta Info Tab 

1. Open EDI2. When EDI – Open Project for Write Access displays, click the No 
button.  Otherwise, the secured project will not authenticate. 

 
EDI – Open Project for Write Access 

11. Verify that project 21000415201 is opened and click the PEDDS Meta Info tab.   

 

 
EDI2 - PEDDS Meta Info Tab Selection 
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12. EDI2 begins the validation of PEDDS information. 

 
EDI2 - PEDDS Validation 

13. Click and open several of the folders and review the PEDDS validation information. 

 
EDI2 - Manifest Project Report 

Note   During this exercise discussions are held on the different information found from 
the PEDDS Meta Info tab in EDI2. 

14. Select File > Exit To close EDI2. 
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Section 3.20 Creating Project Subsets 
Set Maker was designed and developed by the FDOT Engineering/CADD Systems office to assist 
in the validation and generation of various types of electronic project file subsets required during 
the life span of a project, including the creation of a 'Plans and Specs' data subset from the 'Project 
CD' data set. 

 
Set Maker 

The application automates a great deal of file validation, by cross referencing the project’s index 
(ProjectIndex.XML), PEDDS manifest file (Mainfest.XML), Sheet Index Reports 
(Sheetndx.HTM), and other PEDDS information (Signature files, and the SHA-1 hash codes for 
files) to ensure the parent project used in the 'Source Folder' is valid and secure before creating 
subsets.  

Set Maker can be used to build any subset of data from a project. Set Maker always secures the 
data set it creates. The selection of files is done both manually and by Business Rules: 

Predefined rules 

• all files signed and sealed 

• all files secured by PEDDS (This would be the entire project, since Set Maker 
requires a project to be Secured before it operates on it) 

• all files included in indexes (ProjectIndex.XML and/or SheetNDX.htm) 

• revised files contained in DeltaNDX#.htm, etc. 

User-defined rules 

• include files in a given directory by filespec (including wild cards) 

• exclude files in a given directory by filespec (including wild cards) 
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Exercise 3.19 Creating Subsets -Plans and Specs 
The following exercises use Set Maker to create several types of sets: 

• Plans and Specs - which can be burned to a CD (Plans and Specs CD).   

• Plans and Specs Revision - which can be burned to a CD (Plans and Specs Revision 
CD). 

To create of a Plans and Specs Set 

1. In Creating Project Subsets, click Launch. Set Maker opens. 

 
Launching Set Maker 

 
Set Maker 

15. In Source directory click the Browse button ( ).  Browse for Folder opens. 

 
Browse for Folder 
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16. From Browse for Folder, navigate to and select the active project (for the purposes of 
this exercise, select c:\E\Projects\21000415201).  

17. Click the OK button.  Set Maker validates the project information and then 
re-appears. 

 
Set Maker 

Important  SetMaker requires that both a valid ProjectID.xml and Manifest.xml file exist in 
the project’s _meta_info directory. If these files are not found, the application reports an error 
and does not allow users to continue the set making process. 
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Section 3.21 PEDDS File Validation - Excerpt from ED 
Desktop 

Set Maker automatically validates PEDDS SHA-1 hash codes for each file in the project.  Set 
Maker calculates the SHA-1 code for each file in the project on-disk, and compares the computed 
hashes with those stored in the PEDDS Manifest.XML file, Signatory files, and the 
DeltaNDX#.htm xml data.  If the hash codes do not agree, the process is suspended and 
appropriate warnings are generated (see figure below). 

FILE VALIDATION ERRORS & WARNINGS 
Set Maker may encounter errors and warnings during the validation process. If such errors are 
found, the application displays an error report detailing each problem. An error disables the ability 
to create a selection set where as a warning allows the creation of a sub-set. It is highly 
recommended to investigate the cause of warning messages before proceeding with the creation of 
sub-sets.  

From the Project Scan Error Summary form’s toolbar, users may save the error report by selecting 
the disk icon (  ) or print the report by selecting the printer icon ( ). 

Once a project has been validated, users may revisit the error report at any time by selecting View 
> Error Log from the Set Maker menu bar. 

 
Set Maker - PEDDS File Validation Errors & Warnings 
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Errors are grouped together based on the type of error: 

• Manifest File Errors:  files listed in Manifiest.xml that are not physically 
located in the project directory structure. 

• Signatory File Errors:  files listed in a signatory file that are not physically 
located in the project directory structure. 

• SHA1 Code Validation Errors:  files that do not match the SHA1 Hash 
code in either Manifest.xml file, Signatory File, and/or DeltaNDX#.htm file.  

• ProjectIndex File Errors:  files listed in ProjectIndex.xml that are not 
physically located in the project directory structure. 

• DeltaNDX File Errors and Warnings:  files listed in DeltaNDX#.htm as 
'New' or 'Modified' that do not exist within the physical directory structure are 
marked as errors. File listed as 'Deleted' that do not exist within the directory 
structure are marked as warnings. 

• Non Project File Errors:  files detected in the project directory structure 
that are not listed in the Manifest.xml file.  The _meta_info folder may contain 
files NOT listed in the manifest with the exception of Signatory files.  ALL 
signatory files MUST be listed in the manifest. 
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Exercise 3.20 To select files by File Selection and File Selection 
Rules 

To further expedite file selection, Set Maker has a number of pre-defined selection options. The 
selection options select sheets found in Projectindex.xml, using pre-defined selection rules to 
select sheets to build the Plans/Specs set.  Files that are not part of the Project Index do not meet 
the selection rules and must be selected manually. 

1. From the project tree, navigate down to the Specs folder and select the specification 
document. For this exercise, click 21000415201specs.pdf. 

 
Set Maker - Specs Document Selected 
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2. From the Selection menu, click File Selector Rules.  

 

 
Set Maker - File Selection Rules 
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3. File Selections Options opens. Populate the checkboxes for Indexed Files and 
Signed/Signed and Sealed Files and then click the Apply button. 

 

 
File Selection Options - Plans/Specs 

Important  If the Signed/Signed and Sealed Files rule is selected, ALL files secured by ALL 
Signatories are copied to the subset.  Set Maker will not break Signatories. As a result, this 
ensures that all signatories can be authenticated in the subset.  
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4. From File Selection Options, click the Close button. Set Maker reappears and the files 
are selected based on the specified selection rules. 

 

 
Set Maker - Files selected 

Note   Project.pdf is not included in either Sheetndx.htm or ProjectIndex.xml. If 
Project.pdf is not signed or signed and sealed, it is not specified by the pre-defined File 
Selection Rules. This file must be included with Plans and Specs and therefore, it must 
be manually selected.  
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5. Click the Browse button ( ) to the right of the Destination Directory box. Browse for 
Folder opens. 

 

 
Browse to Folder 

6. From Browse for Folder, navigate to and select the active project (for the purposes of 
this exercise, select C:\E\Plans_and_Specs\21000415201) and click the OK button. 
Note: the destination folder must be empty to successfully create a subset. 
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7. Set Maker reappears with the selected Destination Directory added as shown in the 
following figure. 

 

 
Set Maker 

Note   Consultants can name the destination folder to meet their own workflow. 
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8. From the File menu, click Create Set --or-- click the Create Set button ( ) on the 
toolbar.  

 

 
Set Maker - Files selected 

 

9. User Information opens.  Enter the required information as follows:  

10. User Name - FDOT Project Manager 

11. Title – Project Manager 

12. Set Usage – Select Other since it is for a Plans and Specs CD 

13. Description - Plans and Specification for Project 21000415201 
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14. When finished, click the Create Set button. The creation of the set begins.  

 

 
User Information 

Important  User Information defines the lineage of the subset. The information entered is 
contained in the manifest file created in the subset. This always links back to the parent or 
originating project the subset was created from. 

15. Upon creation of the set, SetMaker opens to confirm the creation.  Click the OK 
button to continue. 

  
SetMaker 
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16. Manifest Report displays.  Click the Print button to send the report to a print device.  

 
Sub-Set Manifest Document 

17. Click the Close button. Set Maker reappears. The files and folders needed to create a 
Plans and Specs CD are copied to the defined location as shown in the following figure.  

Important  A CD properly labeled for Plans and Specs can now be created. 

  
Windows Explorer - Plans and Specs Set 
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Exercise 3.21 Creating Subsets - Plans and Specs Revision 
Using Set Maker to create sets for Plans and Specs Revisions requires that revisions to plan sheets 
be created. As such, this exercise can be found in Section 5, Electronic Delivery - Handling 
Revisions, of this manual. 

 

Exercise 3.22 SetMaker - Additional Information 

To review File Information 

Upon selecting a file in Set Maker, information about the file is displayed in the left pane of Set 
Maker. 

 
SetMaker - File Information 
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To create User Defined Rules 

1. Right-clicking on a folder allows the user to select an option, Add Rule, to add a new 
User Defined Rule or Select All. 

 
Set Maker - Create a New Rule 

2. Upon selecting Add Rule, File Selection Rule opens. In this box, the user can choose 
to Include or Exclude files in the selection. After saving the rule, the rule is saved to 
the File Selection Options. 

 
File Selection Rule 
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3. Upon opening File Selection Options, the new rule is available to Include (or 
Exclude). 

 
File Selection Options 

4. File selection options, as well as any user defined rules shown in File Selection 
Options, can be saved to a file for recall anytime Set Maker is used by selecting File > 
Save Selection Rules as shown in the following figure. The Selection Rules are saved 
to a text file. 

 
Save Selection Rules 
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Section 3.22 Creating Strung Projects 

Section 3.22.1 Introduction to Strung Project 

Strung Project is a new application designed to assist with the creation of strung project directory 
structures for the ED process. Strung Project allows selection of a ‘Lead project’ and multiple 
‘Goes-with project’ Plans and Specs' data subsets, and copies them to the correct strung project 
directory structure (shown below). While doing so, Strung Project also creates the environment 
to secure the newly created strung project directory structure with PEDDS.  

  
Structure 

• Lead Project ‘Plans and Specs’ data subset = 12345678901 

• Goes-with Project ‘Plans and Specs’ data subset = 10987654321 
• Goes-with Project ‘Plans and Specs’ data subset = 22222222222 
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Section 3.22.2 Requirements 

Before creating ‘Plans and Specs’ data sub-sets with Set Maker, the project data sets should 
already contain the navigational hyperlinks in their Sheet Index Reports (Sheetndx.htm). These 
navigation hyperlinks can be added during the creation of the Sheetndx.htm reports, using the 
EDI.  

Typically, it is known prior to project delivery if the project in question is going to be a component 
in a strung project, or not. EDI prompts the user to specify whether or not the project is going to be 
a component of a strung project at the time the Sheet Index Report (Sheetndx.htm) is created. 

Strung Project requires that the data source for both ‘Lead’ and ‘Goes-With’ projects be 
previously secured. Strung Project validates candidate ‘Lead’ and ‘Goes-With’ Plans and Specs 
data sub-sets to enforce this requirement. The source data for ‘Lead’ and ‘Goes-With’ projects are 
subsets of Project CD data sets created by the Set Maker application. 

  
Structure 

Section 3.22.3 Strung Projects 

Section 6, Electronic Delivery – Strung Projects of the this manual contains an in-depth 
exercise on this topic. 
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Section 3.23 Delivery Compliance Checklist 
Along with the secured project CD, the requirements listed in the Compliance Certification 
Checklist Report must be delivered to the FDOT Project Manager. The Compliance Certification 
Checklist Report, also known as the Compliance Certification Worksheet, is a document that 
contains the data producers’ certification that all items required by the CADD Manual are included 
in the project.  A signed Compliance Certification Checklist Report must also be delivered to 
the FDOT Project Manager. 

 

 
Compliance Certification Checklist Report 
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Exercise 3.23 Printing the Compliance Certification Checklist Report 

To print the checklist 

1. From Electronic Delivery, click Delivery Compliance Checklist as shown in the 
following figure and then click the Print button.  

 
Electronic Delivery - Delivery Compliance Checklist 

5. Print opens.  Specify the desired printer and click the Print button. The Compliance 
Certificate Checklist Report prints. 

 
Print dialog box 
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Section 3.24 Making a Delivery 
After the project is secured and the Compliance Certification Checklist Report is completed, the 
project can be copied to portable media, such as a CD Rom or DVD and labeled accordingly for 
delivery to the Department.  

This delivery should include the Project CD, signed Compliance Certification Checklist Report, 
and all signature documents generated by PEDDS.  

It is recommended that the project be authenticated on the delivery media prior to delivery to the 
Department, per Item number 15 of the Compliance Certification Checklist Report. 

The Project CD is described as the CD containing all data associated with a project, including all 
files on the Plans & Specs CD, all design files, all reference files, project journals, etc. 

 
Example of a labeled CD suitable for delivery 

If the project is too large to fit onto one CD, the use of DVD is permitted as long as the delivery 
media is labeled as a DVD. If DVD is not available, the recommended procedure is to span the 
project across multiple CDs.  

If multiple CDs are used, the recommended method of authenticating the delivery media changes 
as PEDDS cannot authenticate across multiple CDs. 

 

Exercise 3.24 To authenticate multiple CDs 
1. Copy all project data from the CDs to a temporary storage location using Windows 

Explorer. 

Important  Do not make any changes to the project after copying to the temporary storage 
location. 

2. Authenticate the copied project in the new temporary location using PEDDS. 

3. If project verifies, send the delivery media (multiple CDs) to the Department. 

4. Remove the temporary project copied from the CD 
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4 Post-Production Phase 
The Post-Production Phase training section covers the details of receiving and authenticating a 
delivered project. 

• Post-Production Phase 

• Authenticating a Delivery 

• Authenticating a Project: Other Considerations 

• QC of Project Data Structure 

• Printing Sheets 

• Project Storage and Accessibility 

Section 4.1  Post-Production Phase 
Section 8.5 of the CADD Production Criteria Handbook (CPCH) describes the Post-Production 
Phase of Electronic Delivery as the review and acceptance of the data and supporting 
documentation, as well as making the delivery available to FDOT internal services for posting.  

The consultant delivers a Project CD to Florida Department of Transportation (FDOT) containing 
the required delivery components as defined in Chapter 3 of FDOT’s CADD Manual.  FDOT 
project managers review the accompanying data, the Professional Electronic Data Delivery 
System (PEDDS) and other reports, and project compliance certification form (or an alternative 
form or checklist the District chooses to aid in doing Quality Assurance (QA) on the project 
delivered). Project managers also review the project by inspecting the project data and index 
information. This review procedure allows project managers to determine if the project is 
complete and meets appropriate standards. 

An important consideration for all Post-Production processes is that the project data be secured 
using PEDDS, and any modifications to the project would cause it to not be able to authenticate in 
PEDDS.  As such, all tasks performed under Post-Production should not add, delete, or modify 
the delivery in any way (unless so desired).  
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Expanded Post-Production Phase 

The following are recommended review suggestions for the project manager: 

• Ensure the CD (or other delivery media) has the proper labels. 

• Authenticate with PEDDS, and safely manage all hard-copy documentation present (i.e., 

enroll the documents into the Department’s EDMS system or other method for long-term 

document management). 

• Make provisions to store the media the delivery came on, in the event the delivery is to be 

accepted. 

Use the File Checker application to interrogate the project for evidence, or lack of QC controls.  
Review the File Checker reports submitted by the producer if applicable. 

• Review the Index data and the referenced plan sheets using the Sheet Index Report 

(SheetNDX#.htm) in a Web Browser and the associated application to open and view the 

plan sheets themselves. 

• Print any sheets that need further scrutiny, and seek the assistance of experts. 

The list above only contains suggestions and is not complete. Each district has its own project 
acceptance criteria. 
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Section 4.2 Authenticating a Delivery 
The PEDDS program features the ability to check the integrity of secured project files and 
directories and is used to authenticate delivered files. Project designers may use the program at any 
time to verify that the project has not been tampered with after being secured. Authenticating a 
project detects any additions, deletions, or modifications of files. 

Authentication is the process of comparing the newly generated SHA-1 Hash Codes of the 
Manifest File (Manifest.XML), found printed on the Authentication Report [and those of the 
referenced Signature Files] for an on-hand delivery to those recorded on a received signed 
Manifest Document for a specific delivery. This process is similar to validation, but extends the 
process to the examining the signed paper Manifest Document. 

 
PEDDS Securing and Authenticating Projects 
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Exercise 4.1 Authenticating a Delivery 

The entire delivered project will be authenticated. It is recommended to Authenticate the delivered 
Project CD (media on which the data arrived) itself. This CD should contain all data associated 
with a project, including all files on the Plans & Specs CD, all design files, all reference files, 
project journals, etc. 

To open a project In PEDDS 

1. Select the executable file EDSection4ExercisesStart.exe, ensure Unzip to folder is 
set to C:\e and click the Unzip button to place the starting dataset for Section 6 on the 
hard drive.  Notice that there is an additional copy of the final secured project 
21000415201 in the C:\E\Plans_and_Specs folder.  

 

2. In the Authenticating a Delivery folder, click Launch. The Florida Department of 
Transportation – PEDDS window opens. 

 
Launching PEDDS 

 
Florida Department of Transportation - PEDDS 
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3. From the Project menu, select Open --or-- click the Open Project icon   on the 
toolbar.  

 
Open a PEDDS Project 

4. Open Project displays.  In the Drive box, select the drive letter from the pull-down 
where projects reside.  This is usually the CD drive if authenticating the media the 
project was delivered on. 

5. Navigate to the projects folder and select the project. 

 
Open a PEDDS Project dialog box 
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Open a PEDDS Project – browse for folder 

 
PEDDS Open Project 

Important   If the project is on multiple CDs, use standard Windows tools to copy the complete project 
to a temporary folder on the hard drive where the data can re-combined. Authentication across 
multi-media is not supported. The project must reside in a single contiguous block of storage space to 
be processed by PEDDS. 

Note   Folders with a Briefcase icon represent existing PEDDS projects.  Check Find all 
Projects on Current Drive to locate only the PEDDS projects on the current drive. 

6. In the Current Path box, verify the project selection. If the selected project is incorrect, 
repeat step  

7. To load the selected project into PEDDS, click the OK button. The loaded project is 
now ready to be authenticated. 

  



 Post-Production Phase - Authenticating a Delivery Section 4 
 

Electronic Delivery Training Course © 2009 FDOT 4-7 

To authenticate the project 

1. From the Authenticate menu, select Project --or-- click the Authenticate the 

Current Project icon  on the toolbar. If the project was previously secured, 
Authenticate opens.  

 
Authenticate a PEDDS Project 

 
Authenticate a PEDDS Project – processing dialog box 

Important   According to standard procedure, the project must be secured prior to delivery. 
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2. In Report Viewer, click the Print button to send the report to a print device. 

3. To close Report Viewer, click the EXIT button. 

 
PEDDS - Report Viewer dialog box 

Important   The Delivery Authentication Test report is a required deliverable item as per Item 14 of the 
Compliance Certification CheckList Report. This requirement was included because many deliveries 
the Department received prior to the requirement would not authenticate.  This ensures the data 
producer has at least taken  made certain the project was correctly written to the delivery media. 

4. At this juncture, the SHA-1 Hash code for the Manifest File appearing on the Delivery 
Authentication Test Report as shown above, should be manually compared with the 
one found on the printed Manifest Document that accompanied the delivery.  If the 
SHA-1 Hash codes of the Manifest(s) appearing on each report match, then the project 
is Authenticated; that is no files have been modified, deleted, or added during 
transmission of the project between the data producer and data receiver (the 
Department).   
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Section 4.3 Authenticating the Project: Other 
Considerations 

The signing and sealing authentication process generates a report that:  
• Displays the computed hash code of the professionals’ signatory file, or other discipline 

signatory files. 

• Displays the computed and stored SHA-1 hash code of the ProjectID.xml file. 

• Displays any project files with an invalid SHA-1 hash code or missing project files. 

 

This is the authentication process required by the Board of Professional Engineers to insure that 
files are signed and sealed. 

The user must compare the signatory’s SHA-1 hash code from the authentication report against the 
SHA-1 hash code from the signed and sealed signature document. If they match, then the signature 
file is valid. If no invalid project files are found and no files are missing, then all project files listed 
are signed and sealed. If there are any invalid files or missing files, then those files are excluded 
from the list of project files that are signed and sealed. 

A file is the smallest quantity of work that can be signed and sealed; however, a file may be signed 
and sealed by more than one Signatory. The professional must ensure that the file to be signed and 
sealed contains only the work that he/she wants to sign and seal. There is no way to sign and seal a 
portion of a file. The qualifier option should be used to distinguish work disciplines within a file 
the signatory is taking responsibility for. 
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Section 4.4 QC of Project Data Structure 
File Checker is a tool designed to assist with Quality Control (QC) of electronic delivery projects. 
It is used to examine projects both during development and when they’re ready for submission and 
provides reporting that the project follows standards and business rules for the electronic delivery. 

 
QC of Project Data Structure 

File Checker uses data already present in the project to provide simpler reporting, such as 
pre-existing QC reports (*.txt) from QA/QC software and attribute data mined during 
SheetNavigator runs. The program examines a variety of potential problems in the project, and 
presents those in color coded reports to the user.  

  



 Post-Production Phase - QC of Project Data Structure Section 4 
 

Electronic Delivery Training Course © 2009 FDOT 4-11 

The program also provides a powerful search utility. The following list is only a few of the items 
checked by File Checker: 

• FDOT directory structure intact (directories added / deleted / and non-standard directories).  

• Reports directories greater than 16 chars, with spaces, multiple consecutive spaces, or 

special characters.  

• Reports File names with spaces, multiple consecutive spaces, long file names, and special 

characters.  

• Full paths to files are 255 characters or less.  

• Looks for same file names, found in different paths, with same or different file content 

noted.  

• Looks for same file content with different file paths / file names.  

• Looks for large files (could indicate a problem file.)  

• Identifies MicroStation files that do not meet FDOT file naming conventions.  

• Looks for Sheet files that have been signed / sealed, but are not in the index.  

• Looks for Indexed sheets that are not signed / sealed.  

• Determines presence of key ED component files (SheetNDX#.htm, ProjectIndex.XML, 

Project#.pdf, Projectfiles.xml, etc.).  

• Index validation, Index validation against PEDDS data, against data on-disk. 

• Searches for QC reports, extracts data into sortable tables, including QC reporting of 

Critical files  

File Checker is only a tool to assist in the reporting of projects for the items it checks. Users 
should not assume that it uncovers all potential problems. Likewise, read the reports carefully to 
determine if a reported item is indeed problematic for the project. This utility also requires 
Microsoft.NET Framework (which should already be installed if you are using other FDOT 
Electronic Delivery tools). 

Note   For more detailed information on the File Checker’s Interface, see Section 2.5 of the 
Pre-Production Phase. 
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Section 4.5 Printing Sheets 
QSheet is intended to allow a means to print all or part of an indexed project sheet set. qSheet 
can print using either the Project Index (ProjectIndex.XML) or the Revision Report 
(DeltaNDX#.htm) as the input to determine which files are available to be printed. qSheet is 
'strung project' aware; once a project directory is opened, qSheet searches sub-directories for 
Indexes or Revision reports for printing.  

For printing execution, qSheet launches the selected file(s) onto the chosen printer/queue. For 
most file types, the associated application in Windows is evoked to aid with the printing process 
(for example Acrobat Reader for .PDF files). For PostScript files, the user has the option of either 
letting qSheet copy those directly to a PostScript compatible printer (called Postscript 
pass-through printing), or having qSheet convert PostScript files 'on-the-fly' to PDF and 
launching the print using the converted PDF as the print source. The second option requires that 
the GhostScript engine be loaded and properly selected. It is highly recommended that a 
printer/queue be configured where the default paper size is set for the desired paper size to be 
printed by qSheet.  

A Video tutorial for the operation of the qSheet utility is available on the FDOT, Engineering / 
CADD Office website. This video also discusses the proper configuration of the print queue for 
qSheet to work properly. 

 
qSheet 
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Section 4.5.1 To open the Project 

The qSheet application searches for all Indexes and revision reports under that directory 
structure. As these are found, each is validated (are the files being referenced found, and available 
for printing) before loading into the left pane tree view of the interface as shown in Fig. 4-31. 
Select the Index or report file in the left pane - the right pane automatically loads and refreshes the 
available sheets to print. 

qSheet has been designed to run as a stand-alone application and requires no installation. It can be 
executed from non-writable media, such as a CD-ROM. Before a set of sheets can be printed, you 
must have a completed ProjectIndex.XML or DeltaNDX#.HTM file at the root level(s) of the 
project or sub-project (strung projects). 

1. In Printing Sheets, click Launch. qSheet opens. 

 
Printing Sheets 

 
qSheet 
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2. From the File menu, click Open --or-- click the Open button on the tool bar. 
Browse for Folder appears. 

 
Open 

3. From Browse for Folder, navigate to the current project. 

4. Click the OK button. qSheet re-opens and displays the project. 

 
qSheet - Project 2100041 opened 
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5. From the listed and available reports, click 21000415201\ProjectIndex.xml. qSheet 
now displays the available components and, if expanded, the sheets available for 
printing are displayed. 

Important   If qSheet finds that an indexed sheet is missing from the project, an error message displays 
and the project continues to load without reference to the missing sheet. 

 
qSheet - ProjectIndex.xml selected and expanded 

6. Once the project index is loaded, select the box next to the desired item. To deselect an 
item, click the check box again.  

Note   The user may select or deselect one sheet a time, select or deselect all sheets within each 
plans component, or select or deselect the entire project. 
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To print sheets 

Before printing with qSheet, the Support Applications, which enable the GhostScript application 
to convert a Postscript file to PDF 'on-the-fly' for user who don’t have a PostScript printer, must be 
verified. GhostScript is automatically loaded with the FDOT Electronic Delivery software. 

1. From the Options menu, select Support Applications. . 

 
qSheet - Support Applications 

2. Supplemental Applications displays.  Verify the paths to the support applications are as 
shown below and then click the Save button. Click the Close button to continue.  

 
Supplemental Applications 
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Supplemental Applications 

3. Qsheet re-opens and is now ready for printing.  From the File menu, select Print 

--or-- click the Print button  on the tool bar. Print opens. 

 
Print 

4. From the Printer list, select the desired printer (output device).  Preferably, pick a 
postscript compatible printer like the one shown above, which allows qSheet to copy 
postscript sheet files directly to the printer in “pass-through” mode Populate the 
checkbox for Print postscript files passthrough as shown in the  previous figure. 
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Section 4.5.2 “Pass-through” PostScript Printing   

If you have a PostScript compatible printer, and want to print PostScript files by copying them 
directly to a Postscript printer, there is a check box on Print as shown in Figure 4-39. This is what 
is referred to as “pass-through" printing, because the PostScript files are not processed by the 
Windows printing process. Windows normally uses a helper application (the associated 
application) to process print requests. Pass-through printing bypasses the Windows print process 
for PostScript files only (all other file types printed are processed by the associated Windows 
applications). 

When the “pass-through” option is selected, Postscript files are not converted to PDF on-the-fly 
for printing and are copied directly to the printer/queue, resulting in faster printing. This option 
may also result in more accurate printing because no supplemental conversion to PDF takes place.  

During PostScript pass-through printing, qSheet executes the following console command in 
Windows:  

copy /b filename.ps \\server\printer_name 

In Windows, a printer can be named something other than the printer's "share" name on the 
network or server. qSheet cannot resolve differences between those names (because it is 
executing a console copy command).If Postscript pass-through printing does not work, check the 
network share name of the printer and see if it is the same name as the printer name in the queue (as 
it should be). This can be done by looking at the sharing tab on the printer properties dialog for the 
printer. 

Section 4.5.3 “On-the-Fly” PDF conversion Printing  

When no Postscript printer is available, use the PDF conversion “on-the-fly” option to print the 
Postscript files. This option is selected by making sure the “pass-through” option checkbox is 
not populated (no checkmark). qSheet uses GhostScript to convert PostScript files to PDF 
“on-the-fly”, using the GhostScript setting selected in the Supplemental Applications dialog 
shown previously. The converted PostScript files is launched onto the Windows print process as 
PDF files (so the associated application for PDF printing,  usually Adobe Acrobat, handles 
printing of converted PostScript -> PDF files). The converted PostScript -> PDF files are not 
stored on the disk permanently.  

Make sure you have a print queue that has the default paper size set to size of paper you wish to get 
from the printer, and that the PDF printing settings are correctly established in Acrobat or Acrobat 
Reader (or an alternate associated application for handling PDF on your computer) before the print 
session is started in qSheet.  When a postscript is converted to PDF on-the-fly, and launched on 
the Windows print process, qSheet has no ability to control Acrobat Reader to tell it the sheet 
size, orientation, scale, etc. – That is why it is necessary for the user to set it up ahead of time on 
your print queue (device default) and perhaps launch Acrobat Raeder or Acrobat ahead of time to 
make sure the settings are the default prior to printing with qSheet. 
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Section 4.5.4 Printer Selection Considerations  

Printer selection and setup can be the most difficult aspect of the project printing process. The 
following items should be considered when selecting and setting up the printer: 

• Print PostScript (.ps) files to a PostScript printer. Attempting to print a PostScript 

file on a non-PostScript printer can have very unpredictable results, from skipping the item 

in the print queue to printing enormous amounts of empty pages. If you are not sure that the 

printer is a PostScript printer, contact the systems administrator or check the printer 

manual. 

• To print sheets as PostScript files converted “on-the-fly” to .PDF files, a print 

queue available which sets the proper default paper size on the printer must be available. 

The new queue must be setup with a default paper size (i.e. tabloid or 11x17) in order to 

print the sheets correctly and on the correct paper size for plans 

• Get to know the printer settings. Sheets in the print queue that are not PostScript files 

are printed at the default paper size that has been selected for the printer, which could result 

in .PDF or .TIF sheet images being printed on letter-sized rather than tabloid-sized paper. 

The selected sheet size is applied to all non-PostScript files in the print queue, so you may 

wish to print letter-sized spec packages as a separate print job. 

Printing an entire project can require a large amount of resources for the 

printer, and can overwhelm the printer’s print buffer if too much data is sent. Most 

network printers have 48 to 64 megabytes of internal memory, and this may not be enough 

for larger print jobs. ECSO recommends against printing to a stand-alone network printer 

with limited buffer memory for large print jobs. Printing to a local printer or a network 

printer that is connected to a print server with additional storage capacity is preferred. If 

these are not available, you may have to print your project in batches. 
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Section 4.6 Project Storage and Accessibility 
Once the project is accepted by FDOT, the secured delivery is stored in the PEDDS database 
(PEDDS-DB).  

Depending on the type of work, a project may also be defined in FDOT’s Technical Information 
Management System (TIMS) for use in other post-design and/or post-letting phases of the project. 
TIMS is FDOT’s internal file management system used during plans production for file check 
in/checkout.  

Once the project is let to contract, if applicable, construction personnel may access TIMS project 
data for use during the construction phase. Furthermore, a secured delivery may be accessed from 
PEDDS-DB through the PEDDS interface or a Browser. Access of TIMS warehoused project or 
PEDDS DB secured deliveries is done from the internal FDOT intranet.  As applicable, the files 
can be used as a basis for producing the final, as-built plan set using many of the tools found in the 
FDOT CADD software suite.  
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5 Electronic Delivery - 
Handling Revisions 

 

The Electronic Delivery - Handling Revisions training section covers the details of handling 
revisions using Production Phase tools including: 

• Revisions – Project Delta 

• Sheet Navigator 

• Updating the Index PostScript Images 

• Using Project Delta 

• PEDDS - Signing and Sealing Revisions 

• Creating Data Subsets for Revisions 

• Additional Revision Considerations 

Section 5.1 Revisions - Project Delta 
Section 20.4 of the Plans Preparation Manual (PPM), Volume I defines a revision as a modification 
to the PS&E package after it has been transmitted to Central Office but prior to bid opening. When 
processing Plan Sheet revisions in the context of electronic delivery, it is important to recognize 
how MicroStation works and consider the need to protect legacy data from earlier deliveries. The 
methods described are the recommendations for revising plan sheets in MicroStation files using 
software in the Electronic Delivery suite of tools. 
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Production Phase in the Context of Revisions 

Production Phase workflow and Production tools are used to make revisions as part of the overall 
contemporary version of the project. These tools are used to bring the project up to date and create a 
new Project CD for delivery. Project Delta is used to report all revisions and Set Maker is used to 
build a data subset that represents the changed data only (Plans and Specs Revision CD). 

Section 5.1.1 Preparing the Data for Revisions 

To outline the exercise, a proposed drainage structure located at station 11+08.60 needs to be 
moved to station 11+08 due to a construction conflict. The required modification of the drainage 
structures in the design file pondrd01.dgn from the drainage discipline, only affects Sheets 35 and 
36 found in plprrd01.dgn of the roadway discipline.  

Note   An assumption is made that the required revisions to pondrd01.dgn and 
profrd01.dgn design files have already been completed by the designer.  The required 
changes to the Key Sheet are not made in this exercise due to time constraints. 

For the purposes of our revisions exercises, the following assumptions are true: 

• The Project CD is completed, secured and delivered. 

• According to the PPM, the “Plans to Tallahassee Date” has passed. 

• Revisions, not changes, are required. 
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Exercise 5.1 To Prepare the Original Project for Revisions 

During the revision procedure and following exercises, several new folders are created and used. 
The names of these folders are not important. The folder names in this course have been established 
by the writer only. The designer should follow corporate naming conventions when creating folders. 

Important   The revision procedure is required for Plan Sheets only. Although design modifications are 
made to referenced design files that are clipped into plans sheets, these design files, like a critical file, do 
not need to be revised using this procedure, as it would lead to a downstream file management nightmare. 

1. Select the executable file EDSection5ExercisesStart.exe, ensure Unzip to folder is set 
to C:\e and click the Unzip button to place the starting dataset for Section 5 on the hard 
drive.  Notice that there is an additional copy of the final secured project 21000415201 
in the C:\E\Delivered Projects folder.  

 
Unzipping the Dataset 

Note    Executable files are provided in the dataset for logical starting points throughout 
Section 5.  For example the executable file EDSection5Exercise5.4Start.exe contains the 
files from Section 5 exercises up to Exercise 5.4.  If you encounter errors while working 
through an exercise, select the executable with the nearest starting point and unzip the files 
as demonstrated above.  The Unzip to folder will be set to the correct hard drive location. 

Important   Leave a copy of the 21000415201 project in the C:\E\Projects\ folder to use for the 
revisions. When preparing revisions, always preserve the original delivery in a folder like the Delivered 
Project folder created above. Not only does Project Delta require an original copy of the delivery, but 
also the original delivery’s files, Postscript files, etc. that are signed and sealed by a signatory and must 
be preserved so they will Authenticate. 

Note   In the following exercise, the Electronic Delivery processes are made aware of the 
revision.  During the revision process, changes are made to the design files that represent 
the sheets to be subsequently plotted. 
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Important   Do not make changes to the names of the sheet design files.  Instead, the software used in 
the Electronic Delivery process, specifically Sheet Navigator, is instructed that a revision to a sheet has 
occurred.  In Sheet Navigator, the revised sheet is flagged as revised and includes the revision number 
of the contemporary version of the revised sheet.  Sheets that are not revised remain at the revision 
number they were before the contemporary revision. If a sheet has never been revised, its revision 
number remains zero (0). 

 
Windows Explorer - Original Project copied 

 

Section 5.2 Sheet Navigator 
Sheet Navigator is used to mark sheets for revision. It backs up the original design file, tracks the 
revision number, marks the original sheets as obsolete and places revision text in the revision title 
block. Any sheet(s) marked obsolete display with a red “X”, become inactive and are ignored by the 
Electronic Delivery Indexer, or EDI2, and Plotting. 
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Exercise 5.2 To use Sheet Navigator to revise Plan Sheets 

Prior to opening Plan Sheet(s) for revision, the user should make necessary modifications to any 
referenced MicroStation design files. For the purposes of this course, we are making the assumption 
that all necessary design file modifications are complete. 

1. Double-click the FDOT2008 icon to start MicroStation XM. 

2. From the MicroStation Manager, select plprrd01.dgn and click the OK button.  
 

 
MicroStation Manager  
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3   MicroStation XM opens in the FDOT2008 workspace.  From the FDOT Menu option 
Utils, select Label Sheets (Sheet Navigator).  

 
MicroStation with Cadpilot 
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3. Sheet Navigator opens displaying the Sheet Edit tab in the MicroStation window.  
Click the Navigator tab and then select File > New.    

 
Sheet Navigator - Navigator Tab 

4. When Build Index opens, verify the active project.  

 
Build Index 

5. Click the Build Index button. MicroStation XM minimizes and CM.Batch opens. 
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Note   Sheet Navigator creates the file SheetInfo.xml by default in the project’s root 
directory. If the file already exists, it is updated by the process as shown in the previous 
figure.  This file is required for Sheet Navigator to use automation tools, such as 
Renumbering, Revisions, and Multi-Sheet edit. 

 
CM Batch Processing 

6. Upon completion of the CM Batch processing, MicroStation XM re-displays and the 
newly created file, SheetInfo.xml is loaded into Sheet Navigator.  Notice the Rev 
column in the display, which displays the current revision number for each sheet 
identified by Sheet Navigator. 

 
MicroStation XM 
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Exercise 5.3 To use Sheet Navigator’s Revision Tool 

1. From Sheet Navigator, select Revisions > Start Process.  

 
Sheet Navigator - Revisions 

2. Warning Message displays. Click the OK button.  

 
Warning Message 

3. Set Revision Number opens.  Select 01 from the Revision No. list. 

 
Set Revision Number 
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4. Click the OK button. Sheet Navigator displays with a red box around it in the Revision 
mode. 

Important   This number represents the current Revision number for the drawing. The Revision number 
automatically increments for each revision. The list can be used to change the number. Currently, 
Revision numbers have a maximum value of 20. 

 
Sheet Navigator - Revision process 

5. From Sheet Navigator, scroll down to sheets 35 (0035) and 36 (0036). Populate sheet 
35’s checkbox under the Revise column to open Revision Block Text. 

 

6. In Revision Block Text, enter the following: 

• By – Your initials.  Please note that the By field should contain the initials of the designer 
making the revision.  If no initials are desired, also leave the By field blank.  Also, note 
that the Date field is automatically populated with the current date.  The date can be 
changed to match the “official” date of the revision or be left blank entirely if no date is to be 
placed in the revision block of the plan sheet.   

• Description – Drainage Structure Moved   

7. When finished, click the Save button. 

 
Revision Block Text 
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8. Repeat Steps 5-7 for sheet 36.  

9. Click the Save button to close Revision Block Text.  

Note   If the Key Sheet needs to be revised, reference the Plans Preparation Manual, 
Volume II. Chapter 3. Section 3.11 says “the lead key sheet (usually roadway) shall show a 
complete record of all plans revisions. The component (such as roadway, structures, 
signing and pavement marking), the sheet numbers involved, and the date when the sheet 
was revised shall be listed. A newly sealed lead key sheet is required when any sheet is 
revised.  

Revisions shall be shown on the lower left corner of the key sheet in the “Revisions” area. 
Revisions to strung project sheets shall be listed here, under the respective Financial 
Project ID. A Key Sheet Revisions Block shall be shown on the right side of each 
component key sheet that shall contain a record of all revisions particular to that sheet. It 
shall list the revision date, the initials of the person responsible for the revision and a brief 
description of the revision.  

If the changes to a key sheet only involve notes in the Revisions area, no entry is made in 
the Key Sheet Revisions Block at the lower right corner. The Key Sheet Revisions Block is 
only used to record changes other than revisions notes.” 

10. From Sheet Navigator, select Revisions > Finish & Apply Changes.  

11. From Sheet Navigator, click Revisions and then click Finish & Apply Changes. 
MicroStation XM minimizes and SheetInfo Processing Dialog, CM Batch process 
opens. 

 
Sheet Navigator – Revisions 
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12. MicroStation XM minimizes and SheetInfo Processing Dialog, CM Batch opens. 

 
SheetInfo Processing Dialog (CM Batch) 

13. Upon completion of the processing, MicroStation XM re-displays and the revised 
sheetinfo.xml file is loaded into Sheet Navigator. 

14. Navigate to Sheets 35 and 36 and review the changes. Note the updated revision 
number (01) in the Rev column. 

 
Sheet Navigator - Navigator tab 

Note   Sheet Navigator finds and records the Rev number in the Navigator tab. The Key 
Sheet also reflects the revisions as shown above. 
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15. From Sheet Navigator, select the Sheet Edit tab and review Sheets 34, 35 and 36. The 
Key Sheet also shows Revision 01 and Allow Plot is enabled. 

 
Sheet Navigator - Sheet Edit tab 

Note   In reviewing Sheet Number 34 (an unrevised sheet), note that Sheet Navigator 
displays 00 as the Revision number and Allow Plot is disabled. Sheet Navigator is aware 
that this sheet has not been revised and the original postscript plot image is still valid. Upon 
reviewing Sheets 35 and 36, Sheet Navigator displays 01 as a Revision and Allow Plot 
is turned on. Sheet Navigator is aware that this sheet has been modified and the modified 
sheet will be plotted and indexed by EDI 2. 

Note   If the Revision number needs to be changed manually, or the Allow Plot status 
updated, Sheet Navigator can edit these, on a per–sheet basis, by opening the Settings 
menu, and selecting the Allow Advanced Modifications option.  Use extreme caution 
when making advanced modifications, and only do so as necessary. 

16. Close Sheet Navigator by selecting File > Exit.  
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17. Double-click on Sheet Number 35 in the Sheets list on the left and review the title 
block information of Sheet 35 in MicroStation XM.  

 

 
MicroStation XM 

Note    Using Sheet Navigator’s Revision tool automatically places the Date, 
Description and modification BY initials in the correct location of the Revision Title 
Block area in MicroStation XM. Please note that the BY column is no longer part of the 
Revision Title Block for newer projects.  This is placed as MicroStation text to correct 
FDOT standard symbology.  

The designer can use MicroStation Edit Text if the text needs to be modified.  The delta 
symbol containing the revision number shown in the revision Description could also 
subsequently be copied to the area on the plan sheet adjacent to the objects changed 
reflecting the revision as necessary. 
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18. From FDOT Menu, select Standard > Explore Current Working Directory. 
Windows Explorer opens to the current working directory of the active design file. 

 
MicroStation XM - Cadpilot 
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19. In Windows Explorer, browse to the roadway folder and review the revised design files 
for naming conventions. 

 
Windows Explorer 

Note   Using Sheet Navigator’s Revision tool automatically backs up the original design 
file adding the date of the revision to the filename and adds the .old extension. The newly 
revised file maintains its original (hopefully FDOT standard) file name.  

For example, the revised Plan-Profile Sheet remains plprrd01.dgn while the original sheet 
has been backed up to plprrd01_2007-10-22.old. This file, if tested, will also evoke the 
proper QC rule file as the file maintains the plprrd prefix meeting standard naming 
conventions for QC rules. 

20. Exit MicroStation XM. 
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Section 5.3 Updating the Index and Postscript Images 
EDI2 is used to update the sheet index and create new postscript images for revised sheets. Upon 
opening the index, backed up design files appear in red.  Associated sheets do not appear in the 
revised information. 

Exercise 5.4 To update File Attributes 

1. If MicroStation is open, close it prior to launching EDI2. 

2. From Electronic Delivery, select Launch > ED12. 

 
Electronic Delivery 

Note   An automated version of MicroStation XM opens with EDI2.  

3. From EDI – Open Project for Write Access, select the Yes button. 

 
EDI – Open Project for Write Access 
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4. From EDI Verify Files, select the OK button. 

 
EDI – Verify Files 

5. From EDI2, select Index (Step by Step) > 1) Project (Mining File Attributes) > 1) 
Import... (New! Import Sheet Navigator data). 

 
EDI2 – Import Sheet Navigator Data 
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6. From Import Sheet Navigator Index Data, select SheetInfo.xml and click the OK 
button. 

 
Import Sheet Navigator Index Data 

7. EDI – SheetInfo.xml Date Warning displays.  Populate the Apply answer to all 
items checkbox and click the No button. 

 
EDI – SheetInfo.xml Date Warning 
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8. Click the Mine all modified files icon ( ). 

 
EDI2 – Mine all modified files icon 

Note   In EDI2, mining for the modified files retrieves attribute data for just those files 
which have changed, which is a faster option of updating the attribute data for the revision. 

9. EDI - Mining opens and starts mining the project attributes. The status of the mining can 
be seen at the bottom of EDI2.  EDI - Mining also displays the MicroStation Process 
ID, which can be used to identify errors if MicroStation fails.  

 
EDI 2 - Mining File Attributes 
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Note    and  are examples of messages in the 
Sheet Information Tree View of EDI. 

10. EDI - Mining File Attributes closes and EDI2 is ready to update the index. Upon 
completion of the mining, the file expands and displays the postscript files found from 
the new attributes. 

 
EDI 2 - plprdrd01.dgn design file 
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Important   The file icons have valuable meaning as described below: 

Amber color means the postscript sheet is present in the index but the source file; plprrd01.dgn has 
been modified since the associated sheet was plotted. The red X through the printer icon is 
derived from the Revision process of Sheet Navigator. This represents that while the 
source file, plprrd01.dgn has been modified; this sheet in the file has not changed and has 
been marked non-plottable by Sheet Navigator. Sheet Navigator knows this sheet file 
already exists from the original delivery. 

Red color (with the red X through the sheet icon) defines that the postscript file does not yet exist. 
The naming convention is automatically derived from the Sheet Navigator plan 
component and sheet number. The suffix, appended to the postscript file name, is derived 
from the revision value used during the revision process in Sheet Navigator.  

To create Postscript files for the revised sheets 

1. In EDI2, verify the Sheet Files tab is active.  Right click on the root project folder and 
select Create Plot Files > Missing. 

 
EDI2 - Create Plot Files 
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2. EDI - Create Plot Processing opens and closes when done processing. 

 
EDI 2 - Create Plot Processing 

Important   During the revision process, it is vitally important that existing postscript image files not 
change (because some or all may be signed and sealed by a Signatory).  EDI2 presents the user with 
visual color codes to help identify files (as discussed during the mining process).   

Also note that if EDI2 detects that the user is about to over plot a postscript file that is signed and sealed, 
a dialog displays to confirm or cancel the overwrite.  Pay very close attention and answer this prompt as 
intended, because of the consequences to the Signatory that signed/sealed the files before being 
overwritten. 

Tip   Choosing the Missing option to create plot files allows EDI2 to pass over existing files and 
only plot postscript image files containing revisions. 

3. From EDI2, verify that the Sheet Files tab is still active and click the + symbol to expand 
the information under plprrd01.dgn.  
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4. Click the postscript file name for Sheet 35 and then right-click the file name. From the 
displayed menu, select Display Image.  

 
EDI 2 - Display Image 

Note   Observing the Sheet Index Files pane, the user is again presented with a color-coded 
listing. 
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5. EDI2 displays the selected image in the Image Viewer window. Review the image and 
verify that the revision block is filled in.  

 
EDI 2 - Image Viewer 

Tip   Image Viewer is set to a default of 72 pixels per inch to maximize screen display speed. If 
Image Viewer is going to be used to print the displayed sheet, increase the screen resolution 

using the Set plot output resolution icon ( ) from the menu to produce a better quality 
image; however, screen display response speed could decrease. 

6. From EDI2, select View > Project Viewer (All files, Image files, Design Sheets) to 
return to the Project Viewer. 
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To update the Index 

The file ProjectIndex.xml will be updated. 

1. In EDI2, verify the Sheet Files tab is active.  Right click on the root project folder and 
select Update Sheet Index. 

 
EDI 2 – Updating the Index 
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2. EDI – Sheet Index Update opens.  Populate the Create New Index check box and click 
the OK button. EDI2 creates a new the index file, ProjectIndex.xml, replacing existing 
file, if already created.  

Note   Remove Original will remove the original Sheets 35 and 36 from the index and 
replace them with the newly revised sheets. 

 

 
EDI- Sheet Index Update 

Note   The most conservative (and safest) update option is to take the default, which is to 
have Create New Index and Overwrite Existing unchecked.  However, this requires the 
user to open the Index Editor (View > Index Editor (Edit and Save Index)) to manually 
remove the old entries for the non-revised sheets.  Some users choose to do this as it 
provides a level of confidence the index was updated correctly with the correct sheet 
references, despite requiring a little extra work. 
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3. Upon completion of updating the index, select View > Index Editor (Edit and Save 
Index). 

 
EDI 2 

4. Index Editor displays.  Review the updated index, ProjectIndex.xml, and note the 
changes to the revised files and postscript images.  
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5. Click the Save button ( ) to save the updated index, ProjectIndex.xml. 

 
EDI 2 Index Editor View 

Note   To review, the attributes were updated, the revised file’s postscript image files were 
created and the index, ProjectIndex.xml, was updated to reflect the revised files. 

6. Click the Mine all modified files icon ( ) and then exit EDI2. 

  



Section 5 _______________________________________ Electronic Delivery - Handling Revisions 

5-30 © 2009 FDOT  Electronic Delivery Training Course 

Section 5.4 Additional Information Found in EDI 
EDI2 also offers other valuable information to the user. EDI2 reads and reports back PEDDS 
information, such as whether a postscript image file is signed or not.  To access this information 
select the PEDDS (Execute PEDDS Operations and Applications) submenu from the Tools 
menu.  The submenu items relate to examining or modifying PEDDS related data. 

Additionally, the Tools menu provides the ability to generate a listing of files to run with the QC 
Reporter application, to generate a current QC Report for the graphics files in the project. 

Also, File Checker can be evoked to perform other QC functions.  

Section 5.5 PEDDS - Signing and Sealing Revisions 
When Signing and Sealing revisions, it is important to create and use a new Signatory file to sign the 
revised plan sheets.  Keep the original Signatories intact with the original signed sheets/files, as it 
is historical data which must be preserved.  Do not use an original signatory file to sign a revision.  
Instead, create a new signatory file for each Signatory who needs to sign a revised sheet.  
Remember, a Signatory (person) can have multiple Signatory files, and should if they need to sign 
revisions. 
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Exercise 5.5 To sign and seal the revised sheets using a New Signatory 

1. Open project 21000415201 in PEDDS. 

2. From the Signatory menu, select Create Signatory --or— 

click the Create a New Signature icon ( ) on the toolbar.  

Signatory Information opens.  

 
Florida Department of Transportation - PEDDS  

3. Signatory Information contains information about the individual who is signing and 
sealing the plans. 

4. In the Signatory Name box, type your name. 

Tip   If your signatory already exists, add a descriptor to the signatory name. For example, if the 
signatory, John Johnson exists, and the same signatory is subsequently signing revisions, John 
can use “John Johnson – Revisions” as the signatory name to sign the revision. 

5. In the Signatory Number box, type 12345.  

6. In the Pass-phrase box, type 12345.  
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7. In the Re-enter Pass-phrase box, type 12345. 

Note   The Pass-phrase is a password (or a phrase of characters), unique to each 
professional responsible for signing and sealing files. If the professional forgets his or her 
pass-phrase, PEDDS allows the creation of additional signatories.  Pass phrases are not 
required, and do not add any additional security to the signed and sealed files.  Pass 
phrases only help prevent someone from accidentally opening a Signatory’s Signature file 
and making modifications to the file set selected to be signed and sealed.  Remember, the 
security is still the ink signature, date and impression seal on the printed Signatory Report! 

Even though the Professional of Record could be using the same name, same PE number 
and even same pass-phrase, PEDDS differentiates between Signatory files by the dates 
and times they are created (date, time is added to the file name itself). 

8. Select the Signatory Type. 

9. Click the OK button to continue.  

 
Signatory Information - Professional Engineer (PE) 

Tip   If a District requires the same Professional of Record to use different Signatories for 
different disciplines or purpose, the Professional of Record can add a description of what the 
signature is being used for, as shown above.   

Also note the Signature scope of Work, shown above, is required by Florida rule, and should 
more verbosely describe the reason for the work. 
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 Important  The requirements for sealing information stored in electronic files are defined by the Board 
of Professional Engineers in Rule 61G15-23.003, F.A.C. For each professional engineer in responsible 
charge who is signing and sealing files in a project, PEDDS generates the following: 

A Signature File that defines which files are being signed and sealed, and 

A Signature Document that is printed, signed, dated, and sealed by the Professional Engineer with an 
impression seal. 

10. Signature Scope-of-Work opens. If a Signatory Type other than Signature - No Seal 
(SS) is chosen, enter your professional number in the Signatory Number field. 

11. In Signature Scope-of-Work, type a description of the work to be signed/sealed by the 
Signatory. 

12. Click the Finish button.  PEDDS New Signatory confirmation dialog box appears.  
Click OK. 

 
Signature Scope-of-Work dialog box 

 
Figure 5-42a:  Signature Scope-of-Work dialog box 

Important   The professional's name, address and phone number are not required, however the 
description of the work is.  Note that Signatory shown above chose to add their contact information as 
part of their Scope-of-Work.  This may be requested by some districts.  Any other exculpatory 
language the Signatory chooses to add to this scope would also be entered here.  
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13. In the Available Signatories menu, select the newly created signatory.  When the 
Change Active Signatory dialog box appears, enter the password for the signatory 
and click OK. 

 
PEDDS - Signatory Files 

 
Figure 5-43a:  PEDDS - Signatory Files 
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14. Using the newly created Signatory, select the revised files for signing and sealing. Then 
select Signatory > Sign and Seal. 

 
PEDDS - Revised Sheets Signed and Sealed 

Important  When Signing and Sealing, a Qualifier can be used to specifically add exculpatory language 
about any particular file, or group of files being selected to sign and seal.  A Qualifier is not required, 
but should be used if there is more than one Signatory signing any single file in order to distinguish what 
portions of that file the Signatory is taking responsibility for. 
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Upon completion of the Signing and Sealing process, Report Viewer opens.  Click the 
Print button to send the report to a print device.  The Signature Document, once 
printed on paper, is then manually signed, dated, and impression sealed by the Signatory.   

Note   The files are not electronically signed and sealed electronically, until the paper 
report process just described has been completed, despite completing the electronic 
process in PEDDS. 

 
PEDDS - Report Viewer 

15. Click the Exit button. Report Viewer closes.   
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16. Click Project>Secure.  Enter the Delivery Manager’s Name.  If the information 
displayed is valid, the user can accept what is there. 

 
PEDDS - Secure 

17. Enter the Delivery Manager Title and click the Next button.  

  
Project Manager Information 
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18. Description of Delivery opens.  Enter the purpose for the delivery.  Again, this 
description should contain enough detail to sufficiently describe the purpose for the 
delivery. 

 
Project Description 

19. Click the Finish button. Securing Project opens briefly then closes.  

 
Securing Project 

Note   PEDDS passes all files through the Federal Government SHA-1 secure Hash 
algorithm to create a manifest listing of Hash Codes for each file. That manifest is 
contained in a file called the Manifest file. 
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20. Report Viewer then opens to present the Delivery Manifest Document.  Click the 
Print button to send the Delivery Manifest Document to a print device. 

 
PEDDS – Delivery Manifest Document 

21. Click the Exit button to close Report Viewer and exit Pedds.   
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Section 5.6 Using Project Delta 
As discussed in Section 3.13 of the Production Phase, Project Delta is an application that simplifies 
the job of identifying and reporting indexed differences between two sets of project deliveries.  
Project Delta compares a historical delivery to a revised contemporary delivery.   It uses the 
differences between the indexes (ProjectIndex.xml) and those files referenced by the index for the 
sheets to determine if sheets have been added, modified, or removed from the revision.   

Project Delta creates two reports that can be used to report the differences between two sets of 
indexed projects, the Revision Report and Change Report: 

Revision Report - This report (DeltaNDX#.htm) is created and included in the project before a 
revision delivery is made to the Department. The report denotes the differences between two full 
deliveries; the original (historical), delivery project (which must be secure) and a full, revised 
(contemporary) project delivery.  The report also contains data that is used by Set Maker to create 
a secure subset of revised files from the revised (contemporary) project delivery. 

Change Report – This report is designed to report the indexed differences between any two project 
files sets, not merely full project deliveries, as does the Revision Report.  Though the report was 
originally designed for tracking the differences between an original project delivery and a later 
corrected delivery, the report has many uses – from determining file changes between sets to 
ensuring that a revision set contains the proper files. As this report is designed for quality assurance, 
it does contain set generation information as does the Revision Report.  

Note   Additional reporting capability is available in Project Delta, which utilizes the 
CSDIFF application called by Project Delta to report specific file changes at the folder 
level between projects. 
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Exercise 5.6 To create the Plan Revision Index Report 

Using Project Delta, the Revision Report, DeltaNDX#.htm, is created by comparing the 
originally delivered project, known as the Original Project, to the newly revised project, known as 
the New Project. DeltaNDX#.htm is saved to the revised project’s root directory and only displays 
information about indexed plan sheets that are added, removed or revised. Non-indexed modified 
design files (files containing no plan sheets) are not reported. 

1. In the Revision folder, click Launch to open Project Delta. 

 
Revisions 

 
Project Delta 
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2. Under Report Type, populate the Revision Report radio button. 

3. Click the Browse button ( ) to the right of the Original Project box, to browse to 
the project to be compared.   

 
Project Delta - Browse to Folder 

4. Browse For Folder opens.  Navigate to the location of the originally delivered, secure 
project at C:\E\Delivered Project\21000415201 and click the OK button.  

 
Browse For Folder 
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5. Click the OK button. Project Delta displays project directory in the Original Project 
box. 

6. Repeat steps 4 - 6, selecting the Revised Project as C:\E\Projects\21000415201. 

7. In the User Information Name box, type your name and select One (1) from the 
Revision Information Number menu.  The revision number that is selected will 
determine the name of the deltandx# report (i.e. deltandx1.htm). 

 
Project Delta 

8. Click the Create Report button to continue.  

9. Project Security Warning displays.  Click the OK button. The Revision Report 
begins the creation process.  

 
System Message 
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Important   While Project Delta is creating the Revision Report, it strips out all of the file and 
hash-code values of the revised project’s manifest (which is copied from the original secured manifest). 
Project Delta leaves the Header information in the manifest, but the project is no longer secured. 
PEDDS must be used to re-secure the project before delivery. The original, secured project’s manifest is 
not altered in any way during this process. 

10. Several Creating Delta Report dialogs open displaying the progress of the report 
generation. Upon creation of the Report, the Revisions Report opens, along with 
frmProgress, which state that the “Delta Report creation is complete.” Click the Close 
button to reopen Project Delta. 

 
Creating Delta Report Progress 

11. From Project Delta, click the Close button. 

 
Project Delta 
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Plan Revisions Index Report 

Note   The report, DeltaNDX#.htm, is a web page that describes the differences between 
the original project delivery and the revised project in two contexts.  The first is what the 
differences are between the two in terms of sheets (where any added, removed, or 
modified) between the two project indexes.  The second context is what files referenced 
by those two project indexes were affected.  With both of the contexts, the user gets a 
complete picture about what changed, sheet index wise, between the original project 
delivery and the revision being prepared. 

Note   The naming convention of the deltandx report has changed.  The name now 
includes the revision number (example:  deltandx#.htm).  As shown above, the name for 
the deltandx report of the first revision is deltandx1.htm. 
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Exercise 5.7 Updating Reports for a Revision 

To create the revised reports 

The Sheet Index Report is an HTML report derived from the project's Index, ProjectIndex.xml. 
The report file is titled Sheetndx#.htm and must reside in the project's root directory. 

To update Sheetndx#.htm 

Important  The Sheet Index Report, Sheetndx#.htm is a required deliverable item per Item 17 of the 
Compliance Certification Checklist Report. 

1. Open the project 21000415201 with EDI2.  Be sure to open the project with write 
access when prompted.  Click the Mine all modified files icon ( ).   

2. From EDI2, select Index (Step-by-Step) > 6) Basic HTML index (Index) > Create.  
Creation of the Basic HTML Index, Sheetndx#.htm, processes.  

 
EDI - Create Basic HTML Index 
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Create Basic HTML index (deltandx#.htm report option) 

Note   In the case of a revision, the index number for deltandx#.htm determines the index 
number for sheetndx#.htm (Basic HTML index).  For the original delivery, sheetndx.htm 
is not indexed. 

3. Strung Project Confirmation opens. Click the NO button. 

 
Strung Project Confirmation 

Note   For the purposes of this training course, this is a standalone project; therefore, it is 
not a component of a Strung Project. 
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4. The HTML file Sheetndx.htm is created in the project’s root directory and displays in a 
web browser. 

 
Sheetndx1.htm HTML Web Page View 

5. The HTML web page allows users to browse the project and view files with an external 
Web Browser, like Internet Explorer.  
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To update the Project#.pdf 

The Summary PDF is a single document which contains all plan sheet images in index order. This 
file, in Adobe Portable Document Format (PDF), resides in the project's root directory, and is titled 
Project#.pdf. During the creation of the Project#.pdf, if a previously created Project#.pdf or a 
Summary PostScript file, Project.ps exists, the application automatically overwrites the files, so 
only one Summary file is created. 

To create an updated Project#.pdf 

1. From EDI2, select Index (Step-by-Step) > 7) Project PDF (All Sheets Consolidated 
into PDF) > Create. EDI2 begins the creation process.  

 
EDI - Create Project.pdf 
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Create Project.pdf (select revision # and deltandx#.htm) 

Note   Upon initializing the creation process, Create Project PDF opens and displays the 
“behind the scenes” processes of Ghostscript, EDI, Sheet Navigator, and MicroStation. 

 
Create Project PDF 

2. From EDI – Create Project PDF, the user can choose whether or not to keep the 
intermediate Project.ps file.  For this exercise, click the No button.   

 
Create Project PDF 

3. Display Project PDF opens.  Click the Yes button.  Adobe Reader opens to display 
contents of Project1.pdf. 

 
Display Project# PDF 
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Tip   The user can change Adobe Reader’s view from portrait to landscape to rotate the view of 
Project#.pdf. Check the orientation of any manually inserted sheets prior to building the 
Project#.pdf file.  

 
Adobe Reader – Project1.pdf 

4. PDF (Portable Document Format) is not a perfect solution. There is no control over the 
original size/sheet dimensions, sheet rotation, pixel density or output paper size. PDF 
does, however, offer an inexpensive printing and viewing solution for other users of 
FDOT information that are unable to print or view postscript files as PDF preserves the 
data. 

Important  The Summary PDF, Project#.pdf is a required deliverable item as per Item 16 of the 
Compliance Certification Checklist Report. 
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To create the Revision#.pdf 

The Summary PDF is a single document which contains all plan sheet images in index order. This 
file, in Adobe Portable Document Format (PDF), resides in the project's root directory, and is titled 
Project#.pdf. During the creation of the Project#.pdf, if a previously created Project#.pdf or a 
Summary PostScript file, Project.ps exists, the application automatically overwrites the files, so 
only one Summary file is created. 

1. From EDI2, select Index (Step-by-Step) > Revision PDF (DeltaNDX Sheets 
Consolidated into PDF) > Create. EDI2 begins the creation process.  

 
EDI - Create Revision#.pdf 
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2. Create Project Revision PDF opens.  Ensure 1 is selected in the Revision menu and 
that the deltandx1.htm report is highlighted and then click the OK button.   

Note   If there are other revision.pdf files that reside in the root of the project folder, each of 
the files will be listed in the “existing” box. 

 
EDI2 – Select Revision Number and deltandx#.htm report to Create Revision#.pdf 

3. Upon initializing the creation process, Create Project PDF opens and displays the 
“behind the scenes” processes of Ghostscript, EDI, Sheet Navigator, and 
MicroStation. 

 
 Create Revision# PDF 

4. From EDI – Create Project PDF, the user can choose whether or not to keep the 
intermediate Project.ps file.  For this exercise, click the No button.   

 
EDI – Create Project Revision PDF 
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5. Display Project PDF opens.  Click the Yes button.  Adobe Reader opens to display 
contents of Revision#.pdf. 

 
Display Project Revision PDF 

Tip     The user can change Adobe Reader’s view from portrait to landscape to rotate the view 
of Revision#pdf. Check the orientation of any manually inserted sheets prior to building the 
Revision#.pdf file.  

 
Adobe Reader – Revision1.pdf 
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To update ProjectFiles.htm 

1. Continuing in EDI2, select Index (Step-by-Step) > 8) All Files Report 
(ProjectFiles.htm).    

 
EDI - Create Basic HTML Index 

2. EDI – Create All Files Report opens.  Click the Yes button.  The project index is read to 
create ProjectFiles.htm. 
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EDI – Create All Files Report 

3. When the creation process concludes, EDI2 displays ProjectFiles.htm. 

 
EDI2 – Project Files Report 

4. Return to the Project Viewer window by selecting View > Project Viewer (All files, 
Image files, Design Sheets).  
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5. Click the Mine all modified files icon ( ) and then exit EDI2. 

 
EDI2 – Mine All Modified Files 
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Exercise 5.8 Securing the Revised Delivery 

To secure the revised project with PEDDS 

1. If necessary, open PEDDS. 

2. From the Project menu, select Secure --or—click the Secure the Current Project icon 
( ) on the toolbar.  

 
PEDDS Securing the Project 

3. Delivery Manager Information opens.  Enter the Delivery Manager’s Name.  If the 
information displayed is valid, the user can accept what is there. 
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4. Enter the Delivery Manager Title and click the Next button.  

 

  
Project Manager Information 

5. Description of Delivery opens.  Enter the purpose for the delivery.  Again, this 
description should contain enough detail to sufficiently describe the purpose for the 
delivery. 

6. Click the Finish button. Securing Project, shown below, opens briefly then closes.  

 
Project Description 

 
Securing Project 
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7. PEDDS passes all files through the Federal Government SHA-1 secure Hash algorithm 
to create a manifest listing of Hash Codes for each file. That manifest is contained in a 
file called the Manifest file. 

8. Report Viewer then opens to present the Delivery Manifest Document.  Click the 
Print button to send the Delivery Manifest Document to a print device. 

 
PEDDS – Delivery Manifest Document 

Important  The Delivery Manifest Document results are derived from the Manifest file 
(Manifest.xml, saved in the \_meta_info folder in the project directory). The Delivery Manifest 
Document must be printed (see Item 13 of the Compliance Certification Checklist Report), reviewed 
and signed (not sealed) by the Delivery Manager. 

Important  The Delivery Manifest Document is a signed paper document used to secure a Manifest file 
and to reference signature files in the project delivery corresponding to the Manifest. By signing the 
Manifest Document, one has associated their name to the Manifest file that corresponds to the paper 
document. The Manifest file lists the project files by URL and the project files’ hash-codes, thus the 
Delivery manager has signed (but not sealed) the files listed in the Manifest as belonging to the delivery. 

9. Click the OK button to continue.  Florida Department of Transportation - PEDDS 
re-appears.  

10. Close Florida Department of Transportation - PEDDS. 
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Section 5.7 Creating Data Subsets for a Revision 
Unlike creating a subset for a Plans and Specs CD, a Plans and Specs Revision CD only contains 
revised sheets and files.  The responsibility for creating a subset may be that of the data producer, 
or the District (Depending on which District). 

Exercise 5.9 To create of a Plans and Specs Revisions Subset 

1. In Creating Project Subsets, click Launch to open Set Maker. 

 
Creating Project Subsets 

 
Set Maker 
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2. Click the Browse button ( ) to the right of the Source Directory box.  

3. Browse For Folder opens. Navigate to the active project and select the active project (for 
the purposes of this exercise, c:\E\Projects\21000415201). 

 
Browse For Folder 

Important   Set Maker requires the source project be secured with PEDDS.  If Set Maker detects that 
the source project is not secured, the user receives an error message and processing stops.  Set Maker 
also performs various other validation activities, which might generate both error messages (and 
processing stops) or warning messages (which processing continues).  Pay close attention to the 
messages to understand what problem Set Maker may have detected. 

4. Click the OK button. Set Maker begins to validate the project information, and the 
Project Delta File selection dialog box appears. 

5. Click the radio button that corresponds to the deltandx1.htm report.  If there were 
more than one deltandx#.htm report, the selection would be based on which 
deltandx#.htm would need to be used for the specific revision project. 

 
Project Delta File Selection  
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6. File Verification starts and finishes, then SetMaker re-appears. 

 
SetMaker file verification 

 
Set Maker 

Important   Set Maker requires that both a valid ProjectID.xml and Manifest.xml file exist in the 
project’s \ _meta_info directory.  If these files are not found, the application reports an error and does 
not continue with the set making process.   
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Exercise 5.10 To select files by File Selection and File Selection Rules 

To further expedite file selection, Set Maker has a number of pre-defined selection options. For 
revisions, these options select sheets found in Sheetndx#.htm.  

1. From the project tree in Set Maker, under the project’s root directory, select 
Revision1.pdf to see how files may be manually selected for inclusion in the subset. 

 

 
Set Maker - project_rev1.pdf 

2. As the specifications for this project have not been modified, the specs file does not need 
to be included in the set. 
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3. From the Selection menu, select File Selector Rules --or-- click the File Selection 
Rules icon ( ) on the toolbar.  

 
Set Maker - File Selection Rules 

4. File Selections Options open.  Populate the Revised Files check box.  The File 
Selections Options attempts to present the available conditions from which Subsets can 
be made.  An Original plans delivery would be created by populating the Original Plans 
checkbox (and nothing else).  If a Revision exists (by the presence of DeltaNDX#.htm) 
then the Revised Plans checkbox becomes available.   

5. Once the business rules are selected, press the Apply button to make those selections.  
The Project PDF and Specs Files dialog box appears.   

6. Check the box that corresponds to the Revision#.pdf file that needs to be used to create 
the set.   
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7. When all automatic selections are made, close the File Selection Options by pressing the 
Close button. 

 
File Selection Options - Revised Files 

 
Project PDF and Specs Files. 
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Set Maker - Revised files selected 

Important  Revised Files is available as a File Selection Options, because the Deltandx#.htm 
report file, created by Project Delta exists at the project’s root directory.  Note that the revision#.pdf 
was selected automatically because of the File Selection Options chosen earlier. 

8. Click the Browse button ( ) to the right of the Destination Directory box.  
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9. Browse For Folder opens.  Navigate to the active project and select the active project 
(for the purposes of this exercise, c:\E\Revised_Projects\21000415201rev1\). 

 

 
Browse For Folder 

10. For the purposes of this class, the c:\E\Revised_Projects\21000415201rev1\ folder is 
already created.  Always select an empty folder to write a subset to. 
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11. Click the OK button.  Set Maker reappears with the selected destination added. 

 
Set Maker 

Important  The recommended Root Directory Names for Plans and Specs CD data sets created for a 
revision are described below: 

      Project CD  Plans and Specs (Revision) 
CD 

Original Delivery    21000415201   21000415201 

After Revision 1    21000415201   21000415201rev1 

After Revision 2    21000415201   21000415201rev2 

Note   Description of Supplemental revisions and Plans and Specs revisions which include 
a revised specs package are discussed later. 
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12. From the File menu, select Create Set --or-- click the Create Set icon ( ) on the 
toolbar.   

 
Set Maker - Create Set 
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Note   If you enter a destination folder that doesn’t already exist, Set Maker displays the 
message shown in Figure 5-93. Click the Yes button to confirm the creation of the new 
folder. 

 
SetMaker 

13. User Information opens.  In User Information, enter the required information.  In the 
Description field, enter a detailed description for the subset.  Note that this description 
appears on subsequent reports. 

14. From the Set Usage pull-down list, select Other.  Note that the user can type in a short 
usage message in this field, like “Subset for Revision 1.” 

15. When finished entering the required information, click the Create Set button. Creation 
of the set begins. 

 
User Information 
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 Important  The User Information defines the lineage of the subset. The information entered into User 
Information is contained within the manifest file created in the subset, which is the link back to the 
parent or originating project the subset was created from. 

16. Even though the specs file is not included with the revised set, the CD is still titled a 
Plans and Specs Revised CD. 

17. Upon creation of the set, SetMaker opens to confirm the creation. Click the OK button.  

 

  
SetMaker 

18. Manifest Report opens. Click the Print button to send the report to a print device.  

 
Manifest Report 

19. Click the Close button. Set Maker re-appears. The Plans and Specs set has been created 
and now can be copied to a CD and properly labeled. 
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20.  The following figure displays the set created in Windows Explorer. 

 
Windows Explorer - Plans and Specs Revised Set 

Important   The procedure just described handles a Plans and Specs Revision, where the Specs file 
remained unchanged. 
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Section 5.8 Additional Revision Considerations 
The revised Plans and Specs data submittal (contrasted with the Project CD submittal) uses the 
following directory naming conventions for revisions and/or supplements. This does not apply for 
the Project CD submissions, only for revisions and/or supplements and the subsets (Plans and Specs 
CD) created from them.  

Section 5.1 discussed handling revisions when plan revisions were needed. The directory structure 
(and content) for the revision without the supplement is shown in the following figure. 

 
Plans Revisions only 

When both a plans revision and specifications changes (called a supplement) are needed, the 
exercise outlined in Section 1 is used, with the addition of the specs folder and the revised \supp1 
folder. The directory structure (and content) for the revision with a supplement is shown below: 

 
Plans and Spec Revisions 
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If there are specifications supplements only, the directory structure shown in the following figure is 
used. 

 
Supplement Revisions Only 

Seek guidance from the State Specifications Office for the required sub-directory structures and file 
naming conventions for specifications supplements. 

As a result of the directory structure format for revisions, the following Root Directory Names for 
Plans and Specs CD data sets created for all possible revisions and/or supplements are as follows: 

 
Plans and Specs (Revisions) CD directory names 

Section 5.9 Revision Naming Convention Changes 
Changes in Contracts Administration’s release of revisions to the Contractor electronically have 
spawned a request to make modifications to the file naming protocols in Electronic Delivery.  They 
wish to suffix (sequence) certain ED files with the revision number, and have the ED applications 
do so and manage the data as seamlessly as possible.  The proposed revision sequences and names 
of files are as follows: 

 
Revision naming convention changes 
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6 Electronic Delivery – 
Strung Projects 

 

The Strung Projects training section covers the details of stringing two or more project subsets 
together including: 

• Strung Projects 

• Preparing a Project for Strung Projects 

• Securing the Strung Project with PEDDS 

• Making a Delivery 
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Section 6.1 Strung Projects 
Electronic Delivery of Strung Projects involves the act of combining two or more independent and 
secured project subsets together.  Stringing projects is the result of the administrative practice of 
letting two, or more projects under the same construction contract.   

For Electronic Delivery, stringing project subsets involves combining the data in a way so that the 
end user, typically a contractor, can reasonably navigate the ‘Lead project’ and ‘Goes-with 
projects’ comprising the strung project using a simple Internet Browser. 

 

 
Production Phase in the Context of Revision 
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Section 6.1.1 Setting the stage for Strung Projects 

To prepare for Strung Projects, the user has to create the subsets with Set Maker before they can 
be “strung” together using Strung Project.  

 

 

Section 6.2 Preparing a Project for Strung Projects 
Before the Strung Projects process can begin, the project subsets to be used must meet certain 
criteria. The following items need to be completed prior to stringing project subsets together: 

• Each project subset must contain its own Index (ProjectIndex.xml, or Deltandx#.htm if it 
represents a revision), basic HTML Index report (Sheetndx#.htm), and Summary PDF 
file (Project#.pdf, or Revision#.pdf, if a revision, etc).  

• The projects are each independently secured (Note that Set Maker automatically secures 
every subset it creates). 

• The project subsets independently authenticated with PEDDS. 

• Subsets made from the project (Remember, only project subsets should be strung). 
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Exercise 6.1 Creating Strung Projects 

This exercise uses 2 projects. Project 19728125201 represents the ‘Lead Project’.  This project 
has been indexed and postscript image files have been created and all required files are Signed and 
Sealed.  In the interest of time, Project 29728125201, which represents the ‘Goes-With Project’ 
is also secured and ready to use.   

Therefore, the two projects are independent, secured, deliverable projects.  Note that the subsets 
were created by Set Maker.  This can be confirmed by examining the Manifest report by opening 
the Projects in PEDDS. 

To select the Target Location for the Strung Project 

1. Select the executable file EDSection6ExercisesStart.exe, ensure Unzip to folder is 
set to C:\e and click the Unzip button to place the starting dataset for Section 5 on the 
hard drive.  Notice that there is an additional folder Strung_Projects in the C:\e 
folder.  

Note  Executable files are provided in the dataset for logical starting points throughout Section 6.  For 
example the executable file EDSection6Exercise6.2Start.exe contains the files from Section 6 exercises 
up to Exercise 6.2.  If you encounter errors while working through an exercise, select the executable 
with the nearest starting point and unzip the files as demonstrated above.  The Unzip to folder will be 
set to the correct hard drive location. 

2. In the Creating Strung Projects folder, click Launch. Strung Project opens. 

 
Creating Strung Projects - Launch 

 
Strung Projects 
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3. On the right of Target Location box, click the Browse button ( ).  

 
Target Location 

4. Browse for Folder opens.  Navigate to c:\E\Strung_Projects.  This is the location 
where the resulting strung project will be written to.  Click the Strung Projects folder 
so that it is shown as open in the following figure. 

 
Browse For Folder 
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5. Click the OK button.  Strung Project reappears. 

 
Strung Project - Target Location Set 

To add the “Lead” Project 

The Lead and Goes-With projects must now be added.  The lead project is presumed to be the first 
member of the strung project selected. 

1. At the right of Folder Name box, click the Browse button ( ).  

 
File Name 
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2. Browse For Folder opens.  Navigate to and select the project that is the “Lead Project”. 
For the purposes of this exercise, select C:\E\Projects\19728125201.  

 
Browse For Folder 
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3. Click the OK button.  Current Status opens briefly and checks the selected project.  
Upon completion of the validation process, Strung Project reappears with the selected 
project set as the Lead Project, as shown in Figure 6-30. 

 
Strung Project Validation 

 
Strung Project - Lead Project 

Note   The Add button is used to add a selected project to the list.  This works the same as the 
steps in the exercise.  The Remove button can be used to remove a selected project from the 
collected list.  The Remove All button can be used to remove all projects from the list. The 
Create button is used to start the creation of the Strung Project as shown later in the exercise.  
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To add a “Goes-With” Project 

1. At the right of File Name box, click the Browse button ( ). 

 
File Name 

2. Browse For Folder opens.  Navigate to and select the project that is the “Goes-With 
Project”.  For the purposes of this exercise, select c:\E\Projects\29728125201.   

The order that the user selects the projects typically does not matter, however the user 
may want to select Goes-With projects in the order that they would like them to appear 
in the indexes to the strung project that will be generated.   

Note   Remember that the Lead Project is always the first project selected. 

 
Browse For Folder 
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3. Click the OK button.  Current Status opens and checks the selected project. Upon 
completion of the validation process, Strung Project re-appears with the selected 
project set as the Goes-With Project, as shown in Figure 6-34. 

 
Strung Project Current Status 

 
Strung Project - Goes-With Project 

Note   During the creation of the strung project, a composite Project.pdf for all Lead and 
Goes-With projects is created in the root directory of the strung project structure.  The 
Project.pdf found in the Lead Project has each of the Project.pdf(s) from the Goes-With 
Project(s) appended to it, and the resulting composite Project.pdf is written to the root 
directory of the strung project.  

This operation could take an extended period of time, depending on the size of the source 
PDFs.  It is highly recommended that any batch process operations like this be done on the 
local hard drive, and not across a network for performance reasons!   

This operation also requires the paths to the GhostScript engine be set from the Options 
menu. 
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To set GhostScript Paths 
1. From Strung Project, select Options > Support Applications to open 

Supplemental Applications.  Ensure the settings for GhostScript are correct.  
Normally, the GhostScript settings are those shown below.   

2. When finished, click the Close button to continue. 

 
Support Applications 

 
Supplemental Applications 

 



Section 6 _________________________________________ Electronic Delivery - Strung Projects 
 

6-12 © 2009 FDOT Electronic Delivery Training Course 

To create the Strung Project 

1. From Strung Project, click the Create button. Current Status opens and provides 
progress statistics.  

 
Strung Project - Create 

2. Create Strung Project displays.  Click the Yes button.  Current Status opens and 
provides progress statistics. Strung Project begins by creating and completing the 
appropriate strung project directory structure, and then copies each of the component 
‘Lead’ and ‘Goes-with’ sub-projects into the strung project structure. 

 
Create Strung Project 

 
Current Status 
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Note   Once copying is complete, Strung Project creates a Project Identification file, 
ProjectID.xml in the \_meta_info folder of the root strung project structure. This Project ID 
file is copied from the Lead project, and modified slightly by Strung Project so that PEDDS 
recognizes the strung project as a unique project, separate from either the Lead project or any 
of the Goes-With projects.  

Likewise, a “seed” Manifest file, Manifest.xml is also created in the \_meta_info folder; 
however it does not contain any file listing data.   

At this point, the newly Strung Project is not yet secured and PEDDS must be used to secure 
the project. 

3. User Info opens.  Fill in the user information as shown in the following figure and then 
click the Continue button.  

 
User Info 
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4. Create Strung Project displays.  Click the Yes button.  

  
Create Strung Project 

5. When the strung project's Manifest data is complete, and Project#.pdf is appended, 
GhostScript opens.  
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Note   GhostScript runs with no user interface, and what appears to be a blank window opens for 
each Project#.pdf found in the component project(s) to build the composite Project#.pdf in 
the root directory of the strung project.  

Be patient and allow this process to complete, as PDFs are being un-distilled to PostScript, 
concatenated, and re-distilled back to PDF, which is a very intensive operation. 

 
Ghostscript Window 

6. At the end of the process, GhostScript closes and Strung Project Complete opens.  
Strung Project Complete notifies the user that the strung project must still be secured 
with PEDDS.  Click the OK button to continue.   

 
Strung Project Complete 

7. Exit the Strung Project application. 
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Note   The following figure displays the newly created strung project and its directory structure.  
Note that “ETC” is added to the folder name inherited from the Lead Project.   

Also, if files (or additional folders) need to be added to the root folder structure (the one with 
the “ETC”) outside of the Lead and Goes-with project folders (don’t mess with them), it can be 
done now. 

 
Windows Explorer 
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Section 6.3 Securing the Strung Project with PEDDS 
PEDDS is used to secure the new strung project.  PEDDS may be used to modify the Project 
identification data, ProjectID.xml for the strung project, or Project Header data, which is stored in 
Manifest.xml file. Securing the strung project structure for delivery is done by the normal 
securing procedure in PEDDS. 

Exercise 6.2 Securing the Delivery 

To open the Strung Project 

1. In the Creating Strung Projects folder, click Launch PEDDS to Secure Strung 
Projects.  

 
Creating Strung Projects - Launch PEDDS... 

2. Florida Department of Transportation - PEDDS opens.  From the Project menu, select 
Open --or-- click the Open an Existing Project icon ( ) on the toolbar.  

 
Florida Department of Transportation - PEDDS 
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3. Open Project appears.  Select the Drive letter where strung project resides from the 
pull-down menu. 

4. Navigate to the C:\e\projects folder and select the project.  To load the selected 
project in PEDDS, click the OK button. The loaded project is now ready for PEDDS 
processing. 

  
PEDDS - Open Project 
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To secure the Strung Project 

1. From the Project menu, select Secure --or—click the Secure the Current Project 
icon ( ) on the toolbar.  

 
PEDDS - Securing the Project 

2. Delivery Manager Information opens.  Enter the Delivery Manager Name and 
Delivery Manager Title. Then click the Next button.  

 
Delivery Manager Information 
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3. Description of Delivery opens.  Enter the purpose for the delivery and click the Finish 
button.  

4. Securing Project opens briefly then closes and Report Viewer opens. 

 
Description of Delivery 

Note   The Delivery Manager Name and Delivery Manager Title, as well as the Delivery 
Description are filled in with the information entered during the Strung Project creation, as 
this information is inherited from the Lead Project. 

 
Securing Project 
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5. The Delivery Manifest Document is shown Report Viewer.  Click the Print button to 
send the Delivery Manifest Document to a print device. 

 
Report Viewer – Delivery Manifest Document 

6. Click the OK button.  Florida Department of Transportation - PEDDS reappears.  

7. Exit PEDDS. 
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Section 6.4 Making a Delivery 
After the project is secured and the Compliance Certification Checklist Report completed, the 
project can be copied to portable media, such as a CD-ROM or DVD-ROM, and labeled 
accordingly for delivery to the Department. This delivery should include the Project CD, the 
Compliance Certification Checklist Report (or alternative document the District requires as 
evidence the data producer followed their QC plan), and all signature documents generated by 
PEDDS. It is recommended that the project be authenticated on the delivery media prior to 
delivery to the department as per Item number 15 of the Compliance Certification Checklist 
Report. 

The Project CD is described as the CD containing all data associated with a project, including all 
files on the Plans & Specs CD, all design files, all reference files, project journals, etc.  Note the 
example below of a well labeled CD-ROM. 

 
Example of a labeled CD suitable for delivery 

If the project is too large to fit onto one CD, the use of DVD is permitted as long as the delivery 
media is labeled as a DVD. If DVD is not available, the recommended procedure is to span the 
project across multiple CDs.  

If multiple CDs are used, the recommended method of authenticating the delivery media changes 
as PEDDS cannot authenticate across multiple CDs. 

Exercise 6.3 To authenticate multiple CDs 

1. Copy all project data from the CDs it to a temporary storage location using Windows 
Explorer. 

Important   Do not make any changes to the project after copying it to the temporary storage location. 

2. Authenticate the copied project using PEDDS. 

3. If project verifies, send the delivery media (multiple CD) to the Department. 

4. Remove the temporary project originally copied from the CDs. 



 
 
 

Electronic Delivery Training Course © 2009 FDOT 7-1 

 

7 Production Phase - Extras 
 

This section contains additional reference material on Production Tools that can assist the user 
while preparing a project for electronic delivery.  If time permits at the end of the of the Electronic 
Delivery Production course, these exercises can be started.  If time does not permit, these 
exercises contain valuable reference material for possible future use.  These extra topics cover the 
following: 

• Manually inserting sheet(s) into a Index 

• PEDDS - Partial-Project 

• PEDDS - Synchronize 

Section 7.1 Manually inserting Sheets into a Index 
Occasionally, a project contains plan sheets not generated from MicroStation design files, such as 
sheets in PDF format that came from a scanner or other sources. This exercise details the steps, 
considering both Sheet Navigator and EDI2, to prepare the index for insertion of sheets from a 
source different than the conventional indexing and plotting postscript from MicroStation design 
files. 

 

Exercise 7.1 Manually inserting Sheets into a Index 

This exercise manually adds three new sheets to the project. These two sheets represent two 
Design Standards PDF files.  

To manually insert sheets into the Index 

1. Select the executable file EDSection7ExercisesStart.exe, ensure Unzip to folder is 
set to C:\e and click the Unzip button to place the starting dataset for Section 7 on the 
hard drive.  Notice that there is an additional folder Strung Projects in the C:\e 
folder.  

Note   Executable files are provided in the dataset for logical starting points throughout Section 7.  
For example the executable file EDSection6Exercise7.2Start.exe contains the files from 
Section 7 exercises up to Exercise 7.2.  If you encounter errors while working through an 
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exercise, select the executable with the nearest starting point and unzip the files as 
demonstrated above.  The Unzip to folder will be set to the correct hard drive location 

2. From EDI2, open the project 21000415201.   

3. Once the project is open, switch to the Index Editor view in EDI2 (View > Index 
Editor (Edit and Save Index)).   

4. Scroll down to sheet 320 under the Sheet column and review the index to this point, 
noting the sheets to be manually inserted fall after sheet 320. 

 
71EDI2 Index Editor View 
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5. From the EDI2 Window menu, select Tile Horizontal.  

 
EDI2- Tile Horizontal 
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6. The Project Viewer window reappears tiled with the Index Editor window.  Click 
the Image Files tab as shown in the following figure and then click the roadway 
discipline folder.  Image files 0781.pdf and 0782.pdf display. 

 
EDI2 - Index Editor and Project Viewer Windows Tiled 

7. From the Image Files pane, click 0781.pdf and while holding down the Ctrl key on the 
keyboard, click 0782.pdf to select both files. 
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8. Drag and drop the selected Image Files to the Roadway Plans Component folder of the 
Plans Set (the Sheet Index Files pane to the upper left of the Project Viewer).   

 

 
EDI2 - Image Files added to Plans Set Roadway Component 

9. From the Sheet Index Files pane, select 0781.pdf and right-click on the file. 
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10. From the displayed menu, select Find in Index.  

 
EDI2 - Find in Index 
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11. EDI2 changes focus to the Index Editor window and displays the selected file as 
shown in the following figure. 

 
EDI2 - Index Editor 
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To manually modify Sheet information in the Index Editor 

1. Continuing in the Index Editor, modify the Sheet Number and Description of the 
inserted sheets in the Edit Index Items pane, as shown and then click the Save button.  

 
EDI2 - Edit Index Items 

From the Index Editor, click the Refresh (Undo) to last synch with Sheet Index Files, Plans 

Set tree view icon  on the toolbar.  
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2. Scroll up to Sheet 321 and review the index. 

 
Refresh (Undo) to last synch with Sheet Index Files, Plans Set treeview 

Note   As shown above, Image File 0781.pdf is inserted in the index and the description of the 
sheet is modified and saved. 
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3. Repeat the procedure for Image File 0782.pdf and renumber the sheet to Sheet number 
322. 

Note   Upon completion, the index looks like the following figure. 

 
EDI2 

4. From Index Editor, click the Save button ( ) on the toolbar to save the Index. 
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To update the Sheet Index 

1. Close Index Editor.  From the Project Viewer window, right-click on the project 
folder as shown in the following figure. 

2. From the displayed menu, select Update Sheet Index.   

 
EDI2 - Update Sheet Index 

3. EDI – Sheet Index Update opens.  Ensure all checkboxes are not populated.  
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4. Click the OK button. The index, ProjectIndex.xml is updated. 

 
Update Project Index Plans Set 

Note   As shown in the following figure, the once missing Postscript Image files are displayed 
green in the Sheet Index Files pane. 
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EDI2 - Updated Index 
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5. From EDI2, select Index (Step by Step) > 4) Sheets (Working With Sheets) > Save 
(Save Sheet Index List to ProjectIndex.xml.  

 
EDI2 – Save Sheet Index 

6. EDI - Save Project Index opens.  Click the OK button to save the Index, 
ProjectIndex.xml.   

 
EDI - Save Project Index 
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7. EDI2 reappears in the Index Editor view.  From EDI 2, select File > Exit to close 
EDI2. 

 
EDI2 - Exit 

Note   This concludes the exercise on inserting non Postscript Image files into an index manually.  
See Section 3, Production Phase of this manual for instructions to complete the electronic 
delivery. 
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Section 7.2 PEDDS - Partial Project 
PEDDS provides the ability for sub-project file management.  The Prime Consultant can 
designate folder(s) for a Sub Consultant to work in and use those for reference.  The tool also 
allows the Prime Consultant to package the designated work folders and files and any additional 
folders as read-only reference data to the Sub Consultant.  

The Sub Consultant uses the same tool to deliver the package back to the Prime Consultant.  
PEDDS does not overwrite any data changed in the folders marked read-only back into the 
original project. 
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Exercise 7.2 PEDDS - Partial-Project Package 

For the purposes of this exercise, use Project 99728125201.  This is a small project in Phase 1of 
Production.  A surveying Sub Consultant has been hired and they will work in the Survey folder 
and the contents of the roadway folder will be delivered as reference. 

To Create a PEDDS Partial-Project Package 

The Prime Consultant initializes the transaction by first building a Partial-Project. 

1. From Electronic Delivery Desktop, select Launch > PEDDS. 

 
Electronic Delivery Desktop – Launching PEDDS 
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2. From Florida Department of Transportation - PEDDS, open Project 99728125201.  

 
Florida Department of Transportation - PEDDS 

3. From Florida Department of Transportation - PEDDS, select Partial-Project > 
Create Partial-Project.  

 
PEDDS - Sub-Delivery 
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4. Create Partial-Project dialog box opens.  As the instructions indicate, folders can be 
added by dragging and dropping them from the PEDDS folder window on the left to the 
Create Partial-Project dialog box on the right or they can be removed by right-clicking 
the folders in the Create Partial Project dialog box.   

For the purposes of this exercise, drag and drop Survey and then Roadway from the 
PEDDS folder window on the left to the Create Partial-Project window on the right. 
These folders are added to Sub-Delivery Files. 

 

 
Create Partial-Project 
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Partial-Project Files 

5. From  Partial-Project Folders, populate the Survey checkbox to make it writable for 
the Sub Consultant. 

 
Partial-Project Files 
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6. Click the Create Partial-Project button.  

7. Save Partial-Project Package opens.  In order to specify which folder the 
Partial-Project Package needs to be saved in, go to PEEDS>Settings>Click User 
Settings.   

8. For this exercise, go to User Settings, click the browse button which is located to the 
right of the package save directory, navigate to C:\E\Projects and create a folder 
named Packages. (The User Settings can also be used to specify the locations of the 
Project Lookup Directory and the Error Log Directory).   

 
Save As 

9. Click the Save button. The file Partial_Project.PrtPkg is saved.  The “create partial 
project” dialog box appears.  Click ok. PEDDS reappears. 

 
Create Partial Project package successful creation message. 

Note   PEDDS compresses the selected folder and files and creates a Sub Delivery Manifest.  
This information is saved to the file _partial_project.prtpkg.  This compressed file can be 
sent by e-mail, depending on file size, to the Sub Consultant.  Also note that only the folder 
structure selected is transmitted to the sub-consultant. 
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To receive the Partial-Project by the Sub Consultant 

Once the file, _partial_project.prtpkg is received, the Sub Consultant can expand and start 
working on the project using the directory structure the Prime Consultant sent. 

1. Launch PEDDS. No project needs to be selected. 

2. From Florida Department of Transportation - PEDDS, select Project > 
Partial-Project > Expand and work.  

 
PEDDS - Expand and work. 
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3. Open Partial-Project displays.  Navigate to the location where the file 
_partial_project.prtpkg sent by the Prime Consultant is saved and click the Open 
button. 

 
Open Partial-Project 

4. Partial Project expansion begins and Browse For Folder opens.  If not already 
available, create two new folders named Sub_Consultant and 99728125201 under the 
current project location: C:\e\projects\99728125201\Sub_Consultant\99728125201. 

 
Select Target Folder 
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5. Partial-Project Expansion continues.  Upon completion of the project expansion, 
the project is loaded into PEDDS.  The sub-consultant can now work on the project.   

In this example, work should be saved to the \Survey folder by the Sub Consultant 
using the \Roadway folder for reference.  No work will be returned to the Prime in 
any other folder than the \Survey folder. 

 

 

Florida Department of Transportation – PEDDS 

  



 
Production Phase - Extras - PEDDS - Partial Project _______________________________ Section 7 
 

Electronic Delivery Training Course © 2009 FDOT 7-25 

6. Click the Secure Project icon. 

 

Secure the Current Project 

7. Delivery Manager Information opens.  Modify the displayed information as required 
and click the Next button. 

 
Delivery Manager Information 
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8. Description of Delivery opens.  Enter the required description.  

Note   The description details the purpose for the securing of the project.  

 
Description of Delivery 

9. Click the Finish button and the Delivery Manifest Document opens.  Click exit (or 
Print in order to print the document) .  

 
Report Display 
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To compress and return the Partial-Project to the Prime 
Consultant 

Upon Completion of the project, the Sub Consultant uses PEDDS to compress the project and 
return it to the Prime Consultant. 

1. Launch PEDDS and open the project. 

2. From Florida Department of Transportation - PEDDS, select Project > 
Partial-Project > Compress and return. 

 
Compress and return. 

 
PEDDS Compress and Return Partial Package Secure project verification 

Important   The partial project must be secured prior to running the Compress and return routine. 
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3. Save As opens.  The C:\E\Projects\Packages folder opens. Click the Save button.  
The file 99728125201_partial_project_return.prtpkg is saved.  

  
Save Partial-Project Return Package 

4. PEDDS Compress and Return Partial-Project Package confirmation dialog box 
appears.   

 
PEDDS Compress and Return Partial-Project Package 

5. Click OK. PEDDS reappears. 

6. Exit PEDDS.  

Note   PEDDS compresses the selected folder and files and creates a Delivery Manifest.  This 
information is saved to the file sub-delivery_return.pkg.  This compressed file can be sent 
by e-mail, depending on file size, back to the Prime Consultant. 
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To merge the Partial-Project back into the Parent Project 

The Prime Consultant can now finalize the Partial-Project process by merging the Sub Consultants 
returns back into the parent project. 

1. Launch PEDDS and open the parent project. 

2. From Florida Department of Transportation - PEDDS, select the menu option 
Project > Partial-Project > Merge back to Parent Project.  

 
Merge back to Parent Project 
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3. OpenPartial-Project Return Package displays.  Navigate to the location where the file 
99728125201_partial_project_return.PrtPkg sent by the Sub Consultant is saved 
and click the Open button.  

 
Open Partial-Project Return Package 

4. Pedds opens. Click the Yes button to continue.  

 
PEDDS – Securing/Processing Merge back to Parent Project 

5. Delivery Manager Information opens.  Modify the displayed information as required 
and click the Next button. 

 
Delivery Manager Information 

6. Description of Delivery opens.  Enter the required description. The description details 
the purpose for the securing of the project. 
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Purpose of Delivery 

7. Click the Finish button.  PEDDS merges the Partial-Project into the parent project 
and Report Displays opens.  From Report Display, click the Print button.  

 
Report Display - Delivery Manifest Document 

8. Click Exit to close the PEDDS Document/Report Viewer.  

9. When Florida Department of Transportation - PEDDS re-appears, Exit the 
program. 

Important   PEDDS merged the Partial-Project into the parent project.  Since the survey folder was 
the only folder selected as writable, PEDDS only merged the files from this folder into the parent 
project.  If the Sub Consultant, added, modified or deleted files from the roadway folder, as this folder 
was originally marked as read-only, PEDDS would ignore this folder during the merging process. 
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Section 7.3 PEDDS - Synchronize 
PEDDS provides the ability to make a requestor’s and responder’s project data exactly the same.  
This process is called synchronization.  Note that during this process, the Requestor’s version of 
project data is made to match exactly the Responder’s version of the project data.  That is, only 
the files that the Responder has will be on the Requestor’s version of the project after 
synchronization. 

 

 

Exercise 7.3 Synchronizing a Project 

The following procedure is used to synchronize a Project between two project teams (Requestor 
and Responder). 

To Synchronize a Project 

The requestor for this example is a Sub Consultant who needs to verify that their project files are 
up to date with the Prime Consultant’s project files.  The requestor should make sure their version 
of the Project is secure before starting the Synchronization process. 

1. The Sub Consultant opens their project in PEDDS.  From Florida Department of 
Transportation - PEDDS, select Project > Synchronize > Request synch. PEDDS 
begins to generate the Synchronization request and then Save As opens. 
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Request synch 

2. From Save As, navigate to a directory to save the synch request package, *.syncpkg 
file and then click the Save button.  PEDDS begins the Synchronization process by 
compressing and packaging a copy of the Requestor’s Manifest file, and then creating a 
Synchronization Request Package.   

 
Save As - Generating Synchronization 
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3. Request Project Synchronization dialog box appears.  Click Ok. 

 
Request Project Synchronization 

4. The Sub Consultant exits PEDDS and sends the newly created synch request 
package, *.pkg file  to the Responder (Prime Consultant).  Note that this request 
package is usually small enough to be transmitted by e-mail. 

 

To Respond to a Synchronization Request 

The responder for this example is the Prime Consultant.  The Prime Consultants uses PEDDS to 
open the requestor’s synch request package, *.syncpkg file.  The responder should also have 
their version of the project secure before beginning the response process. 

1. The Prime Consultant opens their project in PEDDS and then selects Project > 
Synchronize > Respond to synch request.  

 
Respond to synch request. 
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2. Open Project Synchronization Request Package File opens.  Tthe Prime 
Consultant navigates to the location of the saved synch request package, *.syncpkg 
file, received from the Sub Consultant and then clicks the Open button.   

Note   PEDDS compares the contents of the package to the contents of the Responder’s open 
project.  

 
Open 

3. Save As opens.  From Save As, the Prime Consultant navigates to a directory where 
the synchronization response is to be saved and clicks the Save button.   

The newly created synch_response package, *.syncpkg file is saved.  The package 
contains all files modified or added to the project that the Sub Consultant requested.  It 
also includes an instruction set to remove any files on the Requestor’s version of the 
project that are not present in the Responder’s.   

Note   Remember, after Synchronization, both the Requestor’s and Responder’s version of the 
project are exactly the same. 
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Responder Synchronization Project 

 

 
Respond to Synchronization Project 

4. The Prime Consultant exits PEDDS and sends the newly created synch response 
package, *.syncpkg file to the requestor (Sub Consultant). 
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To Complete the Synchronization process 

The requestor, the Sub Consultant in this example, uses PEDDS to open the responder’s synch 
response package, *.syncpkg file. 

1. The Sub Consultant opens their project in PEDDS and selects Project > Synchronize 
> Complete synch.  

 
Complete Synch. 

2. Open displays and the Sub Consultant navigates to the location of the saved synch 
response package, *.syncpkg file, received from the Prime Consultant and then clicks 
the Open button.  PEDDS compares the contents of the package to the contents of the 
Sub Consultants active project.  

 
Synch Response 
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3. Report Viewer opens.  From Report Viewer, the Sub Consultant reads and verifies the 
contents of the Project Synchronization Report, clicks the Exit button, and then 
clicks the Yes Button if they want to proceed with Synchronization.  

The report details exactly what changes will be made, including what files will be 
added, replaced, and deleted.   

 
Report Display 

 
Synchronize current project now 

Note   If the Yes button is clicked, PEDDS adds, deletes or replaces the Sub Consultant’s (the 
Requestor’s) project files to match those of the Prime Consultant’s (the Responder’s) active 
project. If the No button is clicked, no synchronization takes place and the process is aborted.  

4. Pedds Complete Synchronization displays.  Click the OK button to continue.  

 
PEDDS – Complete Synchronization 

5. When Florida Department of Transportation - PEDDS re-appears, Exit the 
program. 
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